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g | CHAPTER 1

INTRODUCTION

THANK YOU

Welcome and thank you for purchasing the Opto 22 Mistic MMI! The Mistic MMI (Man-Machine Interface) is
aMicrosoft Windows Version 3.1 (or later) program used to develop operator interfaces for Cyrano 200 strategies
running Opto 22 Mistic control equipment. It consists of two major components: theMistic MIMI Configurator
and the Mistic MMI Runtime. The Configurator is the development environment and contains all the functions
you need to create animated graphic windows to represent and interact with your control process. The Runtime
environment displays the graphic windows you created in the Configurator and allows you to interact with
them to monitor your system.

WHERE DO | START?

If you're new to the Mistic MIMI, please read Chapter1 to understand the basics about the MMI. Then
continue with Getting Started in Chapter 2 to quickly get up and running with the MIMI.

If you're familiar with the MMI and just want to get started, turn to Chapter 2, and begin with the Quick
Start process. Refer to Chapter 3, Configurator Menu and Chapter 15 Runtime Menu, for overviews of each
command.

This book assumes you are familiar with Opto 22's Cyrano, Microsoft Windows, and have a basic knowledge of
networking. For more information about Cyrano, refer to the Cyrano User$ Guide, Form 704. Consult the Microsoft
Windows manuals for more information about Windows.

MMI OVERVIEW

Features

With the Mistic MMI, you can communicate to multiple networked Mistic processors and collect and display
data from the different strategies running on various controllers. Add the MDS software application to the
Mistic MMI system for an efficient data collecting process.

Easily draw and connect graphics to Cyrano tagnames. Because the Configurator shares the same tagname
database created in Cyrano, you eliminate the duplication effort of entering names of variables and I/0 normally
encountered when using other MMIs. Syntax and spelling errors are also eliminated.

Mistic MMI User's Guide ~ 1-1



INTRODUCTION

You can change the color, size, position, visibility, and other attributes of a graphic based on the value or state
of a tag. The value of a tag can also be modified during Runtime based on your interaction with a graphic object.
Other MMI capabilities such as real-time trending, historic data logging, and multimedia sound support are
also provided.

Control vs. Monitoring

The project you develop using the Mistic MMI, monitors the Cyrano strategy as it is running. The Mistic MM
can be used to change the values of tags in the Cyrano strategy, but it does not contain programming or logic-
solving capabilities to actually control a process. These capabilities are part of Cyrano, an actual process
control language.

Cyrano

Cyrano is a visual flow-charting language used to create process control strategies that run on Mistic 200
processors. The Cyrano kernel, the interpretive firmware residing in the Mistic processor EPROMSs, has many
advanced features such as multi-tasking, string handling, communications, and mathematical operations. You
can access these features through Cyrano using English-like commands to create a flow chart logic, and develop
your process control strategy. Use the Mistic MMI to develop an operator interface to monitor a running Cyrano
strategy.

Cyrano saves information about global data items (variables, I/0 points, charts, tables, etc.) in a file with a
.GML extension. The Mistic MMI reads the .GML files and keeps track of its timestamp. If the Cyrano strategy
changes (which affects the timestamp of the .GML file), the MMI warns you so possible problems can be
detected.

Configuration vs. Runtime

The Mistic MMI consists of two separate programs, the MMI Configurator and the MMI Runtime. The
Configurator is used to develop the operator interface by defining and configuring the draw windows, graphics,
and all their attributes that make up a project. It connects these objects to the Cyrano strategy’s tagname
database. Once this is done and the MMI Runtime is started, the MM project communicates with the Mistic
processor which is running the Cyrano strategy. The MMI Runtime animates the operator interface by updating
the graphic attributes (color, size, position, etc.) connected to Cyrano tags according to changes in their values
or states.

Project

Aprojectis a collection of draw windows, graphics, and all their attributes developed with the MMI Configurator.
It is the database for the operator interface you develop with the Mistic MMI. When the project is saved,
several files are created. The main project file has a.MMI extension. Each draw window produces a file with
a sequentially numbered file extension (w01, .w02, etc.) and a file with an .INI extension. The .INI file contains
startup information about the project. The filename.INI file has information about the project status and when
it last exited from the MMI Configurator and the MMI Runtime. These project files, together with the MMI
Runtime, present an animated graphics interface for a Mistic control system.

1-2  Mistic MMI User’s Guide



INTRODUCTION

Windows

Like most Windows applications, the Mistic MMI consists of many different windows. The most important are
the Main Window and Draw Window.

Main Window

This rectangular area of the display allows you to view your application. You can open, close, move, and resize
the main window like any Windows application. The Main Window contains a menu bar allowing you to select
various tools. The title bar displays the full project path. If the pathname is too long to fit in the title bar, only the
working project subdirectory is shown. To display the full project path, select the File=>Project Path command
from the menu bar. Refer to the Windows User's Guide for information on using windows.

Draw Window

This window is where all graphics are drawn and edited. Each project consists of one or more draw windows
which make up the operator interface. The draw window has static attributes of position, size, and color. Draw
windows have visual states of open, closed or iconified. An open window scans and updates associated
objects. A closed window optionally scans any trends it may have, but it does not update any displays. An
iconified window scans all objects but does not update any displays.

Objects

Most things visible in the Mistic MMI are considered objects, as well as some things not visible. Objects
include draw windows, graphics, triggers, and trends.

There are two types of objects: static and dynamic. Static objects have a static appearance and do not change
while the MMI Runtime is running. They have no dynamic (changing) attributes. Dynamic objects have a changing
appearance or cause the appearance of other MMI objects to change during execution of the MMI Runtime.
Dynamic objects have dynamic attributes defined.

Tags
A tag refers to data items (such as variables, I/0 paints, or PID loops) from a Cyrano strategy.

To access tags in a MM project, choose the Configure\Mistic Controller(s) menu option and select the Cyrano
strategies for the project. Now all the tags of the selected strategies are available to the MMI.

Tags animate your operator interface through connections to graphic objects and their dynamic attributes. As
the values of tags change through Controller Driven Attributes(input dynamic attributes, values from the controller)
or Operator Driven Attributes (output dynamic attributes, values sent to the controller), the appearance of the
graphics change. Tags are also used as triggers to initiate system events such as sounds, historic logging, and
window configurations.
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Connections

A connection occurs when a Cyrano tag is selected as the source or destination of data for an MMI dynamic
object. Some examples include:

e Selecting a tag as the source of data to drive the dynamic attribute of a graphic (size, position, rotation,
etc.).

e  Selecting a tag as the destination of data to drive user interaction with a graphic (slider, send data,
etc.).

e Selecting a tag as a trigger source.

e Selecting a tag as the source of data for a trend pen.

CONVENTIONS USED IN THIS MANUAL

Before getting started with the MMI, review the following conventions used in this manual.

General Conventions
e The names of menus, commands, dialog boxes, fields, and buttons are capitalized.
e The names of files are set in capital letters (for example, MWDRIVER.DLL).

e The names of keyboard keys are set in small capital letters (for example, CTRL, AL, DELETE).

Window Screen Conventions

A dialog box is displayed in response to menu options and enables you to enter specifications. Pressing the 148
key highlights the next control; pressing sHiF+7a8 highlights the previous control. The following illustrations are
typical dialog boxes.
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The MMI Configurator main window is used to create and setup the graphical representation of your process,
while the MMI Runtime window displays the animated results of the graphics you created.

Control Menu Box

Enables you to move,

close, resize the window,

or activate other
Windows tasks.

Border

Click and drag the
border to resize the
window.

Menus

Mistic MMI Configurator

[-]-

File

Help  (45562K)

Minimize Button

Reduces window to
anicon.

— Maximize Button

Figure 1-1: MMI Configurator Main Window

Enlarges window to
its maximum size.

To display a menu, click on its title in the menu bar (or press AT and the underlined letter in the menu name).

Amenu displays a list of options. Choose an option by clicking on it using the arrow keys, followed by enTer, or
by pressing the underlined letter in the option name.

Checked option
Indicates the

command is
enabled.

|

Mistic MMI Configurator - CAMMREXAMPLES\EXAMPLE1

‘vl‘

File Edit Tool
(45758K)

Style

View Text Window Configure

Font

4

Help

00!

Size...
Color...

Background...

¥ Normal
Bold

SEEEEEENEE  H

Italic
Underline
Strikeout

Opaque
¥ Transparent

Ellipsis
Choosing the
option
displays a
dialog box.

Figure 1-2: Menus
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Dialog Boxes

A dialog box is displayed in response to menu options and enables you to enter specifications. Pressing the 148
key hightlights the next control; pressing sHiF+1a8 highlights the previous control. The following illustrations are
typical dialog boxes.

Dialog box name Active button

Available for you
to choose;
opens or closes
a dialog box,
performs an

Cancel operation, or
selects an

Closes the option.

dialog box

and does not Dimmed button

save Not currently

changes. available and
cannot be
chosen.

0K Help

Saves Displays

changes and information about

closes the the dialog box.

dialog box.

Figure 1-3: Dialog Box Buttons

Some dialog boxes have drop-down lists and require you to enter specifications in field boxes.

Field
Enables you to enter specific information.

Ellipsis
Clicking
the
button
displays
another
dialog
box.

Drop-down list
Click the arrow to display a

Figure 1-4: Dialog Box Field Entries f(istafvalues to choose
rom.
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CHAPTER 2

GETTING STARTED

OVERVIEW

The Mistic MMI (Man-Machine Interface) is used to develop an operator interface for Cyrano 200 programs
running on Opto 22 Mistic controllers. The first step in using this program is to develop a Cyrano Strategy. Once
that's done, you're ready to use the MIMI.

The Mistic MMI consists of two separate programs, the MMI Configurator and the MMI Runtime. The
Configurator is used to develop the operator interface by defining and configuring the draw windows, graphics,
dynamic attributes, logs, alarms, sounds, and all other objects that make up your project. It connects the objects
to the variables, I/0 points, PID loops, etc. defined in your Cyrano strategy. Once this is done, the MMI Runtime
communicates with the Mistic processor that's running the Cyrano strategy. The MMI Runtime animates the
operator interface by updating the graphic attributes (i.e. color, size, position) connected to the Cyrano tags
according to changes made in their values or states.

SYSTEM REQUIREMENTS

The following are the minimum requirements you need to run the Mistic MMI. The MMI Runtime “About” box
displays the version requirements for the MMI.

PC Hardware

IBM-compatible 386 personal computer (486 or better recommended)
Hard disk with 10 MB of free space

16 MB of RAM

Microsoft Mouse or other compatible pointing device

VGA or compatible display

Software

e MS-DOS version 5.0 or later
e Microsoft Windows version 3.1 or 3.11

Mistic Products

e Any Mistic controller
e Mistic controller kernel EPROM, version 1.43 or later
e (Cyrano software, version 1.3.0 or later
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INSTALLATION

At least 10 MB of free space must be available on your hard drive to install the MMI.
Note:  The Mistic MM does not run under Microsoft Windows 95.

1. Run Windows for Workgroups on your PC.

2. Insert the Mistic MMI disk 1, P/N 8875A, into a removable floppy drive (e.g.: b:).
3. Choose the File=>Run command from Program Manager.

4. Type b:setup in the Command Line box and click OK.
5

Enter the desired location for the MMI when prompted by the MMI setup and press EnTer.
The default location is: CAMMI.

6. Afterthe first disk is installed, remove disk 1, insert disk 2 P/N 8875B, and press ENTER.

7. When installation is complete, the program group “Opto 22" is displayed and contains two icons as
shown in Figure 2-1.

= OPTO 22 [~ ]~

ik
Mistic bkl histic hihdl
Canfigurator Runtime

Figure 2-1: Opto 22 Program Group
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MMI CONFIGURATOR BASICS

Start the Mistic MMI Configurator by double-clicking on its icon. The first time you start the Configurator, a
window displays the caption “Mistic MMI Configurator — (Untitled)”. This window is known as the Main
window.

The MMI Configurator may contain other windows managed by the Main window. This Main window contains
another window captioned (Untitled). This window is called a draw window. Use this window (and others like
it) to draw the objects that make up your operator interface. Properties of this window (name, position, dimensions,
controls, colors) can be changed by selecting the Window—>Properties menu option. Create more draw windows
for the project by selecting the Window—>New menu option.

The Toolbar is also associated with the Main window. This small window captioned Tools contains buttons
with pictures of the basic tools used for building an operator interface. When one tool is selected, it becomes
the active tool until a different one is selected, either via the Toolbar or the Tool menu. The Toolbar is not
constrained to the interior of the Main window, but “floats” on your desktop at the same level as the Main
window.

Selecting a Cyrano Strategy

To begin an MMI project, the MMI Configurator needs to know what Cyrano strategy (or strategies) will be
used for the project. This enables the connections to the appropriate Cyrano tags when assigning dynamic
attributes to your graphics. Selecting the Configure—> Mistic Controller(s) menu option displays a dialog box
window captioned Controllers. This dialog box contains an initially empty list of the Mistic controller names
used in the current MMI project. After adding one or more Controllers to this list, you are ready to continue.

Steps to Create Objects and Connect Them to Tags

To begin configuring the various objects (graphics, sounds, window configurations, etc.) of your operator interface,
start with the graphic objects. Select a tool from the Toolbar (other than the Selector) to draw objects of the
chosen type in a draw window. Once an object is drawn, connect it to a Cyrano tag by either double-clicking on
it or by selecting the Edit—>Dynamic Attributes menu option to display the Dynamic Attributes dialog box. Here
the graphic’s input dynamic attributes and output dynamic attributes and their connection to Cyrano tags are
defined. For example, the input dynamic attributes can set up a connection when the value of a tag increases,
the size of the graphic increases. Or change the color of the graphic when an 1/Q point turns on and off. With
output dynamic attributes, you can setup connections that change the value of a tag as you “slide” the graphic
on the screen or change the window configuration based on which graphic you select. Many different
combinations of attributes may be applied to develop your particular solution.

In addition to graphics, there are other ways of presenting information to the users of your operator interface.
These include Historic Data Logs, Sounds, and Window States which can connect to Cyrano tags from the
strategies of the current MM project. Select these menu options from the Configure menu.
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QUICK START

During installation, a directory named EXAMPLES is created in the MMI directory. This directory contains
examples that include preconfigured Cyrano strategies and MM projects. The following sections describe how
to load the example Cyrano strategy and MM project.

Verification Process

Before going on, you'll want to verify the Mistic controller and Cyrano strategy are working properly. If the
Cyrano strategy is already downloaded to a Mistic controller and is properly operating, you're done with this
section.

If your Cyrano strategy is new or you need to check to see if its controller configuration matches your target
controller, proceed with the following steps.

1. Start Cyrano and go into the Configurator by selecting System—> Configurator from the Cyrano
environment.

2. Choose the File=>Load command and select Cyrano strategy from the \mmi\examples\example
directory (this is the default directory location).

3. Select the Configure—>Mistic command to review the controller’s configuration.

The Configure Mistic Communications dialog box appears. It displays the controller's address,
communication mode, and its PC COM port configuration. Make any necessary changes so it matches
the controller’s settings.

4. Choose Accept to close the dialog box.
5. Save the file by selecting File—>Save.
6. Download the strategy to the controller by choosing System—>Debugger.
Choose “Yes” when asked “Are you sure?”.
7. Once the strategy is downloaded and you're in the Debugger, choose the Run—>Stop option.
8. Verify the Mistic system is operating.

Run the Cyrano strategy in Autostep mode to verify the controller is communicating with the PC. A
properly running system displays two messages in the lower left corner of the Cyrano Debugger screen
indicating the charts and program are running. You can also visually inspect your Mistic system’s
communication LEDs for communication transactions.

If you suspect your system is not operating properly, consult the controller manual’s or Cyrano manual's
appropriate troubleshooting section.

9. \Verification is complete. Exit the Debugger by choosing File—=>Quit.

10. Exit the Cyrano environment by choosing Cyrano—> Quit.
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To Configure the Mistic MMI

IMPORTANT:  Make a backup of your Mistic MMI project before working with it in a new MMl release. A
Mistic MIMI project saved under a newer release will not work under an older version of the
Mistic MM

1. Start the Mistic MMI Configurator from the Windows Program Manager.
The Mistic MMI Configurator main window appears.

If a previously loaded MMI project is opened under a newer Mistic MMI release, a warning first
appears indicating the “Project is being marked as Modified”. Click OK.

= Mistic MMI Configurator [+]=
File Help (45562K)

Figure 2-2: Mistic MMI Configurator Main Window
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2. Select the File=>0pen Project command.
The Open Project dialog box appears.

If the project was “marked as Modified” (from step 1), you are first asked if you want to save any
changes. Saving the project saves it under the newer Mistic MMI release and makes it incompatible
with older releases. Click “Yes” if you made a backup copy; click “No” if you do not have a backup copy.
Backup all projects before proceeding and start the Mistic MMI configuration process again.

=-| Open Project

c:immi

o :

#= mmi

3 3dsymbol
1 bitmaps
£ examples
1 manual
1 symbols
£ utils *

Drives:
| = c: ms-dos_b |;I

Figure 2-3 Open Project Dialog Box (Mistic MMI)
3. Select a Mistic MMI project and click OK.

Use the directory list box to locate the example project directory in \MIMNEXAMPLES\EXAMPLET. The
Mistic MMI project loads and its graphics appear in the main draw window.

If you installed the MM in a directory other than \MMI, the following message appears: “Can't find the
GML file". This is because the full path name of the GML file is stored in the MMI project file, and that
path includes \MMI. Select OK'in the message box and the Controller List dialog box appears. Select a

controller and click the Modify button. The Controller Properties dialog box is displayed. Click the New

Strategy button and select the .GML file from the directory that contains the example. This updates the
full path name stored in the project file.

4. Choose the Configure= Mistic Controller(s) command.
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The Controllers dialog box appears.

Figure 2-4: Controllers Dialog Box (Mistic MMI)

5. Choose a controller from the Name list box.

If controller names appear in the Name list box, click on a name and click Modify. Make any changes
necessary so the controller properties match the Cyrano strategy.

EXAMPLE 1 DEMO
c:immilexamplesiexampleliexamplel.gml I
GALC32SX | 4]

Figure 2-5: Controller Properties Dialog Box (Mistic MMI)

6. Click OK from the Controllers dialog box.

7. Exit the Mistic MMI Configurator by choosing the File=>Exit MMI Configurator command and save the
changes when prompted by the MMI.
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To Run the Mistic MMI
1. Start the Mistic MMI Runtime from the Windows Program Manager.

2. Select the File=>0pen Project command and use the directory list box to locate the example project
directory in \MIMNEXAMPLES\EXAMPLE1. The Mistic MMI Runtime project loads, its graphics appear in
the main window, and the Event Log Viewer appears. The MMI immediately starts monitoring your
process.

Figure 2-6: Event Log Viewer

Make sure the Event Log Viewer shows a successful connection between your MMI project and Mistic
controllers.
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g | CHAPTER 3

CONFIGURATOR MENUS

OVERVIEW

The MM Configurator is used to develop an operator interface. Define and configure the draw windows and
other graphic objects that make up your project and connect them to the variables, I/0 points, and other tags
defined in your Cyrano strategy.

This chapter gives a brief overview about each of the menu options available in the Configurator.

FILE MENU ITEMS

File

New project...
Open project...
Close project

Save project
Save project as...

Project Path

Lhoose bitmap...
Save as bitmap...

Change printer...
Printer setup...
Print

Exit MMI Configurator

Figure 3-1: File Menu

New project (File Menu)

Use this menu option to create a new project. If a project is loaded which has been modified, a Save Project
dialog box prompts you to save any changes. The New Project dialog box is displayed. Select a directory and
name for the new project. Once the new project has been successfully created, a main window labeled with
the project directory and name, and a draw window labeled “(Untitled)” appears.
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Open Project (File Menu)

Use this menu option to open an existing project. The Open Project dialog box is displayed to select the directory
of the project you want to open. If a project file is currently loaded and has been modified, the Save Project
dialog box appears and prompts you to save any changes before closing the project. Only one project may be
open at a time.

Close Project (File Menu)

Use this menu option to close the project. If the project has been modified, the Save Project dialog box prompts
you to save the project. If you close a project without saving it, all changes made since the last time it was
saved are lost.

Save Project (File Menu)

Use this menu option to save the changes to the current project in the project directory.

To copy a project to a different computer or drive, create a directory with the same name as the directory that
the project files are currently in and copy all the files from the project directory to the new directory.

To copy a project to a directory with a different name than the current project directory, use Save Project As or
create the new directory (no “." allowed in the project directory name), copy all the files from the project
directory to the new directory, and rename all the .\Wnn (nn is a 2-digit number), .MMl and .INI files so that their
file names match the project directory name.

For example, suppose you have a project named PROJ-A in the directory CAMMNPROJECTS\PROJ-A, and want
to create a new project based on it named PROJ-B.

1. First create the new directory:
MKDIR C:\MMNPROJECTS\PROJ-B
2. Next copy all the files from the original directory to the new directory:
COPY C:\MMNPROJECTS\PROJ-AV*.* CAMMNNPROJECTS\PROJ-B
3. Finally, rename the appropriate files:
REN PROJ-A.INI PROJ-B.INI
REN PROJ-A.MMI PROJ-B.MMI
REN PROJ-A.Wnn PROJ-BWnn (Note: do not rename WAV files!)

You are now ready to load the new project.

Save Project As (File Menu)

Use this menu option to save and name the project. This command creates another copy of your project file with
another name or saves it to a different location. To save a project with its existing name, location, and format,
use the Save Project command.
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Project Path (File Menu)

This command displays the full project pathname in a message box. The project pathname is also displayed in
the program’s Title Bar. If the full project pathname is too long to fit in the Title Bar, then only the project name
is shown.

Choose Bitmap (File Menu)

Use this menu option to select a bitmap file. The Choose A Bitmap dialog box prompts you for a bitmap
filename and location. The default bitmap file extension is .BMP. The selected bitmap is drawn whenever the
bitmap tool is used.

Save As Bitmap (File Menu)

Use this menu option to save the selected graphics as a bitmap. The Save As Bitmap dialog box prompts you for
the bitmap filename and location to save the selected graphics. If no graphics are selected, then everything in
the draw window is saved to the bitmap filename. The default bitmap file extension is .BMP.

Change Printer (File Menu)

Use this menu option to select the printer you want. The Choose Printer dialog box appears and shows only
installed printers. The currently selected printer will be highlighted. After selecting an installed printer, a dialog
box titled with the name of the selected printer is displayed showing the current settings and prompts you for
any changes. To change the settings on the current printer, use the Printer Setup command.

Printer Setup (File Menu)

Use this menu option to set the attributes of the printer. A dialog box titled with the name of the selected printer
is displayed, shows the current settings, and prompts you for any changes. To select another printer, use the
Change Printer command.

Print (File Menu)

Use this menu option to print any displayed main and draw windows. The Print dialog box prompts for the
number of copies to be printed. To set the attributes of the printer connection, use the Printer Setup command.
To select another printer, use the Change Printer command.
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Exit MMI Configurator (File Menu)

Use this menu option to exit an MMI Configurator session. The Save Project dialog box prompts you to save the
current project if it has been modified.

Shortcuts

Use the mouse to double-click the control-menu button and close the MMI.

Control-Menu Button —

File  Edit

Figure 3-2: Closing the MMI with the Control Menu Button

Keys:  ALT+F4
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EDIT MENU ITEMS

Edit

Cut Shift+Del
Copy Ctri+Ins
Paste Shift+Ins
Delete Del
Duplicate Ctri+D

Select all

Bring to front
Send to back
Align
Flip/Rotate

Copy to File...
Paste from File...

Edit Dynamic Attributes...

Copy Dynamic Attributes

Paste Dynamic Attributes »
Delete Dynamic Attributes

Figure 3-3: Edit Menu

Cut (Edit Menu)

Use this command to remove selected graphics from a draw window and paste them to the clipboard. Cutting
to the clipboard replaces the contents previously stored there. This command is unavailable if you have no
graphics selected.

Shortcut
Keys:  SHIFT+DEL

Copy (Edit Menu)

Use this command to copy selected graphics onto the clipboard. Copying to the clipboard replaces the contents
previously stored there. This command is unavailable if no graphics are selected.
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Shortcut
Keys:  CTRL+INS

Paste (Edit Menu)

Use this command to insert a copy of the clipboard contents. The clipboard contents are inserted in the middle
of the draw window and can be moved to the desired location. This command is unavailable if the clipboard is

empty.
Shortcut
Keys:  SHIFT+INS

Delete (Edit Menu)

Use this command to delete graphics from a draw window. This command is unavailable if you have no graphics
selected. Deleted graphics do not replace the contents previously stored to the clipboard.

Shortcut
Keys:  DEL

Duplicate (Edit Menu)

Use this command to duplicate selected graphics from a draw window. The duplicate is copied directly below
the selected graphics. Duplicating will not replace the contents previously stored to the clipboard.

Shortcut
Keys:  CTRL+D

Select All (Edit Menu)

This command selects all completed graphics in a draw window. Graphics that are not selected may be
incomplete. Use the Redraw command under the View menu selection to remove the unselected graphics.

Bring To Front (Edit Menu)

Use this command to move one or more graphics in front of another graphics object. This command is unavailable
if no graphics are selected.

Send To Back (Edit Menu)

Use this command to move one or more graphics in back of another graphic. This command is unavailable if no
graphics are selected.
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Align (Edit Menu)

When this command is selected, another window pops up and displays possible alignment selections.

Left

Left justifies the alignment of the selected group of two or more graphics. All selected graphics are aligned
with the leftmost graphic in the group.This command is unavailable if you have not selected at least two
graphics.

Example:

O
:IO [ ]

| |

Before Left-Align After Left-Align

Figure 3-3: Left Alignment of Graphics

Center

Horizontally centers the alignment of the selected group of two or more graphics. This command is unavailable
if you have not selected at least two graphics.

Example:

O -

H |

Before Center-Align After Center-Align

[ ]

Figure 3-4: Center Alignment of Graphics

Right

Right justifies the alignment of the selected group of two or more graphics. All selected graphics are aligned
with the rightmost graphic in the group. This command is unavailable if you have not selected at least two
graphics.
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Example:

)
:IQ [ ]

| |

Before Right-Align Atfter Right-Align

Figure 3-5: Right Alignment of Graphics

Top

Top justifies the alignment of the selected group of two or more graphics. All selected graphics are aligned with
the topmost graphic in the group. This command is unavailable if you have not selected at least two graphics.

Example:

O
[ ] :IHD

|

Before Top-Align After Top-Align

Figure 3-6: Top Alignment of Graphics

Middle

Vertically centers the alignment of the selected group of two or more graphics. The graphics are centered
between the topmost and bottommost graphics. This command is unavailable if you have not selected at least
two graphics.
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Example:

O

EH e

Before Middle-Align After Middle-Align

Figure 3-7: Middle Alignment of Graphics

Bottom

Bottom justifies the alignment of the selected group of two or more graphics. All selected graphics are aligned
with the bottommost graphic in the group. This command is unavailable if you have not selected at least two
graphics.

Example:

O
[ ]

H :IHD

Before Bottom-Align After Bottom-Align

Figure 3-8: Bottom Alignment of Graphics

Flip/Rotate (Edit Menu)

The flip and rotate command changes the orientation and position of graphic elements. The actual movement
depends on the type of graphic(s) selected.
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Flip Horizontal

A horizontal flip replaces the selected graphics with a mirror image about their vertical axis. Text, trends, and
bitmaps have their positions changed but are not mirrored.

I

Before flip After flip

Figure 3-9: Horizontal Flip of a Single Graphic

abe AN D .CD :/ "ab-::.

= A .4

Before flip After flip

Figure 3-10: Horizontal Flip of Multiple Selected Graphics

Flip Vertical

A vertical flip replaces the selected graphics with a mirror image about their horizontal axis. Text, trends, and
bitmaps have their positions changed but are not mirrored.

Before flip  After flip

Figure 3-11: Vertical Flip of a Single Graphic

we N ‘w'w'
A A =

Before flip After flip

Figure 3-12: Vertical Flip of Multiple Selected Graphics
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Rotate Clockwise

Rotates the selected graphic 90 degrees clockwise. If more than one graphic is selected, the center of rotation
is the center of the minimum rectangular area that contains the graphics. Text, trends, and bitmaps cannot be
rotated and any selection of multiple graphics that includes one of these cannot be rotated.

St

Before rotate  After Rotate

Figure 3-13: Clockwise Rotation of a Single Graphic
ll n n

. e
J 4 No.

Before rotate After rotate

Figure 3-14 Clockwise Rotation of Multiple Selected Graphics
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Rotate CounterClockwise

Rotates the selected graphic 90 degrees counterclockwise. If more than one graphic is selected the center of
rotation is the center of the minimum rectangular area that contains the graphics. Text, trends, and bitmaps
cannot be rotated, and any selection of multiple graphics that includes one of these cannot be rotated.

Before rotate  After rotate

Figure 3-15: CounterClockwise Rotation of a Single Graphic
n O [ | n
,‘ ‘ I/ n

n n m

Before rotate After rotate

Figure 3-16: CounterClockwise Rotation of Multiple Graphics

Group (Edit Menu)

Use this command to group any combination of two or more graphics as one graphics object. This command is
unavailable if one or no graphics are selected.

A group is treated as a graphic object. It can be selected, moved, resized, or have dynamic attributes. At
Runtime, only the dynamic attributes assigned to a group are processed, any dynamic attributes assigned to
individual members of a group are ignored (this includes trends). If a group is subsequently Ungrouped, the
previously configured dynamic attributes of ungrouped graphics are configured and processed at Runtime.

Ungroup (Edit Menu)

Use this command to ungroup previously grouped graphics. This allows each graphic object to be individually
selected. This command is only available if a group is selected.

If any of the ungrouped graphics had dynamic attributes prior to grouping, those dynamic attributes will be
configured and processed at runtime.
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Copy To File (Edit Menu)

Use this command to save the selected graphics to a file. A Copy Symbol to File dialog box prompts for the
filename, location, and file format. The default extension for the filename is .SMB. This command is unavailable
if you have not selected any graphics.

Paste From File (Edit Menu)

Use this command to retrieve graphics from a file. The Paste From Symbol File dialog box prompts for the
filename, location, and file format. The default extension for the filename is .SMB.

Edit Dynamic Attributes (Edit Menu)

Use this command to connect a graphic to a Cyrano data item. The Dynamic Attributes dialog box is displayed
for primary graphics showing all applicable dynamic attributes. You are prompted to select input dynamic
attributes or output dynamic attributes. As an example, you can setup connections so the value of a Cyrano tag
changes the color and fill size of a graphic. With output dynamic attributes, you can change the value of a tag
as you “slide” the graphic on the screen. Many different combinations of dynamic attributes are possible.

Different dialog box windows are shown when you want to assign dynamic attributes to an advanced graphic.
For example, the Trend Configuration dialog box is displayed when a trend is selected.

This command is unavailable if no graphics are selected or have selected more than one graphics object.

Copy Dynamic Attributes (Edit Menu)

Use this command to copy a selected primary graphic’s dynamic attributes to another primary graphic. Use the
Paste Dynamic Attributes command to actually assign the copied dynamic attributes to another primary graphic.

This command is unavailable if no graphics are selected or if more than one graphic object is selected, or if no
Mistic controller is configured.

Paste Dynamic Attributes (Edit Menu)

Use this command to assign previously copied dynamic attributes to a primary graphic. You can paste dynamic
attributes to a group of one or more selected primary graphics. During the pasting process, you may choose
whether the attributes of the pasted object should be deleted or if it should have any duplicate attributes
replaced or ignored.

This command is unavailable if no graphics are selected or have not copied another graphic object’s dynamic
attributes. A Mistic controller is configured when you have identified which Cyrano strategy is used for this
project.
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Delete Dynamic Attributes (Edit Menu)

Use this command to delete dynamic attributes of a selected primary graphic. You can delete the dynamic
attribute connections of a group of one or more selected primary graphics.

This command is unavailable if no graphics are selected or have not configured a Mistic controller. A Mistic
controller is configured when you have identified which Cyrano strategy is used for this project.

Edit Object (Edit Menu)

Use this command to edit graphic objects which have unique methods of editing. If a graphic is selected which
can be edited, this menu item is enabled and the text indicates what type of graphic is selected.

Text objects are currently the only graphic which can be edited. Select the text with the select tool and then
choose this menu item. A dialog box appears in which the text may be edited.

3-14 Mistic MMI User’s Guide



CONFIGURATOR MENUS

TOOL MENU

Tool

W Select

Line
Rectangle
Round Rect
Ellipse
Polygon
Polyline
Lurve
Bitmap
Text

Trend

Figure 3-17: Tool Menu

Select (Tool Menu)

The select tool is used to select one or more Primary or Advanced graphics. Most graphic commands, such as
resize or rotate, require objects to be selected before the command is performed. The Select command may be

chosen from the Tools Menu or the Tool Bar.

Tool Bar

Select Tool

Figure 3-18 : Select Tool

To Select One Object:

1. Choose the Select tool.
2. Place the mouse pointer anywhere over the item to be s

3. Click the left mouse button.

elected.

Once selected, the object appears with sizing handles and a selection mark.

pd

||
Object not —_ .E
selected I:I : =
T

Sizing Handles

Selection Mark

II1I

~Object selected

Figure 3-19: Sizing Handles on a Selected Graphic
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To Select More Than One Object:

1.

2.
3.
4.

Choose the Select tool.
Place the mouse pointer just outside the items to be selected.
Hold the left mouse button down.

Drag the select box over the objects to be selected.

Once selected, sizing handles surround the selected objects and selection marks identify each graphic that is
included in the selection.

@ T O

e T o (i
<>7 B& Handles
n L] -
Objects not Objects selected
selecied

Figure 3-20 : Sizing Handles on a Group of Objects

Line (Tool Menu)

Draws a line in the current line style and color. The Line command may be selected from the Tools Menu or the
Tool Bar. A line is a primary graphic.

=]

1
Tool Bar

Line Tool

Figure 3-21 : Line Tool

To Draw a Line:

1.
2.
3.

Select a line color and line style. These choices can be made from the Style menu.
Select the line tool.

Move the mouse pointer into the drawing area.

Press and hold the left mouse button to anchor one end of the line. Drag the pointer. If the cTrL key is
pressed while dragging the pointer, only a vertical or horizontal line is drawn, depending on which axis
the mouse was moved farthest from the anchor point.

Release the left mouse button to place the line.
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Rectangle (Tool Menu)

Draws a rectangle in the current line style, fill pattern, and color. Select the Rectangle command from the Tools
Menu or the Tool Bar. A rectangle is a primary graphic. A square can be easily constructed with the rectangle
tool by holding the cTrL key down while constructing the graphic as described below.

o

Tool Bar

Rectangle Tool

Figure 3-22 : Rectangle Tool

To Draw a Rectangle:

1. Select a line style, fill pattern, and color. These choices are made from the Style menu.
2. Select the rectangle tool.

3. Move the mouse pointer into the drawing area.

4. Press and hold the left mouse button to anchor one corner of the rectangle. If the sHiFT key is pressed
when the mouse button is pressed and stays pressed while dragging the pointer, the initial mouse point
is used to anchor the center of the rectangle rather than the corner.

5. Drag the pointer to size the rectangle. If the cTrL key is pressed while dragging the pointer, a square is
drawn. Pressing both the cTrL key and the sHiFT key produces a square with its center anchored at the
initial mouse point.

6. Release the left mouse button to place the rectangle.

Round Rectangle (Tool Menu)

Draws a rectangle with rounded corners in the current line style, fill pattern, and color. Select the Rectangle
command from the Tools Menu or the Tool Bar. A round rectangle is a primary graphic. A square with rounded
comners can be easily constructed with this tool by holding the cTrL key down while constructing the graphic, as
described below.

=

— |

Tool Bar

Round Rectangle Tool

Figure 3-23: Round Rectangle Tool
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To Draw a Round Rectangle:

1. Select a line style, fill pattern, and color. These choices can be made from the Style menu.
2. Select the round rectangle tool.

3. Move the mouse pointer into the drawing area.

4. Press and hold the left mouse button to anchor one comer of the rectangle. If the sHiFT key is pressed
when the mouse button is pressed and stays pressed while dragging the pointer, the initial mouse point
will be used to anchor the center of the rectangle rather than the corner.

5. Drag the pointer to size the rectangle. If the cTrL key is pressed while the pointer is dragged, a square
will be drawn. Pressing both the cTaL key and the sHiFT key will produce a square with its center
anchored at the initial mouse point.

6. Release the left mouse button to place the rectangle.

Ellipse (Tool Menu)

Draws an ellipse or circle in the current line style, fill pattern, and color. The Ellipse command may be selected
from the Tools Menu or the Tool Bar. Ellipses and circles are primary graphics. A circle can be easily constructed
with this tool by holding the cTrL key down while constructing the graphic as described below.

—

A

Tool Bar

Ellipse Tool

Figure 3-24: Ellipse Tool

To Draw an Ellipse or Circle:

1. Select a line style, fill pattern, and color. These choices can be made from the Style menu.
2. Select the ellipse tool.

3. Move the mouse pointer into the drawing area.

4. Press and hold the left mouse button to anchor one comer of the ellipse. If the sHiFT key is pressed when
the mouse button is pressed and stays pressed while the dragging the pointer, the initial mouse point is
used to anchor the center of the ellipse rather than the corner.

5. Drag the pointer to size the ellipse. If the cTrL key is pressed while the pointer is dragged a circle will be
drawn. Pressing both the cTrL key and the sHiFT key produces a circle with its center anchored at the
initial mouse point.

6. Release the left mouse button to place the ellipse.
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Polygon (Tool Menu)

Draws an N-sided polygon in the current line style, fill pattern, and color. Select the Polygon command from the
Tools Menu or the Tool Bar. A polygon is a primary graphic.

=1
o
Tool Bar

Polygon Tool

Figure 3-25: Polygon Tool

To Draw a Polygon:

1.

o o &~ W

Select a line style, fill pattern, and color. These choices can be made from the Style menu.
Select the polygon tool.

Move the mouse pointer into the drawing area.

Press and hold the left mouse button to anchor the first vertex of the polygon.

Drag the pointer to the next vertex of the polygon.

Release the left mouse button to place the vertex. Repeat for each vertex.

When the last vertex has been placed, click on the last vertex to complete the polygon.

An alternate way to close the polygon is to double-click the left mouse button to close the polygon once
the last vertex has been placed. In addition to closing the polygon, it selects it, and presents the Graphic
Dynamic Attributes dialog box.

Polyline (Tool Menu)

Draws a multi-segment line in the current line style and color. A polyline appears to be several individual lines,
but actually is one graphic object. Polylines are useful when complex line drawings are connected to Dynamic
Attributes. Select the Polyline command from the Tools Menu or the Tool Bar. A polyline is a primary graphic.

=
[

il
Tool Bar

Polyline Tool

Figure 3-26: Polyline Tool
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To Draw a Polyline:

1. Select a line style and color. These choices can be made from the Style menu.

2. Select the polyline tool.

3. Move the mouse pointer into the drawing area.
4. Press and hold the left mouse button to anchor the beginning of the polyline.
5. Drag the pointer to the end of the first line segment.

6. Release the left mouse button to place the line segment. Repeat for each segment.

7. When the last segment is placed, double-click the left mouse button to complete, select the polyline,
and display the Graphic Dynamic Attributes dialog box.

Curve (Tool Menu)

Draws a curve in the current line style and color. The curve is drawn based on points placed in the draw window.
After placing a fourth point, a curve is drawn. If you continue placing points, additional curves are connected
with every third point that's placed.

Select the Curve command from the Tools Menu or the Tool Bar. A curve is a primary graphic.
—

Curve Tool

Tool Bar

Figure 3-27: Curve Tool

To Draw a Curve:

1. Select a line style and color. These choices can be made from the Style menu.
2. Select the curve tool.
Move the mouse pointer into the drawing area.

Click the left mouse button to anchor the beginning of the curve.

o &~ W

Click the left mouse button at the second, third, and fourth points.
A curve is drawn after the fourth point is placed.

6. Continue placing points to draw the desired curve.

A curve is drawn after every third point that is placed.

7. To complete the curve, click on the last point one more time.
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Curve
First and second points Third and fourth points
are tangent to the starté____ _A are tangent to the end
of the curve of the curve

Figure 3-28: 4-Point Curve Construction

Bitmap (Tool Menu)

Places a bitmap into the drawing area. Bitmaps are useful for highly detailed drawings or when other drawing
programs are used to produce graphic symbols. Select the Bitmap command from the Tools Menu or the Tool
Bar. A bitmap is a primary graphic.

| -

o
Toal Bar

Blimap Tool

Figure 3-29: Bitmap Tool

To Place a Bitmap:

1. Select Choose Bitmap from the File Menu.
2. Choose a bitmap file (*.BMP) from the dialog box.

Select the bitmap tool.

>~ w

Move the mouse pointer into the drawing area.

5. Click the left mouse button at the desired bitmap location. The bitmap is centered at this point.

Text (Tool Menu)

Places character text in the drawing area in the current font style, size, and color. Select the Text command from
the Tools Menu or the Tool Bar. Text is a primary graphic.

—1

[T
Tool Bar

Text Tool

Figure 3-30: Text Tool
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To Place Text:
1. Select a text font, size, and color. These choices can be made from the Text menu.

2. Select the text tool.

3. Move the mouse pointer into the drawing area.
4. Click the left mouse button to anchor the starting position of the text.
5. Type the desired text. Use the backspace key to erase mistakes.

6. Move the mouse pointer away from the text and click the left mouse button to end the text entry.

Trend (Tool Menu ltems)

Places a strip-chart style data trend in the drawing area. Select the Trend command from the Tools Menu or the
Tool Bar. Trends are advanced graphics. Refer to Chapter 8, Trends, for more details about trends.

Ea

Trend Tool

Tool Bar

Figure 3-31: Trend Tool from the Toolbar

To Place a Trend:

1. Select the trend tool.
2. Move the mouse pointer into the drawing area.
Press and hold the left mouse button at the desired location.

Drag the mouse to size the trend.

o &~ W

Release the mouse to complete placing the trend.

To edit the trend parameters, select the trend with the Select tool and then choose the Edit>Edit Dynamic
Attributes command. See the Trend dialog box for mare trend configuration information.

3-22 Mistic MMI User’s Guide



CONFIGURATOR MENUS

STYLE MENU

The Style Menu allows you to control the drawing attributes of the primary graphic tools. Whenever a primary
graphic, such as a line or rectangle is drawn, the default style is applied. Combining different style settings
allows you to draw an almost infinite variety of graphics. A style is set before an object is drawn or changed.
Advanced graphics, such as trends and bitmaps are not affected by style settings. Text drawing attributes
which include font style, color, and size are controlled with the Text menu.

Style
Line Color...
Line Width...
Line Style ’

Fill Color...
Fill Pattern »

Opaque
v Transparent

Figure 3-32: Style Menu

Line Color (Style Menu)

Set or change a primary graphic’s line color. All primary graphics will have this default line color.

To Set the Default Line Color:
1. Select Line Color from the Style Menu.

2. Adialog box of available colors is displayed.

3. Choose the desired color.

To Change the Line Color of an Existing Primary Graphic:

1. Use the select tool to select the graphic(s).

2. Select Line Color from the Style Menu. A dialog box of available colors is displayed.
3. Choose the desired color.

Only the line color of the selected object(s) is affected.
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Line Width (Style Menu)

Set or change a primary graphic’s line width.

(L[N FLEN L B

Figure 3-33: Sample Line Widths

To Set the Default Line Width:
1. Select Line Width from the Style Menu.

2. Enter the line width in the dialog’s edit box.

3. The line width is given in number of pixels. All primary graphics will have this default line width.

To Change the Line Width of an Existing Primary Graphic:

1. Use the select tool to select the object.
2. Select Line Width from the Style Menu.
3. Enter the line width in the dialog’s edit box.

Only the line width of the selected graphic is affected.

Line Style (Style Menu)

Set or change a primary graphic’s line style. Different line styles only apply to objects with line width of 1. Line
widths greater than 1 are always solid.

Solid
— — —— — Dashed
------------ Dot
—_— - — - — - DashDot
—_———————-- DashDotDot

Figure 3-34: Sample Line Styles
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To Set the Default Line Style
1. Select Line Style from the Style Menu.

2. Choose the desired line style from the pop-up menu.

All primary graphics will have this default line style.

To Change the Line Style of an Existing Object

1. Use the select tool to choose the object.

2. Select Line Style from the Style Menu.

3. Choose the desired line style from the pop-up menu.

Lines with a line width greater than 1 can only have a solid line style.

Invisible

The invisible line style is used with rectangles, round rectangles, ellipses, and polygons. If these objects are
drawn with the invisible line style, the border line around the object is not displayed.

Border visible Border invisible
~ —
With solid  With invisible
line style line style

Figure 3-35: Example of Invisible Line Style

Fill Color (Style Menu)

Set or change a primary graphic’s fill color. Fill colors only affect rectangles, round rectangles, ellipses, and
polygons.

To Set the Default Fill Color:
1. Select Fill Color from the Style Menu.

2. Adialog box of available colors is displayed.
3. Choose the desired color.

All rectangles, round rectangles, ellipses, and polygons will have this default fill color.
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To Change the Fill Color of an Existing Rectangle, Round Rectangle, Ellipse, and Polygon:

1. Use the select tool to choose a graphic.
2. Select Fill Color from the Style Menu.
3. Adialog box of available colors is displayed.

4. Choose the desired color.

Fill Pattern (Style Menu)

Set or change a primary graphic's fill Pattern. Fill patterns only affect rectangles, round rectangles, ellipses, and
polygons.

To Set the Default Fill Pattern:
1. Select Fill Pattern from the Style Menu.

2. Amenu of available patterns is displayed.
3. Choose the desired pattern.

All rectangles, round rectangles, ellipses, and polygons will have this default fill color.

To Change the Fill Pattern:

1. Use the select tool to select a graphic.

2. Select Fill Pattern from the Style Menu.
3. Amenu of available patterns is displayed.
4. Choose the desired pattern.

Only the fill pattern of the selected object is affected.

Solid and Invisible

The solid and invisible fill determine if an objects fill is displayed. If the fill is invisible, then only the object’s
border is displayed.

)

Fill pattern Fill pattern
solid invisible

Figure 3-36: Example of Solid and Invisible Fill
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Percent

When using a percent fill, you can control the tone of the fill by setting a percentage of fill. Percent fills do not
affect vertical, horizontal, diagonal, hatch, pebble, or brick fill patterns.

10 15 30 50 70 8b

Figure 3-37: Example of Percent Fills

Patterns:

In addition to the solid and percent fills, several patterns may be selected as fill objects.

d a ¢

Vertical Horizontal Diagonal

4 @& 4

Hatch  Pebble Brick

Figure 3-38: Example Fill Patterns

Opaque (Style Menu)

The Opaque style is used to determine how non-solid primary graphics, such as dotted and dashed lines,
interact with overlapping graphics and background colors. When the opaque style is set, overlapped graphics
and background colors are overwritten.

Transparent (Style Menu)

The Transparent style is used to determine how non-solid primary graphics, such as dotted and dashed lines,
interact with overlapping graphics and background colors. This is the opposite of the Opaque style. When the
transparent style is set, overlapped graphics and background colors are overwritten only by the solid portion of
the line.
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VIEW MENU ITEMS

Yiew
Hide MenuBar
Hide ToolBar
Hide Coordinates

Grids...

Redraw

Figure 3-39: View Menu

Hide Menu Bar (View Menu)

Use this command to hide the Menu Bar. The Esc key toggles the menu bar on and off.

Mistic MMI Configurator - [Untitled)
File Edit Tool Style Yiew Text Window Configure Help

Figure 3-40: Menu Bar

Shortcut
Key: ESC

Hide\Show ToolBar (View Menu)

Use this command to hide or show the ToolBar. The ToolBar has buttons for the primary graphics and advanced
graphics. If the ToolBar is hidden, the Show ToolBar command is displayed and you can use this command to
show the ToolBar. If the ToolBar is displayed, then the Hide ToolBar command is shown and you can use this
command to hide the ToolBar.

Hide\Show Coordinates (View Menu)

Use this command to hide or show the coordinates display of the draw window. The coordinates tell you the
position of the cursor within the draw window. If the coordinates display is hidden, the Show Coordinates
command is displayed. Use the Show Coordinates command to display the coordinates. If the coordinates
display is shown, the Hide Coordinates command is displayed.
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Grids (View Menu)

Use this command to make grid changes to the draw window. A Grid dialog box window is displayed and
prompts you to toggle the grid on or off, toggle the Snap On or Snap Off, and to enter a grid size. The grid size
refers to the spacing of grid points, measured in pixels. For example, a grid size of 10 means a grid point will
appear every 10 pixels.

There will be a checkmark by the Grids command if a grid should be displayed and entries are made to affect
the grid size. Sometimes grids do not appear because the grid size is too big for the draw window.

Hide\Show Grid (View Menu)

Use this command to hide or show a grid in the draw window. If the grid is hidden, the Show Grid command is
displayed. Use this command to show the grid. If the grid is shown, the Hide Grid command is displayed. Use
this command to hide the grid. To make changes to the grid, use the View—>Grids command.

Turn Snap On\Off (View Menu)

Use this command to toggle the Snap On or Snap Off feature for the active draw window. If Snap On is enabled,
the Snap Off command is shown. Use this command to turn off the feature. If Snap Off is enabled, the Snap On
command is shown. Use this command to turn on the feature. To make changes to the grid, use the View—>Grids
command.

Redraw (View Menu)

Use this command to redraw the contents of your draw window. Incomplete primary graphics (such as an
incomplete polygon) appearing in the window are removed upon a redraw.
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TEXT MENU ITEMS

The Text Menu Items allow you to control text attributes. Text placed in the drawing area with the Text Tool,
applies the current font style, size, and color. A text style may be set before the text is drawn or changed after
it is placed. Style attributes selected from the Style menu do not affect text.

Text
Font 2

Size...
Color...
Background...

v Mormal
Bold
Italic
Underline
Strikeout

Opaque
v Transparent

Figure 3-41: Text Menu

Font (Text Menu)

Sets or changes a text font. The style or appearance of each character in a text string is called a font. The MMI
currently supports several fonts.

Opto 22 Fixed Serif
Opto 22 Fixed SanSerif
Opto 22 Prop Serif

Opto 22 Prop SanSerif

Opto 22 Stroke Serif
Opto 22 Stroke Sansenf
Opto 22 Script

Figure 3-42: Examples of Supported Fonts
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To Set the Default Text Font:

1. Select Font from the Text Menu.
2. Amenu displays available fonts.
3. Choose the desired font.

All text will have this default font style.

To Change the Font Style of an Existing Text String:

1. Use the select tool to select the string.
2. Select Font from the Text Menu.

3. Amenu displays available fonts.

4. Choose the font.

Only the font style of the selected text string is affected.

Size (Text Menu)

Sets or changes text size. In addition to the font style, the size may be set to enhance the text appearance. The
size of the text is specified in points. The smaller the point size, the smaller the text. For currently supported
fonts, any point size may be used, however point sizes less than eight are difficult to read.

CyTam 10 Point
Cyrano 12 Point
Cyrano 16 Point

Cyrano 20 Point

Figure 3-43: Example of Prop Serif Font at Different Point Sizes

To Set the Default Text Size:

1. Select Size from the Text Menu.
2. Enter the point size in the dialog’s edit box.

All text will have this default font size.

To Change the Font Size of an Existing Text String:

1. Use the Select tool to select the string.
2. Select Size from the Text Menu.
3. Enter the point size in the dialog’s edit box.

Only the font style of the selected text string is affected.
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Alternate Method:

1. Use the Select tool to select the string.
2. Grab one of the string’s sizing handles.

3. Move the sizing handle to the new size.

Color (Text Menu)

Sets or changes text color. Lines, boxes, and text strings may appear in any color.

To set the default text color:

1. Select Color from the Text Menu.
2. Amenu displays available colors.
3. Choose the desired color.

All text will have this default color.

To Change the Color of Existing Text:

1. Use the select tool to select the text string.
2. Select Color from the Text Menu.

3. A menu displays available colors.

4. Choose the desired color.

Only the color of the selected text is affected.

Background (Text Menu)

Sets or changes the text background color. Background colors only apply to Opaque text. Text that is Transparent
is not affected by this setting.

To Set the Default Text Background Color:

1. Select Background from the Text Menu.
2. Amenu displays available colors.
3. Choose the desired color.

All text will have this default background color.
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To Change the Background Color of Existing Text:

1. Use the select tool to select the text string.
2. Select Background from the Text Menu.

3. Amenu displays available colors.

4. Choose the desired color.

Only the background color of the selected text is affected.

Text Type Face (Text Menu)

Sets or changes a text type face. In addition to text font style, size, and color, text type faces further enhance the
appearance of text. Currently normal, bold, italics, underling, and strikeout type faces are supported.

Oplormux - Moarmal
Optamux  Bold
O Halic

Cptomux  Underling
Optemus  Strikeout

Figure 3-44: Examples of Text Type Faces

To set the default text type face, select Normal, Bold, Italic, Underline, or Strikeout from the Text menu. Checkmarks
on the menu items indicate the characteristics of the default type face. All text subsequently created will have
this default type face.

To Change the Type Face of Existing Text:

1. Use the select tool to select the text string.
2. Select one of the type faces from the Text menu.

Only the type face of the selected text is affected.

Opaque (Text Menu)

The opaque setting determines how text appears when overlapping other objects. If the text is set to opaque,
objects under the text will be overwritten by the text and text background color. The text background lies just
outside the text. Also see Transparent (Text Menu Items).

Object overwritten
Opaqua by opaque text
Figure 3-45: Example of Opaque Text:

To set opaque default text, select Opaque from the Text menu.
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To Change Existing Text:

1. Use the select tool to select the text string.
2. Select Opaque from the Text menu.

Only the selected text is affected.

Transparent (Text Menu)

The transparent setting determines how text appears when overlapping other objects. If the text is set to
transparent, objects under the text will be visible and not affect the text background color. Also see Opaque
(Text Menu Items).

Object is visible
Transpa' under text

Figure 3-46: Example of Transparent Text

To set transparent default text, select Transparent from the Text menu.

To Change Existing Text:

1. Use the select tool to choose the text string.
2. Select Transparent from the Text menu.

Only the selected text is affected.

WINDOW MENU

Window
New...
Open...
Close...

Copy...
Delete

Properties...

1 MAIN
2 PUMP 1
3 PUMP 2
4 CLIP

5 SET POINTS

Figure 3-47: Window Menu
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The MMI Configurator allows you to configure several draw windows per project. The Window menu items
control the number and properties of each draw window in a project. You can create new draw windows,
delete draw windows, copy draw windows, and change properties of existing draw windows.

New (Window Menu)

Use this command to create a new draw window and add it to your project. When you create a new project, a
new draw window is automatically added.

To add a new draw window to a project, select New from the Window Menu. The Window Properties dialog
box is displayed and allows you to configure the name, size, behavior, and window attributes. You must provide
a unique name for each draw window.

Open (Window Menu)

Use this menu item to open draw windows that are configured but currently closed. To open a window, select
Open from the Window menu. The Open Window dialog box is displayed and lists the names of all draw
windows that are closed. Select the name of the windows you wish to open. Draw windows open when a
project is saved are opened when the project is started at Runtime. This can be modified by using the
Configure—> Runtime menu command.

Close (Window Menu)

This menu item is used to close draw windows that are currently open. To close a window, select Close from the
Window menu. The Close Window dialog box is displayed and lists the names of all opened windows. Select
the names of the draw windows you wish to close. Draw windows that are closed when a project is saved, are
closed when the project is started at Runtime. This can be modified by using the Configure—=Runtime menu
command.

Copy (Window Menu)

This menu item is used to duplicate the current draw window. To copy a window, select Copy from the Window
menu. In the dialog box enter a new name and any properties you wish to change. All graphics and their
connections in the current draw window are copied to the new draw window. The Copy Window dialog box is
displayed allowing you to configure the name, size, and window attributes. You must provide a unique name to
the new draw window.

Delete (Window Menu)

This menu item is used to delete the current draw window. To delete a draw window, select Delete from the
Window menu. All graphics and their connections in the current draw window are deleted and the draw
window is removed from the project. A dialog box is displayed asking you to verify the operation. Use caution
since deleted draw windows cannot be recovered.

Mistic MMI User's Guide 3-35



CONFIGURATOR MENUS

Properties (Window Menu)

This menu item is used to modify the properties of an existing draw window. To change a draw window’s
properties, select Properties from the Window menu. Enter the new draw window properties in the dialog box.
The Window Properties dialog box allows you to change the name, size, behavior, color, and attributes of a
draw window.

Open Window List (Window Menu)

Currently opened or iconified windows are listed in the Window Menu. Up to nine window names are displayed.
If more than nine windows are open, a menu item named More Windows is appended.

Select a draw window name to display that draw window in front of all other open draw windows. If more than
nine windows are open, selecting More Windows displays a list box with all the names of opened windows.
Select from the list box the window you want brought to the front. A window must be open or iconified for it to
be listed.

CONFIGURE MENU ITEMS

3-36

Configure

Mistic Controller(s)...
Refresh Times...

Historic Data Log...
Event Loq...

Applications...
Sounds...
Window State...
Recipes...

Run Time...

Figure 3-48: Configure Menu

Mistic Controllers (Configure Menu)

Use this command to select which Cyrano Strategy (or strategies) are used for this project. The MMI Configurator
uses the information from the strategy to connect the appropriate Cyrano data item to the dynamic attribute of
a dynamic object. The Controller Properties dialog box prompts for the Cyrano strategy. If a Cyrano strategy is
not configured for this project, dynamic attributes cannot be assigned to any dynamic objects.

Refresh Times (Configure Menu)

Use this command to change the refresh time for a refresh time group. The Refresh Time Group dialog box
prompts you for the new times. Refer to Chapter 5, Scanning, for more information about configuring refresh
times.
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Historic Data Log (Configure Menu)

Use this command to create historic logs. A Historic Log List dialog box is displayed and lists the historic log
files that have been created. This command allows you to modify which points are recorded and the data
logging frequency to the files.

Event Log (Configure Menu)

Use this command to record a message caused by an event to the disk. You can change parameters such as the
number of messages saved, the delimiter used between messages, and the file rollover period.

File names are dependent upon the rollover period specified within the Event Log File Configuration dialog box
and follow the format:

yy = year, mm = month, dd = day, and hh = hour.

File name extensions are .MSG. The number of files retained on disk for an event log is also set within the Event
Log File Configuration dialog box. When the limit is reached during Runtime, the file with the oldest DOS time
stamp is deleted.

Applications (Configure Menu)

Use this command to add or modify application managers for use in the project. The Application Manager List
dialog box displays available application managers for the project. The Application Manager Configuration
dialog box lets you select the program file, working directory, launch options, the initial display view, and trigger
associated with the application manager.

Sounds (Configure Menu)

Use this command to select sounds and assign their trigger for use in the project. The Sounds dialog box lists
the available sounds for the project. The Sound Configuration dialog box lets you configure start and stop
triggers with the Trigger dialog box. The Sound Configuration dialog box also prompts you for the sound file.

Window State (Configure Menu)

Use this command to add or make changes to existing window managers. The Window Manager List dialog
box displays all currently configured window managers and allows access to the Window Manager Configuration
dialog box. The Window Manager Configuration dialog box allows you to change triggers with the Window
Manager Start Trigger dialog box and to control the draw window visual state with the Pop Window dialog box.

Run Time (Configure Menu)

Use this command to define the initial setup of the draw windows at runtime. For example, you may want to
have certain draw windows pop-up and have others iconified when the project starts.

This command can also be used to prevent user exit from MMI Runtime when this project is loaded.
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Recipes (Configure Menu)

Use this command to configure download or upload of recipes to a controller by a trigger. This method of recipe
management does not require a graphic to be selected during Runtime for the recipe action to occur. To control
recipe action by toggling a graphic, refer to the Dynamic Attribute Download Recipe or to the Dynamic Attribute
Upload Recipe.

HELP MENU ITEMS

Help

Lontents
Search for Help On...
How to Use Help

About MMI Configurator ...

Figure 3-49: Help Menu

Contents (Help Menu)
Starts Help and displays help topics for the MMI Configurator.

Search for Help On (Help Menu)

Opens the Search dialog box for MMI Configurator Help. Use the Search dialog box to look up Help information
by using keywords.

How to Use Help (Help Menu)

Describes how to use Help.

About MMI Configurator (Help Menu)

Displays version information about the MM Configurator.
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CONTROLLER CONFIGURATION

OVERVIEW

Controllers need to be configured in the MMI Configurator so that the MMI Runtime can communicate to
them. Each controller you configure requires a controller name and address, communication rate, and the
name of a Cyrano strategy.

The first part of this chapter discusses communication protocols available between the Mistic controllers.
Review this information before configuring your controllers. Following this discusion, is detailed information
about the dialog boxes used to configure controllers.

CONTROLLER COMMUNICATION

The Mistic MMI communicates with multiple networked Mistic processors via ARCnet, RS-485, fiber optic,
RS-232 connections using logical Windows communication ports, or the Mistic Data Server (MDS). Serial
communication is performed using either Binary or modem ASCII modes.

ARCnet

Communication with Mistic processors via ARCnet requires a PC bus adapter card (8 or 16 bit) based on the
SMC ARCnet chip. This is the recommended form of communication because it provides the best data throughput
and is an economical solution. Using passive or active ARCnet hubs, you can connect up to 254 additional
ARCnet nodes such as Mistic processors and other PCs on the network. Refer to Table 4-1 and 4-2 for more
detailed ARCnet specifications and MisticNET (ARCnet) cabling information.
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Table 4-1: ARCnet Port Specifications

Transfer rate

2.5 megabits/sec.

Termination

93 ohms

Address range

1 to 255, 0 not used

Topology Star
Cable type RG62A/U
Connector type BNC

Normal signal levels

20 VPP output, 7.5 VPP input

Minimum signal levels

16 VPP output, 6.0 VPP input

Access time

Deterministic (token passing)

Table 4-2: ARCnet Cable Specifications

Maximum ARCnet Cable Distances
Between two farthest NIMs? 20,000 ft.
Between active NIM and active NIM 2,000 ft.
Between active NIM and passive NIM? 100 ft.
Between passive NIM? and controller 100 ft.
(or host PC)

1 NIM stands for network interface module (i.e., PC card,
M4RTU, or active or passive hub).
2 Passive boards cannot be linked directly to one another

without an ARCNET network.

The following ARCnet boards have been tested and are recommended:

ISA BUS Computers:

e Model ARCnet PC-130 Network Controller Board

Standard Microsystems Corporation

Microchannel BUS:

e Model PDIuC508 ARCnet for IBM PS/2 Models 50, 60, 80

Pure Data Ltd.
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RS-485 and Fiber Optics (AC37/AC42)

The AC37 isa 16 hit ISA bus adapter card that provides high-speed, two-wire or four-wire RS-485 communication
atrates of up to 115.2 KB. As many as 255 Mistic processors can be networked in a daisy-chain fashion over a
combined distance of 3,000 feet. The AC37 provides optical and transformer isolation for your PC's safety. It is
recommended that one AC38 Repeater Brick be used for every 30 processors on the communication link.
Communications wire type is a shielded twisted pair.

The AC42 is a 16-bit ISA bus adapter card that provides a fiber optic communications port to Mistic products.
RS-485 information at baud rates of up to 115.2 KB is transmitted over the fiber cable. Fiber optic networks can
be 3.5 kilometers (about 11,480 feet) and offer a data link that is electrically isolated and completely immune to
electrical noise. OPTO 227 fiber optic receivers and transmitters are optimized for 62.5/125 mm cable with
“ST" style connectors. Other fiber diameters can be used, but performance specifications fall off rapidly. Up to
255 Mistic processors can be networked on a fiber optic data link. A diagram of typical connections is shown in
Figure 4-1.

Figure 4-1: Fiber Optic Communications

See the Communications chapter of the “Mistic 200 Systems Installation Guide”, Form 595, for information on
communications wiring and connectors.

Windows Communication Port / RS-232

RS-232 communications can be implemented using the logical Windows communication ports. The four logical
ports are configured using the control panel icon in the Main program group. Four parameters are automatically
set by the Mistic driver when the port is used. These parameters include the Baud Rate, Number of Data Bits,
Parity, and Number of Stop Bits. The three remaining parameters must be set as follows:

Flow Control None
Base I/0 Port Address  Must match current hardware settings
Interrupt Request Line  Must match current hardware settings

MMI uses Window's serial drivers for RS-232 communication. Some versions of the serial drivers do not work
well when using RS-232 in binary mode. Third party serial communication drivers are available and solve some
of these problems. The following problems with the Windows serial drivers have been identified:
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Version: Windows 3.1

Result: Binary mode does not work since the parity bit does not change on-the-fly.

Work-Around: Use ASCII mode, the Opto 22 P/N AC37 adapter card for RS-485 communication, or
third party drivers.

Version: Windows For Workgroups 3.11

Result: Binary mode works but very slowly due to 400 msec time delays.

Work-Around: Use ASCII mode or use AC37. ASCII mode actually runs faster than binary.

Binary Serial Communications Mode

Binary mode optimizes communications by using the parity bit. In binary mode, parity is normally low for all
bytes except the address byte where the parity is forced high. The Mistic 200 controller can then quickly accept
(orignore) incoming commands using hardware interrupts. This allows the controller to spend less time servicing
communications on networks with several Mistic 200 controllers. Communication parameters are: 8 data bits,
1 stop bit and a parity bit as previously described.

Format of command sent to controller:

Address Tbyte, 01-FF
Length 1 byte
Command to controller My Data @ .

CRC-16 2 bytes

Format of response from controller:

Length 1 byte
Error Code 1byte  0=no error

Response from controller 123

CRC-16 2 bytes
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Modem ASCII Serial Communications Mode

This communication mode allows communications to serial devices that cannot support binary communications,
such as telecommunication modems or RF modems.

The G4LC32 controller offers the modem-ASCIl option in its configuration and is accessed with the SETUP
button. If you have an older G4LC32SX, it requires a separate set of EPROMSs for modem ASCII mode. Newer
G4LC32SX controllers with Flash EPROMSs have an optional jumper to select this feature.

Table 4-3: EPROMSs for ASCIl Modem Communication

Minimum Description
Version P
107 Display EPROM

(G4LC32)

1.37 mistic kernel EPROM

Comparing Binary with Modem ASCII Serial Communications

Modem ASCII packets are similar to the binary packets above with these exceptions:
e The contents of commands and responses are identical.

e With ASCII mode, each byte is sent as two characters representing the hex value. For example, a byte
with a value FF (hex) would be sent as two “printable” ASCII characters like this: “FF”.

Other differences between binary and modem ASCII modes are shown in Table 4-4.
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Table 4-4: Binary and Modem ASCIl Comparison

Command to Controller

by the address byte ‘Mark’ parity.

Binary Modem ASCII
. ‘Space’ ,except for the first byte
Parity (address byte) which is ‘Mark’ parity None
Start Byte: None. The start of the packet is indicated | A “>" character

Start Byte: None. A “<” character
Response to Controller
End byte :ggesylz:cket size is determined by the carﬁajzgrftum
Data bits 8 8
Stop bits 1 1
Binary Command Example:
Address Length Command CRC
1 byte 1 byte 7 bytes 2 bytes
FF 09 VERSION Tp
ASCIl Command Example:
Start  Address Length Command CRC End
Tbyte 2 bytes 2 bytes 14 bytes Abytes  1hyte
" “FF" 09" “56455253494FAE"  "5470 cr
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MDS

MDS (Mistic Data Server) is a DDE software application which allows multiple Mistic MMIs and DDE applications
to access data from Mistic controllers. DDE (Dynamic Data Exchange) is a standard interprocess communication
protocol for Windows for Workgroups and Windows NT. Linked DDE applications can easily and efficiently be
updated with current data from your Mistic controllers. Two software programs make up the MDS package: the
MDS Administrator, and MDS.

The MDS Administrator is used to:

e Configure the physical ports MDS uses to communicate with Mistic controllers
e Set scan times for DDE-aware clients

e Set time-outs between MDS and Mistic controllers

MDS is a stand-alone PC application used to:

e (ollect data from attached Mistic controllers

e Send only changed data to all registered DDE-aware and Mistic MMI clients

e Display DDE conversation message logging

Use MDS to provide real-time information to multiple PC workstations needing data from the same Mistic
controller(s), without slowing down the controller’s performance. Typically, a system with several computer
terminals, each running Mistic MMI and/or DDE-aware clients (such as Microsoft Excel or Microsoft Word), are
networked to a PC running MDS. The PC running MDS has a direct physical connection to Mistic controllers via
a MisticNET protocol (ARCnet, RS-485, or any other Mistic controller supported communication option). MDS
scans controllers at a preset rate and informs clients of any changes in data.

Without MDS, each client would need to scan Mistic controllers for data updates. This would result in slower
throughput rates from the controllers. Each time a controller is scanned, its resources are used to read 1/0
instead of processing the control strategy.
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DIALOG BOXES

The dialog boxes used to configure controllers in the MMI Configurator are discussed in this section. The
Controller dialog box lists the currently configured controllers for the MMI. Adding a controller or modifying
controller properties displays the Controller Properties dialog box. The PC Com Port Configuration option selected
displays the appropriate dialog box to configure the communication port on the MMI computer.

Controllers Dialog Box

To add and configure Mistic controllers, choose the Configure=>Mistic Controllers menu option. This displays
the Controllers dialog box.

= Controllers

Name ‘ Add. I
OFTO DEMO BOX

‘ brpelify I

‘ Pelate I

V 0K xCancel ? Help

Figure 4-2: Controllers Dialog Box

The Name list box displays a list of controllers available for the MMI project. The controller names are the same
names used in your Cyrano strategy. The properties you enter for each controller are saved by clicking OK

‘ Add._ | To add controllers to the Name list box, click the Add button. The Controller

Properties dialog box appears (Figure 4-3). The dialog box is described in the
next section.

‘ Modify. .. | To modify properties for controllers shown in the Name list box, click the

Modify button or double-click on its name. The Controller Properties dialog
box appears (Figure 4-3). The dialog box is described in the next section.
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Delete Deletes controllers from the Name list box. A Delete Controller dialog box

appears and asks for confirmation about the controller you want to delete.
Click Yesto delete the name from the list , or Noto void the delete request.

Controller Properties Dialog Box

Clicking Add or Modify in the Controllers dialog box displays the Controller Properties dialog box (Figure 4-3).
After setting all options, click UK to save the changes.

= Controller Properties

Name: |OPTO DEMO BOX

Strategy:|c::\mds_mmi\cyranu\watermds.gml | | Browse. .. I

Type: Address: (1 - 200)

PC Com Port Configuration:

Port [ARCNET [#] | setup.. |

V 18 xl:ancel ? Help

Figure 4- 3: Controller Properties Dialog Box

Name Toadd a controller, enter its name exactly as it appears in the Cyrano strategy.
Use the Browse button to easily find your Cyrano strategy and enter the
controller's name and other properties. If you selected the Modify button
from the Controllers dialog box, the controller name automatically appears.
Cyrano files end with a .GML extension.

Strategy To specify the name of the Cyrano strategy running in your controller, enter
the full pathname of the file. Use the Browse button to easily enter the
filename. Cyrano strategy files end with a .GML extension. If you selected
the Modify button from the Controllers dialog box, the controller strategy
name automatically appears.

Type To select the Mistic controller model you are configuring, choose an option
from the Type drop-down list. The options are: GALC32, G4LC32SX,
G4ALC32ISA, and M4RTU. If you selected the Modify button from the

Controllers dialog box, the controller type automatically appears.
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Address

Port

Setup...
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To select the controller's address, enter a value in the Address field. If you
selected the Modify button from the Controllers dialog box, the address
automatically appears.

Table 4-5: mistic Controller Address Ranges

Controller Address Range
G4LC32 1—255

G4LC32SX 1—200

G4LC32ISA 1—255
M4RTU 1—255

Choose an option from the Port drop-down list to select the communication
port type used to connect to the Mistic controller. This port is located in the
PC that's running MIMI. If you selected the Modify button from the Controllers
dialog, the port type automatically appears.

Table 4-6: Controller Port Types

Type Description
ARCnet Choose this option if you are using an ARCnet port
AC37/ACA2 Choose this option if you are using an Opto 22

AC37 RS-485 port, or an AC42, fiber optic port

WIN COM PORT

Choose this option if you are using a RS-232 port

ISA DIRECT

Choose this option if you are using an Opto 22
GA4LC32ISA controller

MDS

Choose this option if you are using the Mistic Data
Server to access data from the controllers

To configure the selected port, click the Setup button. A dialog box named

after the Port option you selected appears. The dialog boxes are described
in the following sections.
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ARCnet Port Dialog Box

Click Setup in the Controller Properties dialog box to display the ARCnet Port dialog box. Use this dialog box to
configure the ARCnet port used to connect the MMI computer to the Mistic controller. Click OK to save the

options you entered.

1/0 Address

RAM Address

Retries

Time OQut(sec.)

ARCNET Port

1/0 Address
RAM Address DO00OK

Tim Ou (s0)
Fe-enable (sec)

w 0K annceI ? Help

Figure 4-4: ARCnet Port Dialog Box

To specify an 1/0 address for the ARCnet port, choose an option from the
I/0 Address drop-down list. The address options are: 260h, 290h, 2E0h,
2F0h, 300h, 350h, 380h, and 3EOh. The address should match the address
setting of the ARCnet card.

To specify a RAM address for the ARCnet port, choose an option from the
RAM Address drop-down list. The options are: CO000h, C4000h, C8000h,
CC000h, D0000K, D4000K, D8000K, DCOOGh, and EO0OC. The RAM address
should match the RAM Address setting of the ARCnet card.

To specify the number of times MMI tries to communicate to a controller
after the initial attempt before the controller is considered down, enter a
value from 110 9. The default value is 1.

Enter a value from 0.2 to 600 to specify the time (in seconds) MMI waits for
a response from the controller between each communication attempt (set
by the Retries option). Failure by the controller to respond results in an error
message sent to the Event Log window. The default time-out value is 0.5
(seconds).
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Re-enable

To specify the time interval to wait before checking for a Mistic controller
response after it has failed to respond. This property frees up the computer’s
CPU for other tasks during this waiting period. The options available are 1,
3,10, and 30 seconds. The MMI default re-enable time is 3 seconds.

AC37/AC42 Port Dialog Box

Click Setup in the Controller Properties dialog box to display the AC37/AC42 Port dialog box. Use this dialog box
to enter settings for your AC37, RS-485 port or your AC42, fiber optic port. Click OK'to save the options you

entered.

COM #
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ACITIACAZ Port

Time Out (sec)

COM # 13|
170 Address
BAUD 115200 [4]

Retries D

Re-enable (sec.)

Com Mode Binary

“ Ok annceI ? Help

Figure 4-5: AC37/AC42 Port Dialog Box

To select a communication port, choose a port from the COM # drop-down
list. The options available are: COM1, COM2, COM3, COM4, COM5, COMS,
and Custom. The Custom port option allows you to enter an address in the
I/0 Address field. All other COM ports have dedicated |/0 addresses and
cannot be changed. The default COM # is COM3.

Choose Custom if your port's address is configured differently from standard
I/0 Address settings. Refer to the 1/0 Address option description for the
standard address settings.
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1/0 Address

BAUD

Retries

Time OQut(sec.)

Re-enable

This option displays the dedicated /0 address for the COM port selected in
the COM # option. Table 4-7 shows the assigned|/0 Address to each COM#.
If the Custom port was chosen, assign an address from the drop-down list.
The addresses available for the Custom option are 260h, 290h, 2ECh, 2FOh,
300h, and 350h. Make sure the address you choose is assigned to only one
communication port. The default I/0 address is 348h (the typical Opto 22
address setting for the default COM3 port).

Table 4-7: AC37/AC42 |/O Addresse

COM # I/O Address
COoM1 3F8h
CcCom2 2F8h
COM3 348h
com4 340h
COM5 248h
COM6 240h
Custom *

* See I/O Address discussion for
available addresses.

To specify a baud rate, choose an option from the BAUD drop-down list. The
options are: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 76800, 115200.
The default baud rate is 115200 baud.

To specify the number of times MM tries to communicate to a controller
after the initial attempt before the controller is considered down, enter a
value from 110 9. The default value is 1.

Enter a value from 0.2 to 600 to specify the time (in seconds) MMI waits for
a response from the controller between each communication attempt (set
by the Retries option). Failure by the controller to respond results in an error
message sent to the Event Log Viewer window. The default time-out value
is 0.5 (seconds).

To specify the time interval to wait before checking for a Mistic controller
response after it has failed to respond. This property frees up the computer’s
CPU for other tasks during this waiting period. The options available are 1,
3,10, and 30 seconds. The MMI default re-enable time is 3 seconds.
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Com Mode To select the communication mode used by the host computer to the
controller, choose the Binary or ASCII option from the Com Mode drop-down
list. The Com Mode chooses the type of information packets exchanged by
the host computer and controller. The default communication mode is hinary.

Use ASCII mode if there is a madem between the MDS computer and Mistic
controller. Make sure you configure the Mistic controller for ASCII mode as
well. (Consult your controllers user's guide for this setting.) Most modems
cannot understand the Opto 22 binary protocol.

ISA Direct Dialog box

Click Setup in the Controller Properties dialog box with the ISA DIRECT port option selected to display the ISA
DIRECT Port dialog box. Enter settings for your GALC32ISAs PC COM port connection. Click OK to save the
settings you entered.

= ISA DIRECT
COM #
170 Address
BAUD

Retries D
Time Out (sec)

Re-enable (sec.)

Com Mode Binary

“ Ok annceI ? Help

Figure 4-6: ISA Direct Dialog Box
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COM #

1/0 Address

BAUD

Retries

Time OQut(sec.)

Re-enable

Com Mode

To select a communication port, choose a port from the COM # drop-down
list. The options are: COM1, COM2, COM3, COM4, COMb, and COM6. The
default COM # is COM3.

This field displays the communication 1/0 address for the GALC32ISA
controller. Communication port 1/0 addresses may be viewed and configured
in the Ports program group from the Windows Control Panel. Make sure the
I/0 address matches the I/0 address setting on the G4LC32ISA. Also verify
the I/0 address is unique from any other address assigned to a card in the
computer.

This field is not displayed. This parameter does not apply to the G4LC32ISA.

To specify the number of times MM tries to communicate to a controller
after the initial attempt before the controller is considered down, enter a
value from 110 9. The default value is 1.

Enter a value from 0.2 to 600 to specify the time (in seconds) MM|I waits for
a response from the controller between each communication attempt (set
by the Retries option). Failure by the controller to respond results in an error
message sent to the Event Log Viewer. The default time-out value is 0.5
(seconds).

To specify the time interval to wait before checking for a Mistic controller
response after it has failed to respond. This property frees up the computer’s
CPU for other tasks during this waiting period. MMI options available are 1,
3,10, and 30 seconds. The MMI default re-enable time is 3 seconds.

To select the communication mode used by the host computer to the

controller, choose the Binary or ASCII option from the Com Mode drop-down
list. The Com Mode chooses the type of information packets exchanged by
the host computer and controller. The default communication mode is binary.

Binary mode is faster and is typically used. If you are configuring a G4LC32ISA
controller, choose the binary communication mode.
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WIN COM PORT Dialog Box

Click Setup in the Controller Properties dialog box with the WIN COM port option selected to display the WIN
COM Port dialog box. Use this dialog box to enter settings for your RS-232 port. Click OK'to save the settings

you entered.

COM #

1/0 Address

BAUD
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= WIN COM PORT

COM #

IO Address

BAUD 38400

Retries

Time Out (sec)
Re-enable (sec.)

Com Mode Binary

“ Ok annceI ? Help

Figure 4-7 : WIN COM PORT Dialog Box

To select a communication port, choose a port from the COM # drop-down
list. The options are: COM1, COM2, COM3, and COM4. The default COM #
is COM3.

This field is not displayed. Communication port /0 addresses may be viewed
and configured in the Ports program group from the Windows Control Panel.
Make sure the address you choose is assigned to only one communication
port.

To specify a baud rate, choose an option from the BAUD drop-down list. The
options are: 300, 600, 1200, 2400, 4800, 9600, 19200, 38400, 76800, 115200.
The default baud rate is 38400 baud.
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Retries

Time Out(sec.)

Re-enable

Com Mode

To specify the number of times MM tries to communicate to a controller
after the initial attempt before the controller is considered down, enter a
value from 1 to 9. The default value is 1.

Enter a value from 0.2 to 600 to specify the time (in seconds) MM|I waits for
a response from the controller between each communication attempt (set
by the Retries option). Failure by the controller to respond results in an error
message sent to the Event Log Viewer. The default time-out value is 0.5
(seconds).

To specify the time interval to wait before checking for a Mistic controller
response after it has failed to respond. This property frees up the computer’s
CPU for ather tasks during this waiting period. The options available are 1,
3,10, and 30 seconds. The MMI default re-enable time is 3 seconds.

To select the communication mode used by the host computer to the

controller, choose the Binary or ASCII option from the Com Mode drop-down
list. The Com Mode chooses the type of information packets exchanged by
the host computer and controller. The default communication mode is hinary.

Use ASCII mode if there is a modem between the MMI computer and Mistic
controller. Make sure you configure the Mistic controller for ASCII mode as
well. (Consult your controller's user’s guide for this setting.) Most modems
cannot understand the Opto 22 binary protocol.
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MDS Port Dialog Box

This dialog box explains the Mistic Data Server (MDS), communications port interface. It is displayed when
MDS is the Port option and the Setup button is selected from the Controller Properties dialog box.

= MDS Network Server

Server Node | | Browse. .. I
Backup Node | | Browse. .. I
Retries I:l

Time Out (sec.)

Re-enable (sec) m

V 0K xl:ancel ? Help

Figure 4-8: MDS Port Dialog Box

The description corresponds to the MDS computer’s network configuration. Typically the Mistic MMI computer
is connected to another computer running the MDS program. The computer running MDS has a physical
connection to the Mistic controller(s). This physical connection and configuration is handled by the MDS
Administrator program and is transparent to the Mistic MMI.
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Server Node

Backup Node

Retries

Time Out (sec.)

Re-enable (sec.)

This is the main MDS server's node name. Use the Browse button to quickly
locate and enter the node name. If the PC is not connected to a network
(Mistic MMI and MDS are running on the same computer), enter the PC’s
name.

This optional parameter is used to configure a backup MDS server. Use the
Browse button to quickly locate and enter the node name.

This is the number of times a message is retransmitted by the Runtime
before MDS is considered down and an error condition is declared. The
default value is one retry.

This is the period of time that the Runtime waits for a response from MDS
before an error condition is declared. The default value is 4 seconds.

This is the period of time the MMI Runtime waits after a communication
attempt has failed to the MDS before trying to re-establish communication.
The MMI Runtime uses the Re-enable time to try to setup and enable a
disconnected MDS server. The default value is 10 seconds.
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CHAPTER 5

SCANNING

OVERVIEW

WINDOWS

The Mistic MMI has an internal scanner that is responsible for acquiring data for tags from one or more
controllers. During configuration, tags are connected to graphic objects in the MMI. Understanding how the
scanner functions is important to optimizing your system’s performance.

This first part of this chapter discusses some important concepts about scanning and the MMI. The latter part
of this chapter presents the dialog box used to configure scan times.

The Mistic MMI supports three different window states: Open, Iconified, and Closed. The state of a window
determines how tags for that window will be scanned and whether or not the tags are updated to the display.
Any time a window is open, its associated tags are scanned.

Note: An open window is any window that's opened, not just the active (top most) window.

It is suggested that from the Configurator you configure as few windows open as necessary during Runtime.
This reduces the chance the scanner will overrun.

Iconified windows scan their data values but do not update the display. By iconifying a window, you reduce the
heavy Windows graphics overhead. Since the window does not update the display, that time can be used by
other open windows. Keep in mind that since an iconified window still scans its data, the communication
overhead is unchanged.

Closed windows do not scan values or update the display. A window should be closed if the information in the
window is no longer needed. This greatly reduces the communication and graphic burden on the system.
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REFRESH TIME GROUP

Each data value displayed by the MMI belongs to a Refresh Time Group, Group0 by default. The refresh time
configures how often a value is scanned. Up to seven groups (Group0—Group6) with different refresh times
can be configured in the the Mistic MMI. System performance has a direct relationship to refresh time. Avoid
using fast (less than 1/2 second) refresh times on a large number of points to minimize scanner overrun errors.

SCAN GROUP

FRESHNESS

There are four different types of Scan Groups: Window, Triggers, Trend, and Historic Log. All the tags displayed
ina window belong to that window’s scan group. A tag can optionally belong to a trend group and a historic log
group. The points that make up a window’s scan group are scanned based on the state of the window. If the
window is closed, then no point scanning in the window occurs.

When a point is connected to a trend or to the historic log, the point belongs to a Trend Scan Group or a Historic
Log Scan Group. The Trend and Historic Log Scan Groups can be configured to always be scanned regardless of
window state, or scanned only when specific occurrences happen. Trend scan groups have scan disabling
options based on its window state. If the window is maximized or minimized, scan disabling is not available.
The Historic Log scan group can be configured as a trigger-based scan group using the Start and Stop Trigger
options to activate and stop the scan. Keep in mind the number of points configured on trends and in historic
logs can dramatically impact system speed.

When an I/0 point is required by the scanner, the scanner must request the data from the controller. The
controller must then get the data from the 1/0 unit. This can be very time consuming since the controller must
communicate with the /0 unit and wait for the I/0 unit to respond. Since the controller program is likely to have
recently used an 1/0 point, this information can be used to lessen the communication burden. Every time an
I/0 point is accessed by the controller, the value and time it was read from the I/0 unit is stored in the controller's
memory. When a request is made from the MMI to get an /0 value, the time of the last read is checked. If the
last read is within the refresh time for that point, the controller's last value is used. No request for the point will
be sent to the I/0 unit. This greatly reduces I/0 communication overhead.
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DIALOG BOXES

The dialog box used to configure scan times and freshness values in the MMI Configurator is discussed in this
section.
Refresh Times Dialog Box

To configure refresh times for data I/0 groups, select the Configure—>Refresh Times menu option from the
MMI Configurator. The Refresh Time Group dialog box is displayed.

=-| Refresh Times
Name Scan Rate Freshness

Yalue Units Yalue Units
Gows ] [ ] e 3]
Gowr ] [ [ ] [econss [8]
owz ]| [ [ ] [seconss [3]
oows ][] [ ] [ T3]
ows ]| [1_] [peoonds [3] | [1__] [seconss 3]
|Gr|:|up 5 | |1 | |1 | |Secunds |£I
Gows ]| [1_] [econds [3] | [1_] [seconss 3]

‘ _| Enable Scanner Overrun Notification
V Ok x[:anc:el ? Help
Figure 5-1: Refresh Time Group Dialog Box
Name Specify a name for the refresh time you want to set up. The name is used in

the MMI request for a data item. The name can be up to 15 characters long.
Avoid using the “!" and “|" characters in the name. Spaces are also valid
characters but when referencing names with spaces, don't omit the spaces
or substitute the “_" character for spaces.

Scan Rate To specify how often the MMI scans the controllers for data, enter a value
from 0to 9999 in the Value field and a unit of time from the Units drop-down
list. The unit options are: milliseconds, seconds, minutes, hours, days, and
months. The scan rate must be greater than or equal to the value in the
Freshness field. The greater the value, the more time between 1/0 readings
and the fewer times the controller is scanned.
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Freshness

To specify how current (fresh) the data from the controller must be, enter a
value from 0t0 9999 in the Value field and a unit of time from the Units drop-
down list. The unit options are: milliseconds, seconds, minutes, hours, days,
and months. The freshness value must be less than or equal to the value in
the Scan Rate field.

If the data available from the controller is older than the time specified in
the freshness field, the controller scans the I/0 units for new data. The
higher the freshness valug, the less the controller’s throughput is affected.
The lower the freshness value, the more likely the I/0 units will need to be
scanned.

Enable Scanner Overrun Notification
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Check this box to post error messages in the Event Log during runtime. If this
box is unchecked, Scanner Overrun error messages will be ignored by MM
Runtime.
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DRAW WINDOWS

OVERVIEW

A draw window is any window that allows the addition of graphics. A draw window has static attributes of
position, size, and color. It also has a dynamic attribute of a draw window visual state.

DIALOG BOXES

The dialog boxes used to create, open, and close draw windows are discussed in this section. Use the Open or
Close windows dialog boxes to manipulate windows in the Configurator. Windows configured as closed or
open upon leaving the Configurator are assigned this state at Runtime.

Window Properties Dialog Box

This dialog box is displayed whenever the properties of a draw window must be specified or modified. Selecting
the Window—>New command displays the Window Properties dialog box.

=-‘ New Window

‘ Name: || |

X Position: width:
Y Position: Height:

_| Always In Memory (fastest access)

Behavior Control Background Color
“+ Child v| Caption

> Popup v| Border Color: l:l

v| Size Handles
v| Minimize Box
_ | Bystem Menu

oz

Figure 6-1: New Window Properties Dialog Box
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X &Y Position

Width & Height

Always in Memory

Behavior
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The unique name of a draw window within a project. The name may be up
to 20 characters long. Leading and trailing blanks are ignored and are stripped
off when the dialog box is closed.

The X and Y Pasition fields define the upper left corner of the draw window
with respect to the client area of the program. Position X=0 and Y=0 is the
upper, left-most corner of the draw window. The default positions are X=40
and Y=10.

These fields define the size of the draw window in pixels. The default width
and height is 200.

This option specifies this window’s information should be loaded and always
saved inthe MIMI computer’s memory during Runtime. Normally, only opened
oriconified windows are saved in memory. Use this option for a window you
know will be opened and closed often. This will save you time when this
window is opened.

There are tradeoffs when using this option. The more windows you have
with this option selected, the more computer memory is used and the more
time your initial MMI setup will take. Fewer windows with this option use
less computer memory, speeds up the initial MMI setup, but costs you time
when a window is opened.

Note, windows with trends are always saved in memory. If you are using
the Mistic MMI with the Mistic Data Server (MDS), all windows are always
saved in memory.

Selects the type of window being created. Child windows appear on top of
currently displayed windows. When a Child window is closed, any window(s)
hidden by it reappears. Child windows stay within the boundaries of the
main draw window when it is active or iconified. The Child window becomes
an active window when any portion of its window is clicked.

Popup windows can appear anywhere inside or outside the boundaries of
the main window. When a Popup window is iconified, its icon appears in

the lower left corner of your screen and is not bound by the boundaries of
the main draw window.
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Control This section defines the style of the draw window. Check the appropriate
box to apply that style element to the draw window. A draw window can
have these optional featuress: a Caption, a Border, Size Handles, a Minimize
Box, and a System Menu. Selection of some elements will automatically
select another, e.g., selecting Caption forces a Border selection as well.

Color Specifies the background color of the draw window. Selecting the color
button displays the Color dialog box. Choose a color from the palette and
click OK

Open Windows Dialog Box

To display the Open Windows dialog box, select the Configure = Open menu option. Use this dialog box to open
windows in the Configurator. All currently closed windows are listed and any number of them may be selected
for opening by simply clicking on their name and then OK' If a closed window has tags which must be scanned,
the scanning restarts when the window is opened. Windows configured as closed or open upon leaving the
Configurator are assigned this state at Runtime.

= Open Windows

Currently Closed Windows:
FLUSH

w 0K annceI ? Help

Figure 6-2: Open Windows Dialog Box
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Close Windows Dialog Box

To display the Close Windows dialog box, select the Configure—> Close menu option. Use this dialog box to
close windows in the Configurator. All currently open and iconified windows are listed and any number of them
may be selected for closing. If windows are closed in the MMI Runtime, any scanning of tag values associated
with the windows ceases until the window is opened again. Windows configured as closed or open upon
leaving the Configurator are assigned this state at Runtime.

Figure 6-3: Close Windows Dialog Box
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GRAPHICS

OVERVIEW

The purpose of the Mistic MMI is to display a graphic representation of a process or system and allow you to
interact with that representation. Use the MMI Configurator to create your project’s graphics.

The first part of this chapter reviews concepts about graphics, how to create, and how to manipulate them. The
latter part presents the dialogs used to define the behavior of graphics with dynamic attributes.

GRAPHIC MANIPULATION

Building Graphics

The Mistic MMI configurator provides several tools to draw graphics. The Tool menu and the Tool Bar provide
the basic building blocks to construct all graphics. These tools allow you to choose the type of graphic object
you need to build a given image. Each of the tools is classified as a primary graphic or an advanced graphic.
Primary graphics include lines, rectangles, circles, and bitmaps. An advanced graphic is a trend.

Selecting Graphics

One of the most important tools is the Select tool. Before any operation can be performed on a graphic or group
of graphics, it must be selected. Selecting a graphic tells the graphics editor which items will be affected by
the next command.

i i Select Tool
Select Menu ,_lll Style  Vic
tem + Select
Tool Menu Tool Bar

Figure 7-1: Selecting a Graphic in the MMI
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When a graphic or group of graphics is selected, two types of marks are used to identify the graphics in the
selection. Eight sizing handles are used to mark the minimum rectangular area that surrounds the selected
graphic or graphics. Each graphic that is included in the selection has a selection mark. It serves to identify it as
a member of the selection when more than one graphic is selected. The position of the graphics selection mark
varies depending on the type of graphic. For example, a rectangle has the mark in the upper left corner and an
ellipse has it at the top.

There are two ways to select a graphic using the select tool. The first is to place the pointer over the graphic and
click the left mouse button. A set of sizing handles appears outside the selected graphic and a selection mark
is added to the graphic. Additional graphics can be added to the selection by placing the pointer over another
graphic and holding the shiFr key down while clicking the left mouse button. This graphic will have a selection
mark added to it and the sizing handles will be repositioned if the newly added graphic was outside the
rectangular area marked by the sizing handles.

Selection Mark

I/I .
Object not-__ .]:lf.JOh]t:ct selected
selected I:l :

[ |

u u
L
Sizing Handles

—_—

Figure 7-2: Sizing Handles Around One Selected Graphic

The second way to select a graphic is to use the pointer to draw a box around the graphics. To do this, place the
pointer just outside the graphic to be selected and hold down the left mouse button. Next, while keeping the
mouse button down, stretch the box over the graphic. Release the mouse button when the box completely
surrounds the graphic or graphics to be selected. A set of sizing handles appears outside the selected graphics
and each selected graphic has a selection mark added to it. This method can select only those objects completely
surrounded by the box. More than one graphic may be selected at a time. Additional graphics can be added to
the selection by placing the pointer over another graphic and holding the sHiFT key down while clicking the left

mouse button.
[ ] [ ]
] D % Selection Mark

L] ]
Example Text txample Text
n [ .\
Objects not Objects .
selected selected Sizing Handles

Figure 7-3: Sizing Handles Around a Group of Selected Graphics
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Sometimes it is difficult to select a graphic because other objects are overlapping it. When this happens, hold
down the c1rL key while left clicking the mouse. This causes the selector to cycle through the objects under the
pointer.

De-selecting Graphics

Graphics can be de-selected by placing the pointer over an area of the draw window that is not covered by a
graphic and pressing the left mouse button. When the selection contains more than one graphic, individual
graphics can be de-selected by placing the pointer over the graphic and pressing the sHIFT key + left mouse
button.

Sizing Handles

Sizing handles appear around any graphic or group of graphics that are selected. The sizing handles are a visual
cue that one or more graphics is selected. To use most commands on the Edit menu, one or more graphics must
be selected. When nothing is selected, these Edit Menu items appear as disabled text. This indicates the
command is not available.

Sizing Handles can also be used to change the size of selected objects. To resize a graphic, place the pointer
over one of the eight handles and hold down the left mouse button. Stretch the graphic by moving the handle
away from the graphic, or shrink the graphic by moving the handle into the graphic. Release the left mouse
button to fix the graphic.

Moving Graphics

Moving a graphic is a very common operation. To move a graphic, or group of graphics, select the items to be
moved using one of the methods described in the Selecting Graphics sections. Place the pointer inside the area
defined by the sizing handles and hold down the left mouse button. Move the graphics to their new location
and release the mouse button. If you find it difficult to place a graphic exactly where you want it, select the
graphic and then use the keyboard arrow keys. Each time an arrow key is pressed, the graphic moves one pixel
in that direction.

Setting Attributes

Attributes control the appearance of most graphics. Line Color, Line Width, Line Style, Fill Color, and Fill Pattern
are examples of graphic attributes. Attributes for a graphic can be set before it is drawn. Use the Style menu to
select different attributes. Changing the settings on the Style Menu when no graphics are selected, sets the
default attributes. Any graphics subsequently drawn assume these attributes.

To change an attribute of a graphic or graphics that have already been drawn, select the graphics you want to
change and then use the Style Menu commands to specify the new attribute. When graphics are selected and
an attribute is changed on the Style Menu, only the selected graphics are affected. The default settings do not
change.
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Grouping Objects

Sometimes it is easier to handle several graphics as one entity. The Mistic MMI allows any number of graphic
objects to be part of a Group. When a set of graphics is grouped, they act as one graphic. They can be moved
and sized just like any other graphic. Examples of graphics that are typically grouped are PID face plates, bar
graphs, dial faces, and buttons.

Before Grouping After Grouping

Rectangle
AUTO
Circle Text
Three seperate One Object
objects

Figure 7-4: Grouping Objects

To Group a set of graphics, select all of the graphics with the select tool. Then select the Group command from
the Edit menu. The objects now act as one graphic.

If you need to edit a member of a grouped graphic, the Ungroup command on the Edit Menu breaks the graphic
into its individual pieces.

The Mistic MMl also allows grouped objects to be grouped.

Graphic Order

When you place objects in the drawing area, the graphic that is placed last appears in front of any previous
objects that it overlaps. The graphic is said to be in “front” of the others. To build complex objects, it may be
desirable to change the order in which a graphic appears. The Mistic MM allows the order of objects to be
changed. The Edit menu contains two commands, Bring to Front and Send to Back, which are used to reorder

objects.

Circle in front Circle in back
of rectangle of rectangle

Figure 7-5: Multiple Graphics and Their Order

To change the order of a graphic, select the graphic with the Select tool. Choose either the Bring To Front or
Send to Back command from the Edit Menu.
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Bitmaps

Bitmaps are pixel-based pictures that can be displayed on computers. There are many different file formats for
bitmaps, e.g. TIFF, PCX, GIF, etc. The Mistic MMI supports the native Windows bitmap format which has a file
extension of .BMP. Currently the MMI supports 16-color bitmaps. If you have bitmaps that have a format other
than .BMP, and you wish to use them with the MMI, there are several commercial and shareware programs
that are capable of converting a graphics file from one format to another.

You can save the contents of a draw window as a .BMP file by selecting the Save as Bitmap option on the File
menu. This can be useful for documentation purposes or if you have a picture that you wish to use as a hitmap
in other draw windows.

Another way of getting bitmaps in and out of the MMI is via the Windows clipboard. If you select one or more
graphic objects in a draw window, and then choose Cut or Copy from the Edit menu, the selected objects will be
placed on the clipboard so that other Windows programs can Copy or Paste them (as hitmaps) into their
workspace. Alternately, if you use a Windows program to cut or copy bitmaps to the Clipboard, you can select
the Edit->Paste menu option to paste a bitmap from the clipboard into a draw window.

DYNAMIC ATTRIBUTES

Dynamic objects in the Mistic MMI have what are called Dynamic Attributes. The Dynamic Attributes of a
graphic are edited by double-clicking on a selected graphic or by choosing the Edit—>Dynamic Attributes menu
option while a graphic is selected. There are two different types of Dynamic Attributes—Controller Driven
Attributes (CDA) and Operator Driven Attributes (ODA). At least one controller must be configured before
dynamic attributes can be attached.

CDA

Controller Driven Attributes are those attributes of a dynamic object that cause a change in the value or state
of a Cyrano tag or another MIMI dynamic object. Examples of CDAs are Line Color, Fill Color, Text Color, Visibility,
Horizontal Size, Vertical Size, Horizontal Position, Vertical Position and Rotate. An MMI dynamic object with a
CDA is therefore affected by data coming into the object from an external source (e.g. a tag from a Cyrano
strategy running on a Mistic processor).

ODA

Operator Driven Attributes are those attributes of a dynamic object that cause a change in the value or state of
a Cyrano tag or another MM dynamic object. Examples of ODAs are Horizontal Slider, Vertical Slider, Left
Button—Send Data and Left Button—Windows. These dynamic attributes cause an object to send data to, or
affect the state of a Cyrano tag or anather MMI dynamic object. ODA changes take effect immediately because
they are not a part of any scan group.
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DIALOG BOXES

The dialog boxes used to configure dynamic attributes for graphics are discussed in this section. The Dynamic
Attributes dialog box displays all possible dynamic attributes that can be configured. Each dynamic attribute
that is edited from this dialog box has a corresponding dialog box to enter configuration changes. Each of these
dialog boxes requires a tag to be identified for the dynamic attribute. The Tag Dialog box is used to select this
tag.

Dynamic Attributes Dialog Box

The Dynamic Attributes dialog box appears when the Edit— Dynamic Attributes menu option is chosen while a
graphic is selected. The dialog box is divided into three sections. The Object information secyion are read-only
fields which display position and size of the selected graphic. The Controller Driven Attributes list shows all
controller driven attributes, and the Operator Driven Attributes list shows all operator driven attributes that can
be applied to the selected graphic. They both allow you to select an attribute and edit its parameters.

=-| Graphic Dynamic Attributes
‘ Object: Group x 81 Y: 146 Width: 68 Height: 24
Controller Driven Attributes Operator Driven Attributes
[J Line Color [ Horizontal Slider +
[ Fill Color [ wertical Slider L
[J Text Color [J Touch - Send Value
] ¥isibility/Blink [J Touch - Send Discrete
[ Horizontal Size (width) - [J Touch - Send String -
[ Vertical Size (height) Clisay [ Touch - Windows Claat
[ Horizontal Position [ Touch - Download Recipe +
[ wertical Position
v| Focus-frame Enabled
v| Beep Enabled
V oK xﬁancel ? Help

Figure 7-6: Dynamic Attributes Dialog Box

Controller Driven Attributes List (Dynamic Attributes Dialog Box)

This section lists all controller driven attributes that can be applied to the selected graphic. Each entry is
preceded by a checkbox which indicates if the dynamic attribute is selected. An empty square indicates a
dynamic attribute of that type is not associated with the selected graphic. A checked square indicates a dynamic
attribute of that type is associated with the selected graphic. A circle with a slash through it indicates a
dynamic attribute of that type cannot be associated with the selected graphic because it conflicts with another
dynamic attribute previously selected for that graphic.

Selecting an entry and then pressing the Edit button, or double-clicking on an entry, displays the dialog box to
configure the selected dynamic attribute.
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Edit Button

Clear Button

Displays the dialog box to configure the dynamic attribute selected in the
Controller Driven Attributes List box.

Clears the dynamic attribute selected in the Controller Driven Attributes List
box.

Operator Driven Attributes List (Dynamic Attributes Dialog Box)

This section lists all operator driven attributes that can be applied to the selected graphic. Each entry is preceded
by a checkbox which indicates if the dynamic attribute is selected. An empty square indicates a dynamic
attribute of that type is not associated with the selected graphic. A checked square indicates a dynamic attribute
of that type is associated with the selected graphic. A circle with a slash through it indicates a dynamic attribute
of that type cannot be associated with the selected graphic because it conflicts with another dynamic attribute
previously selected for that graphic.

Selecting an entry and then pressing the Edit button, or double-clicking on an entry, displays the dialog box to
configure the selected dynamic attribute.

Edit Button

Clear Button

Focus-Frame Enable

Beep Enable

Displays the dialog box to configure the dynamic attribute selected in the
Operator Driven Attributes List.

Clears the dynamic attribute selected in the Operator Driven Attributes List
box.

The Focus-Frame is a thick rectangle which is drawn around a graphic at
Runtime when the mouse is over the graphic and the graphic has Operator
Driven Attributes configured. Check this box to enable display of the focus-
frame.

Check this box if you want a beep to occur at Runtime whenever the mouse
is clicked on this graphic and it has an Operator Driven Attribute configured.
If the beep is enabled, it will only occur for Operator Driven Attributes which
do not prompt for user interaction.
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Tag Selection Dialog Box

The Tag dialog box is displayed when the Name field's ? button is clicked from one of the dynamic attribute
dialog boxes that's being edited. The dialog box lets you select the Cyrano tag you want to work with. The
dialog box is divided into 5 sections: Controller, ltem Type, ltem Name List, Selected Fields, and Refresh Time
(only for controller driven attributes and triggers).

Figure 7-7: Tag Dialog Box

Controller

Select the Mistic controller which contains the tag you wish to use. If only one controller is available, it is
automatically selected. Selection of a controller updates the ltemName list box so that it displays a list of the
selectable Cyrano data types available in that controller’s Cyrano strategy.

Item Type

Select the type of data you wish to use. The list contains only those types defined in the selected controller’s
Cyrano strategy. Selection of a specific item type updates the [tem Name list box . It then displays a list of all the
tags of that selection type. The Item Type selection also determines the Selected Field options available.

Item Name

This is an alphabetized list of the available Cyrano tags of the type specified in the ItemType list. You can select
the tag of interest from this list.
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Selected Fields

The base type of the selected item determines which of these fields, if any, need to have contents specified. If
an entry is not needed, then the cursor for the dialog box is prevented from entering that dialog box control.

Field

Bit

Element

Start Index & Num Elements

Refresh Time

Specifies what data associated with the tag is of interest. For example, if
the tag selected is of Item Type PID, then the available fields are Error, Enable,
A/M, Input, Output, Setpoint etc. If the tag Item Type is Digital Multifunction
Input Point, the available field is State. If the tag [tem Type is FLOAT, the
Field list box is disabled.

If the base type is Integer, a particular bit may be selected from the integer.

If the selected ItemType is one of the Table types and only a single element
of the table is desired, then this field can be used to select the index of the
single element of interest.

To select multiple elements from Item Type Table, use the Start Index to
specify the first element and Num Elements to specify how many.

Allows you to select the refresh time group to be used for scanning. All tags
with the same refresh time group are scanned at the same time. A group
with a refresh time of 0 seconds is scanned as fast as possible. Use the drop
down button to select from the list of refresh time groups. The refresh time
parameter is displayed if a controller driven attribute is being edited.
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Dynamic Attribute Color Dialog Box

This dialog box is displayed when Line Color, Fill Color, or Text Color is highlighted and the Edit button is
selected from the Dynamic Attributes dialog box. It allows you to specify which colors you want associated to
the dynamic attributes of the graphic you are editing.

|

Dynamic Attribute - Line Color

Tag

Name: |

Type: |Cyrano 200

Setup by

-

 Discrete
“ Current Value

==

Setup by Current Yalue

Cutoff values

Deadband:
L]

Figure 7-8: Dynamic Attribute Color Dialog Box

Select the Cyrano tag that's used to affect the graphical response of the tag section for this dialog box. As the
value of the selected tag's data changes during execution of the Cyrano strategy, the graphic’s color changes
according to the options entered in this dialog box.

Setup by

Setup by Discrete
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Select one of the options to display the appropriate program group.

Selecting Discrete enables the Setup by Discrete control group. This option
is normally selected when the tag is a digital input point.

Selecting Current Value enables the Setup by Current Value control group.

When enabled, this control group determines the color used for Tag values
of OFF (Tag value of zero) and ON (Tag value not equal to zero). Select the
Color button located below the tag value (ON or OFF) to select the desired
color.

NOTE:  Avoid use of dithered colors.
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Setup by Current Value When enabled, this control group determines the color by comparing tag
values against a graphical response scale delineated by cutoff values. The
cutoff values are entered in the four edit boxes. These cutoff values separate
the graphical response scale into five areas. All areas have a color button to
select the desired color.

NOTE:  Avoid use of dithered colors.

Deadband This field is used to specify the deadband value. This value is used in
determining whether the graphic should be redrawn as changing data is
received from the Mistic processor. In order for the graphic to be redrawn,
the reading from the processor must differ from the reading that caused the
current graphic state by at least the value specified in the deadband field.
Otherwise, the graphic is not redrawn.
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Dynamic Attribute Position Dialog Box

This dialog box is displayed when the Horizontal or Vertical Position CDA , or the Horizontal or Vertical Slider
ODA is highlighted, and the Edit button is selected from the Dynamic Attributes dialog box. It allows you to
specify the position parameters associated with the graphic whose dynamic attributes are being edited. The
term “exceeds” used in the dialog box option descriptions is used to indicate a value that may be either greater
than or less than the Left/Up or Right/Down value.

=-| Dynamic Attribute - Horizontal Position

Tag

Name: |

Type: (Cyrano 200

Yalue At Left: I:I Movement Left:
Yalue At Right: I:I Mowvement Right:

Reference

[ ]
[ ]

> Left “ Center > Right

“ oK xﬁancel ? Help

Figure 7-9: Dynamic Attribute Position Dialog Box

Name Select a Cyrano type tag from the tag section of this dialog box to use as the
source of the position data. As the value of the selected tag’s data changes
during execution of the Cyrano strategy, the graphic’s position changes
according to the position parameters entered in this dialog box.

Value at Left/Up Specify the value for the leftmost or topmost position for the tag value from
the controller. The Value at Left/Up may be either less than or greater than
the Value at Right/Down.The tag position moves in either direction as the
data from the tag increases or decreases. If the tag exceeds this value, the
graphic is positioned to the leftmost or topmost position as specified by the
Movement Left/Up value.

Movement Left/Up This field defines the maximum number of pixels for movement to the left or
in the up direction relative to the default graphic position. The entered value
must be a non-negative number. Movement is achieved when the tag returns
data that is equal to or exceeds the Value at Left/Up, as explained above.
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Value at Right/Bottom

Movement Right/Down

Reference

Deadband

Specify the value for the rightmost or bottommaost position for the tag value
from the controller. The Value at Right/Bottom may be either less than or
greater than the Value at Left/Up.The tag position moves in either direction
as the data from the tag increases or decreases. If the tag exceeds this
value, the graphic is positioned to the rightmost or bottommost position as
specified by the Movement Right/Down value.

This field defines the maximum number of pixels for movement in the right
or down direction, relative to the default graphic position. The entered value
must be a non-negative number. This movement is achieved when the tag
returns data that is equal to or exceeds the Value at Right/Down as explained
above.

Defines the graphic reference point to which graphic movement is applied.
This setting is only critical when the graphic’s dynamic attributes of size and
position are simultaneously modified during runtime. Change in a graphic’s
size may alter the pixel locations of the graphic’s reference points in a different
manner. Therefore, it is necessary to specify this reference point within the
graphic. Changes in a reference point’s pixel location, due to re-sizing, are
used in conjunction with pixel movement calculation defined within this
dialog to determine a final graphic position.

For example, a graphic’s left most point may be used as the reference to
which the movement is applied. The scanned tag value may require a graphic
position change of 10 pixels to the right and a graphic size change moving
the left reference point to the left by 5 pixels. The net change in the graphic’s
position is then 5 pixels to the right.

This field is used to specify the deadband value to be used in determining
whether the graphic should be redrawn (for position update) as changing
data is received from the Mistic processor. In order for the graphic to be
moved to a new position and redrawn, the reading received from the
processor must differ from the reading which caused the current position of
the graphic by at least the value specified in the deadband field.
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Dynamic Attribute Text Input Dialog Box

This dialog box is displayed when a text item is selected in the draw window, the Edit=>Edit Dynamic Attributes
menu option is selected, the “Text In (from controller)” dynamic attribute is highlighted, and the Edit button is
selected from the Dynamic Attributes dialog box. It allows you to specify the data source you want to associate
with the text string whose Dynamic Attributes are being edited.

|

Dynamic Attribute - Text In (from Controller)

Tag
Yalue Text Justification Setup b
Deadband: ICI * Left » Center > Right “ Value
 Discrete
 String
On: | Off: |
“ Ok xﬁancel ? Help
Figure 7-10: Dynamic Attribute Text Input Dialog Box
Name Select the tag name associated with this text string. Use the Name field's ?
button to quickly locate the tag name. As the value of the selected tag’s
data changes during the execution of the Cyrano strategy, the text is updated
to display the value of the data.
Type This type is always Cyrano 200 source type.
Setup by Select one of the options to display the appropriate program group. The

Text Justification
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choices are Value, Discrete, and String.

This radio button group specifies how the displayed text is aligned with
respect to the pound signs (###) used as place holders in the text string
which has this dynamic attribute. If Left is selected, the left edge of the
dynamic text appears where the left most pound sign is. If Right is selected,
the dynamic text is positioned such that it ends where the right most pound
sign ends. If Center is selected, the center of the dynamic text is positioned
at the center of the horizontal space occupied by the pound signs.
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Deadband If you specified Setup by Value, this field is used to specify the Deadband
value to be used in determining whether the text value should be updated
as changing data is received from the Mistic processor. In order for the text
value to be updated, the reading received from the processor must differ
from the reading which caused the current text value by at least the value
specified in the deadband field. Otherwise, the text value is not updated.

On/Off If you specified Setup by Discrete, fill in these fields with the strings you
want displayed if the Tag's value is ON and OFF, respectively.

Dynamic Attribute Width/Height Dialog Box

This dialog box is displayed when “Horizontal Size (width)” or “Vertical Size (height)” is highlighted and the Edit
button is selected from the Dynamic Attributes dialog box. The Dynamic Attributes dialog box is available after
agraphic has been selected and the Edit—> Edit Dynamic Attributes menu option has been selected. This dialog
box allows you to specify which sizing parameters you want to associate with the graphic whose dynamic
attributes are being edited.

=] Dynamic Attribute - Width

Tag

Name: |

Type: |Cyrano 200

Maximum Yalue: I:I Max Percent Width: I:I
Minimum Yalue: I:I Min Percent Width: I:I

Anchor

> Left + Center > Right Deadband: I:I

V oK xcancel ? Help

Figure 7-11: Dynamic Attribute Width/Height Dialog Box

Size changes are described in percentage terms of the graphic’s full size, which is the size of the graphic
produced with the MMI Configurator. Full size is 100 percent, invisible is 0 percent.

(The text in this dialog box may vary according to whether it is being used to specify width or height. In the text
that follows, word pairs are used to describe the use of the dialog box, e.g. left/bottom, width/height, etc. Use
the word from the pair that is appropriate for the function being configured.)
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Anchor

Deadband
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Select which Cyrano 200 Tag to use as the source of the sizing data from the
Tag section of this dialog box As the value of the selected tag’s data changes
during execution of the Cyrano strategy, the graphic’s size changes in
accordance with the parameters that you enter in the dialog box.

Specify the highest tag value the data from the controller can be. This tag
value will produce the Max Percent Width/Height size. If the tag is equal to
or exceeds this value, the graphic is sized to the Max Percent size.

Specify the maximum percent width/height size that the graphic may achieve.
The entered value must be between 0 and 1000. This percentage of full size
is achieved when the tag returns data that is equal to or exceeds the
Maximum Value.

Specify the lowest tag value the data from the controller can be. This tag
value will produce the Min Percent Width/Height size. If the tag is equal to
or less than this value, the graphic is sized to the Min Percent size.

This field is used to specify the minimum percent width/height size that the
graphic may achieve. The entered value must be between 0 and 1000. This
percentage of full size is achieved when the tag returns data that is equal to
or less than the Minimum Value, as explained above.

The anchor point of the graphic is that which remains fixed while all other
points change as the size changes. Left/Bottom fixes the graphic’s left/bottom
edge, i.e., the graphic’s right/top edge moves as it resizes. Right/Top fixes
the graphic’s right/top edge and the left/bottom moves as it resizes. Center
means that both left/bottom and right/top edges move as the graphic resizes
while the position of the center remains fixed.

This field is used to specify the deadband value to use in determining whether
the graphic should be redrawn (for resizing update) as changing data is
received from the Mistic processor. In order for the graphic to be resized and
redrawn, the reading received from the processor must differ from the reading
which caused the current size of the graphic by at least the value specified
in the deadband field. Otherwise, the graphic is not resized.
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Dynamic Attribute Visible/Blink Dialog Box

This dialog box is displayed when Visibility is highlighted and the Edit button is selected from the Dynamic
Attributes dialog box. The Dynamic Attributes dialog box is available after choosing a graphic and selecting the
Edit->Edit Dynamic Attributes menu option. The Visible/Blink dialog box allows you to specify the blink rate or
visibility associated with the graphic whose dynamic attributes are being edited.

OPFTO DEMO BOX:LED_#8.5tate Cyrano 200 |—

Con |
—
misile[4]

Figure 7-12: Dynamic Attribute Visibility/Blink Dialog Box

Tag Select which Cyrano 200 Tag to use as the source of the sizing data from the
Tag section of this dialog box. As the value of the selected tag's data changes
during execution of the Cyrano strategy, the graphic will be visible, invisible
or blinking, according to the blink rate or visibility options you entered in the
dialog box.

Setup by This radio button allows the selection of one and only one of the available
options. The options are Discrete and Current Value.

Selecting Discrete enables the Setup by Discrete control group. This option
is normally selected when the tag is a digital input point.

Selecting Current Value enables the Setup by Current Value control group.
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Setup by Discrete

Setup by Current Value

Deadband
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When enabled, this controls group determines the graphical response for
Tag values of OFF (tag value of zero) and ON (tag value not equal to zero).
Use the drop down list box located below the Tag value (ON or OFF) to select
the graphical response. The graphical responses are:

Invisible Removes the graphic from the display screen.
Visible Draws the graphic on the display screen.
Slow Blink Alternates between drawing and removing the graphic

at approximately 0.5 hertz rate.

Medium Blink  Alternates between drawing and removing the graphic
at approximately a 1 hertz rate.

Fast Blink Alternates between drawing and removing the graphic
at approximately a 2 hertz rate.

When enabled, this controls group determines the graphical response by
comparing tag values against a graphical response scale delineated by cutoff
values. The cutoff values are entered in the four edit boxes. These cutoff
values separate the graphical response scale into five areas. All areas have
adrop down list box to select the graphical response. The graphical responses
are:

Invisible Removes the graphic from the display screen.
Visible Draws the graphic on the display screen.
Slow Blink Alternates between drawing and removing the graphic

at approximately 0.5 hertz rate.

Medium Blink  Alternates between drawing and removing the graphic
at approximately a 1 hertz rate.

Fast Blink Alternates between drawing and removing the graphic
at approximately a 2 hertz rate.

This field is used to specify the deadband value to be used in determining
whether the graphic should be redrawn as changing data is received from
the Mistic processor. In order for the graphic to be redrawn, the reading
received from the processor must differ from the reading which caused the
current graphic state by at least the value specified in the deadband field.
Otherwise, the graphic is not redrawn.
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Dynamic Attribute Rotate Dialog Box

This dialog box is displayed when Rotate is highlighted and the Edit button is selected from the Dynamic
Attributes dialog box. It allows you to specify the rotation parameters associated with the graphic whose
dynamic attributes are being edited.

|

Dynamic Attribute - Rotate

Tag

Name: |

Type: |Cyrano 200

Yalue at Max CCW:

Yalue at Max CW:

Rotation Anchor Point (Offset from Object Centerpoint)

’ Ok xCancel ? Help

Tag

Value at Max CCW

Max CCW Rotation

Value at Max CW

Figure 7-13: Dynamic Attribute Rotate Dialog Box

Select which Cyrano 200 Tag to use as the source of the rotate data from
the Tag section of this dialog box. As the value of the selected tag's data
changes during execution of the Cyrano strategy, the graphic rotates in
accordance with the rotation parameters entered in the dialog box.

Enter the tag value that represents the value at the maximum
counterclockwise rotation. If a tag is read which exceeds this value, the
graphic rotates counterclockwise as far as possible, as specified by the
Max CCW Rotation. The Value at Max CCW may be either less than or
greater than the Value at Max CW. This allows the graphic to rotate in
either direction, according to the value of the tag.

This field is used to specify the maximum counterclockwise rotation angle
that the graphic may rotate in degrees from its configured location. The
entered value must be a non-negative number. This rotation angle is achieved
when the tag returns data that is equal to or exceeds the Value at Max
CCW, as explained above.

Enter the tag value that represents the value at the maximum clockwise
rotation. If a tag is read which exceeds this value, the graphic rotates,
clockwise as far as possible, as specified by the Max CW Rotation. The
Value at Max CW may be either less than or greater than the Value at Max
CCW. This allows the graphic to rotate in either direction, according to the
value of the tag.
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Max CW Rotation

This field is used to specify the maximum clockwise rotation angle that the
graphic may rotate in degrees, from its configured location. The entered
value must be a non-negative number. This rotation angle is achieved when
the tag returns data that is equal to or exceeds the Value at Max CW, as
explained above.

Rotation Anchor Point (Offset from Object Centerpoint)

Deadband
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The rotation anchor point is used to specify the fixed location that the graphic
rotates. This location is specified in terms of an offset (in units of pixels)
from the centerpoint of the graphic at its configured location. In the field,
enter a negative value to specify a position that is to the left of the configured
location or a positive value to specify a position that is to the right of the
configured location. In the Vertical field, enter a negative value to specify a
position that is above the configured location or a positive value to specify a
position that is below the configured location. If a value of zero is specified
for both fields, then the graphic will rotate about its centerpoint.

This field is used to specify the deadband value to use in determining whether
the graphic should be redrawn (for rotation update) as changing data is
received from the Mistic processor. In order for the graphic to be rotated to
a new position and redrawn, the reading received from the processor must
differ from the reading which caused the current rotation of the graphic by
at least the value specified in the deadband field. Otherwise, the graphic is
not rotated from its current position.



GRAPHICS

Dynamic Attribute Send Value Dialog Box

This dialog box is displayed when the Touch—Send Value is selected from the Dynamic Attributes dialog box
and the Edit button is selected. It allows you to specify what output value you want to associate with the
graphic whose dynamic attributes are being edited. The Dynamic Attributes dialog box is displayed by selecting
the Edit—=>Edit Dynamic Attributes menu option.

An output value is sent to the Cyrano tag you select from the Tag section of this dialog box. The value is sent
when the left mouse button is pressed while the cursor is positioned over the associated graphic.

=-| Dynamic Attribute - Send Value

Tag

Type: [Cyrano 200 il

Name: |

Fixed Data:

Source:

Prompted Data:

* Fixed Data  Prompt For Data

Destination:

“ Set  Offset

oz

Figure 7-14: Dynamic Attribute Send Value Dialog Box

A numeric keypad is displayed during the MMI Runtime and prompts the user to enter a value if the Send Value
is configured with “Prompt For Data” as the source. For computer systems with touch-screens and no attached
keyboard, select the “Use On-Screen Keyboard for Touch Screens” from the Configure=>Run Time command.
This option sizes the keypad to be as large as possible for the video resolution of the Runtime computer monitor.

Name Choose a Cyrano tag name to receive the value sent. Make sure the tag
name type matches the type of data it will receive. Use the ? to quickly
locate the Cyrano tagname.

Type The Cyrano 200 type is the only available choice at this time.

Source The Fixed Data and Prompt For Data buttons determine the source of the
value sent to the Name at Runtime if the graphic is selected.

If the Fixed Data button is selected, the value specified at configuration
time is sent to the tag. If the Prompt For Data button is selected, a dialog box
will appear to allow you to enter a value to send to the tag.

Value Out This field contains the value which will be sent to the tag if Fixed Data is
selected.
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Destination The Set and Offset buttons specify whether the value is to be used to directly
set the tag’s value or the value is to be added to the tag’s current value.

Prompted Data The contents of the User Message field will be displayed in a dialog box
that will prompt for a value at Runtime. If the field is left blank, no message
is displayed.

The Min Value and Max Value fields must contain the minimum and maximum
values allowed for data entered in at Runtime.

Dynamic Attribute Send Discrete Dialog Box

This dialog box is displayed when Touch—Send Discrete is highlighted and the Edit button is selected from the
Dynamic Attributes dialog box. It allows you to specify discrete output that is to be associated with the graphic
whose dynamic attributes are being edited. The Dynamic Attributes dialog box is displayed when the Edit—>Edit
Dynamic Attributes menu option is selected and a graphic item is selected.

The discrete output will be sent to the Cyrano tag that you select from the tag section of this dialog box. The
value is sent when you press the left mouse button while positioning the cursor over the associated graphic.

Cyrano 200

Figure 7-15: Dynamic Attribute Send Discrete Dialog Box
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Type

Source

Fixed Data

Prompted Data

Choose a Cyrano tag name to receive the discrete value sent. Make sure the
tag name type matches the type of data it will receive.

The Cyrano 200 type is the only available choice at this time.

The Fixed Data and Prompt For Data buttons determine the source of the
discrete state sent to the tag at runtime if the graphic is selected.

If the Fixed Data button is selected, the output state specified at configure
time is sent to the tag. If the Prompt for Data button is selected, a dialog box
appears which has two buttons; one for setting the state of the tag and one
for clearing the state of the tag.

This group of five buttons is used to specify the output state sent to the tag
if the source is fixed data.

Set: The Name tag is set TRUE when the graphic is
selected.

Clear The Name tag is set FALSE when the graphic is
selected.

Toggle The Name tag changes to TRUE if it is currently FALSE
or FALSE if it is currently TRUE.

Direct The named tag is set to TRUE while the left mouse
button is held down and reset to FALSE when the
button is released.

Reverse The named tag is set to FALSE while the left mouse
button is held down and set to TRUE when the button is
released.

The contents of the User Message field is displayed in the dialog
box that prompts for a discrete state at Runtime. If the field is left
blank, no message is displayed.

The dialog box that appears at Runtime has two buttons. One button causes
the named tag to be set TRUE and the other causes the named tag to be set
FALSE. The default text on the buttons is SET and CLEAR, respectively. The
text that appears on the buttons can be customized by entering strings in
the Set Button Text and the Clear Button Text fields. If either field is left
empty, its respective button will display its default text.
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Dynamic Attribute Send String Dialog Box

This dialog box is displayed when Touch—Send String is selected from the Dynamic Attributes dialog box and
the Edit button is selected. It allows you to specify which output string you want to associate with the graphic
whose dynamic attributes are being edited. The Dynamic Attributes dialog box is displayed by selecting the
Edit—>Edit Dynamic Attributes menu option.

oz [3)

Figure 7-16: Dynamic Attribute Send String Dialog Box

The output string will be sent to the Cyrano tag you select from the tag section of this dialog box. The value is
sent when the left mouse button is pressed while the cursor is positioned over the associated graphic.

A full keyboard is displayed during the MMI Runtime and prompts the user to enter a string if the Send String
is configured with “Prompt For Data” as the source. For computer systems with touch-screens and no attached
keyboard, select the “Use On-Screen Keyboard for Touch Screens” from the Configure Y Run Time command.
This option sizes the keyboard to be as large as possible for the video resolution of the Runtime computer
monitor.

Source The Fixed Data and Prompt For Data buttons determine the source of the
string sent to the tag at runtime if the graphic is selected.

If the Fixed Data button is selected, the string specified at configure time is
sent to the tag. If the Prompt For Data button is selected, a dialog box appears
which allows you to enter the string to be sent to the tag.
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Fixed Data The String Out field specifies the string to be sent to the
tag if Fixed Data is selected as the source.

Prompted Data  The contents of the User Message field will be displayed
in the dialog box that prompts for a string at runtime. If
the field is left blank, no message will be displayed. If
the Hide Characters check box is checked, the runtime
dialog box that prompts for the string will not display
the characters as they are typed. Instead, an asterisk
will be displayed for each character. This feature is useful
for entering passwords.

Pop Window Dialog Box

This dialog box is displayed when Touch—Window is selected from the Dynamic Attributes dialog box and the
Edit button is selected. The Dynamic Attributes dialog box is displayed by selecting the Edit—> Edit Dynamic
Attributes menu option.

This dialog box allows you to specify a visual state (e.g., open, iconic, closed) for a project’s draw windows after
an event has occurred. This dialog box accomplishes this by listing the project’s draw windows and providing a
means of describing the visual states after the event. The following description of this dialog box refers to a
generic event. The particular event being configured is determined by the menu selection or dialog box selection
that caused this dialog box to appear.

To specify the new visual state, first use the Windows list box to select the draw windows that will be affected
by the event. They are then removed from the Windows list box and added to the Affected Windows list and
the desired action is specified for each. Finally, actions can be specified for all draw windows that have not
been added to the Affected Windows list. The sections below detail how to perform these actions.
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Figure 7-17: Pop Window Dialog Box

Windows List

The Windows list is a multiple selection list box used to select the draw windows to be affected by the event.
Selections from this list box can be added to the Affected Windows list box using the Insert or Append buttons.
The new visual state of the selected draw windows is initially specified by the Default radio button group. The
specification of the new state can be changed after the entry is in the Affected Windows list. See that section
for details.

The order of the draw windows in the Affected Windows list is important when any of the draw windows to be
opened overlap other draw windows to be opened. If such an overlap exists, those that are nearer the top of the
list will obscure those lower in the list. Proper draw window ordering can be obtained using the Insert and
Append buttons.

The Append button adds the selected draw windows at the bottom of the Affected Windows list. The Insert
button can be used whenever there are entries in the Affected Windows list and there is one, and only one,
entry in that list selected. In this case, all selected draw windows in the Windows list are inserted before the
entry selected in the Affected Windows list.

Each time entries are added to the Affected Windows list, they are removed from the Windows list and are left
in the selected state in the Affected Windows list and any that were previously selected are deselected.
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Affected Windows List

The Affected Windows list is a multiple selection list box. Each entry has two parts: the name of the draw
window and the action to be performed when the event takes place. Entries are added to the list by the
methods described in the Window List section.

Open, Close, and Iconify These buttons redefine the action for all entries selected.

Remove Selected This button removes the selected entries from the list and returns them to
the Windows list.

Remove All This button removes all entries from the list and returns them to the Windows
list.
Deselect All This button deselects all entries in the list, i.e., the entries remain in the list

but they are set to the deselected state.

Unselected Windows Action

It may be desirable to specify new visual states when the event occurs for all draw windows not included in the
Affected Windows list. The section All Others provides radio buttons for this purpose. A group of buttons exists
for each of the three possible visual states of a draw window. The radio button selected in each group determines
the new visual state for all the draw windows currently in that group’s state when the event occurs. For example,
if the Close radio button is selected in the If Open grouping, then all open draw windows not listed in the
Affected Windows list will be closed when the event occurs.

The No Change radio button means that there should be no change for draw windows referred to by that
grouping. This button is the default for each group.

Dynamic Attribute Upload Recipe Dialog Box

This dialog box is displayed when Touch—Upload Recipe is selected from the Dynamic Attributes dialog box
and the Edit button is selected. The Dynamic Attributes dialog box is displayed by selecting the Edit—>Edit
Dynamic Attributes menu option. Use this dialog box to configure a Touch—Upload Recipe dynamic attribute
or a trigger-based recipe upload.

The upload recipe function requires two Recipe File names to enable execution at Runtime. The Format File is
the file that contains the recipe description. The Destination File is the file that contains the uploaded recipe. If
you want to upload the recipe to the Format File, its name must be provided in bath sections.
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=-| Dynamic Attribute - Upload Recipe

Format File:

Directory | Browse... I
# Fixed Name _
File Name: Extension: |rcp
> Prompt For Name
 From Mistic String
Destination File:
Directory | Browse... I
“ Fixed Name _ _
File Name: Extension: (rcp

> Prompt For Name
 From Mistic String

/ oK xﬁancel ? Help

Figure 7-18: Dynamic Attribute Upload Recipe Dialog Box

The following descriptions apply to both the Format File and the Destination File.

Name Enter a name to refer to this recipe manager. This name is used to refer to
this trigger-based recipe in the Recipe Managers list dialog box. The name
can be up to 40 characters long.

Directory Use the Browse button to select the directory where the template file
resides. At Runtime, only files from this directory are accessed.

Fixed Name Check this if the template file is a file name you want to configure at this
time. If this option is selected, the File Name edit box appears, prompting
you for a file name. Make sure the file exists in the Directory entry, otherwise
an error is posted. The file name may not be changed at Runtime.

The Extension parameter also appears and prompts for a one to three
character long extension that's appended to the Fixed Name. The extension
must not contain a period or a DOS wild card character. The default extension
is .RCP.

Prompt For Name Check this if the template file name is to be prompted at Runtime when the
trigger occurs. If this option is selected, the “Extension” parameter also
appears. Enter a one to three character long extension which does not contain
aperiod or a DOS wild card. This extension is used as a filter to select which
files are displayed when prompting a user for the recipe name at Runtime,
however files with different extensions may be selected.
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From Mistic String Check this option if you want to use a string tag name from the controller
strategy to specify the template file name. If this option is selected, the
“Mistic String” edit box appears, prompting for the name of the Cyrano tag
name you want to use. Use the “?” button to enter the tag name from the
Tag Selection dialog box.

Extension Specify the file extension for the recipe files available to this dynamic attribute
by entering the extension in the File Extension field. The extension must be
one to three characters long and must not contain a period or DOS wild card
characters.

If Fixed Name is checked, this extension will append to the File Name entry
to create the name for the recipe file. If Prompt For Name is checked, this
extension will be used as a filter to select the files for display in a file selection
dialog box when the MIMI Runtime executes this dynamic attribute. However,
you may override this filter if you wish to select a file with a different
extension.

Trigger (Trigger-based recipe upload)
Use the Trigger button to select the Cyrano tag name that triggers the recipe
upload action. Pressing the “Trigger” button displays the Recipe Trigger
Configuration dialog box.

Notification (Trigger-based recipe upload)
Choose this button to select a tag to write a value to when an recipe is
successfully uploaded. Pressing this button displays the Recipe Upload
Completed Notification dialog box.

Notification Enabled (Trigger-based recipe upload)
This checkbox allows enabling and disabling of the Notification option
once it's configured. The Notification Enabled box remains disabled until
the natification is configured. A check mark in the box indicates the
notification is enabled.
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Dynamic Attribute Download Recipe Dialog Box

This dialog box is displayed when Touch—Download Recipe is selected from the Dynamic Attributes dialog
box and the Edit button is selected. The Dynamic Attributes dialog box is displayed by selecting the Edit>Edit
Dynamic Attributes menu option. Use this dialog box to configure a Touch—Download Recipe dynamic attribute
or a trigger-based recipe download. The descriptions that follow for the fields and controls apply to both the
Format File and the Destination File.

|

Dynamic Attribute - Download Recipe

> Prompt For Name
 From Mistic String

Recipe File:
Directory || | Browse... I
“ Fixed Name _ _
File Name: Extension: |rcp

V oK xcancel ? Help

Figure 7-19: Dynamic Attribute Download Recipe Dialog Box

Name: (Trigger-based recipe download)

Directory

Fixed Name

Mistic MM User's Guide

Enter a name to refer to this recipe manager. This name is used to refer to
this trigger-based recipe in the Recipe Managers list dialog box. The name
can be up to 40 characters long.

Use the Browse hutton to select the directory where the recipe files are.
This directory contains the recipe files available for downloading. At Runtime,
only files from this directory are accessed.

Check this if the recipe file is a file name you want to configure at this time.
If this option is selected, the File Name edit box appears, prompting you for
a file name. Make sure the file exists in the Directory entry, otherwise an
error is posted. The file name may not be changed at Runtime.

The Extension parameter also appears and prompts for a one to three
character long extension that's appended to the Fixed Name. The extension
must not contain a period or a DOS wild card character. The default extension
is “.RCP".
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Prompt For Name Check this if the recipe file name is to be prompted at Runtime when the
trigger occurs. If this option is selected, the Extension parameter also appears.
Enter a one to three character long extension which does not contain a
period or a DOS wild card. This extension is used as a filter to select which
files are displayed when prompting a user for the recipe name at Runtime,
however files with different extensions may be selected.

From Mistic String Check this option if you want to use a string tag name from the controller
strategy to specify the recipe file name. If this option is selected, the “Mistic
String” edit box appears, prompting for the name of the Cyrano tag name
you want to use. Use the “?” button to enter the tag name from the Tag
Selection dialog box.

Extension Specify the file extension for the recipe files available to this dynamic attribute
by entering the extension in the File Extension field. The extension must be
one to three characters long and must not contain a period or DOS wild card
characters.

If Fixed Name is checked, this extension will be appended to the File Name
entry to create the name for the recipe file. If Prompt For Name is checked,
this extension will be used as a filter to select the files for display in a file
selection dialog box when the MIMI Runtime executes this dynamic attribute;
however, you may override this filtering if you wish to select a file with a
different extension.

Trigger (Trigger-based recipe download)
Use the Trigger button to select the Cyrano tag name that triggers the recipe
download action. Pressing the Trigger button displays the Recipe Trigger
Configuration dialog box.

Notification (Trigger-based recipe download)
Choose this button to select a tag to write a value to when an recipe is
successfully downloaded. Pressing this button displays the Recipe Download
Completed Notification dialog box.

Notification Enabled (Trigger-based recipe download)
This checkbox allows enabling and disabling of the Natification option once
it's configured. The Notification Enabled box remains disabled until the
notification is configured. A check mark in the box indicates the notification
is enabled.

Mistic MMI User's Guide  7-31



GRAPHICS

Dynamic Attribute Launch Application Dialog Box

This dialog box is displayed when Touch—Launch Applications is highlighted and the Edit button is selected
from the Dynamic Attributes dialog box. The Dynamic Attributes dialog box is displayed when the Edit—>Edit
Dynamic Attributes menu option is selected. It allows you to specify execution of a program file which is to be
associated with the graphic whose dynamic attributes are being edited.

|

Dynamic Attribute - Launch Application

~ Single Instance

Working Directory | | Browse... I
Command Line | | Browse... I
Append Mistic String | | ? IX I
Launch Options Show Options
“# Multiple Instances
P # Normal > Minimized > Maximized

“DK

xﬁancel ? Help

Figure 7-20: Dynamic Attribute Launch Application Dialog Box

Working Directory

Command Line
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These controls allow selection of a working directory used when launching
the specified application. The working directory is an optional parameter. If
a working directory is not specified, the current MM Runtime directory is
used when launching the application. Selecting the Browse button displays
a dialog box titled Working Directory Selection. This dialog box enables
selection of a working directory path. Upon exiting this dialog box, the
selected path is displayed in the edit box. Contents of this edit box can be
edited to add or modify the working directory at any time.

Selecting the Browse button displays a dialog box titled Application Manager
Executable File Selection. This dialog box enables selection of a program
file which is executed when the graphic is selected. Upon exiting the dialog
box, the edit box contains the selected program file name, extension, and
path. Contents of this edit box can be edited to add or modify any command
line parameters.
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Append Mistic String/Browse/Clear Button

Launch Options

Multiple Instances

Single Instance

Show Options
Normal
Minimize

Maximize

This optional feature allows a string from a Mistic controller tag to be
appended to the Command Line string. The string is appended to the
command line string before the application is launched. A possible use for
this option is to save command line options for an application in the controller.
Only tag names may be entered. Literal strings are not accepted. If the
appended string is a parameter, a space must be included in the Command
Line string to separate it from the main command line.

Selecting the “?" button displays the Tag Selection dialog box to choose a
string variable from the controller strategy. Pressing the “X" button clears
the tag name entered.

Applications can be launched so that a new session is created each time, or
so that only one session is running at a time for a single graphic.

This option launches a new session of an application each time the operator
selects the graphic. Some applications only allow one session of an
application to run, while others allow multiple sessions.

This option forces the Runtime to check if this graphic has already launched
an active session of any application. If no application has been launched,
the Runtime launches it, and keeps track of when it's closed.

The single instance option does not limit the number of active sessions of
an application that's launched by other graphics and triggers. The single
instance option only applies to each graphic or trigger. Therefore, it's possible
to have multiple active sessions of an application, even when this option’s
used.

The show options control the initial appearance of the application when it's
launched.

This option displays the application window in a normal view.
The application is displayed as an icon when it is launched.

The application is displayed as an enlarged window when it is launched.
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Dynamic Attribute Runtime Menu Commands Dialog Box

This dialog box is displayed when the Touch—Execute Menu Item is highlighted and the Edit button is selected
from the Dynamic Attributes dialog box. The Dynamic Attributes dialog box is displayed when the Edit—>Edit
Dynamic Attributes menu option is selected. Use this dialog box to configure a Runtime command to execute
when the selected graphic is touched.

= Runtime Menu Commands

Menu ltem

FilefChange Printer...
File/Exit MMI Runtime
FilefOpen Project... —
File/Print

File/Printer Setup...
File/Project Path
Help/About MMI Runtime...
Help/Contents

Help/How to Use Help
Help/Search for Help On... +

V 0K xl:ancel ? Help

[+

Figure 7-21: Dynamic Attribute Runtime Menu Commands Dialog Box

A Touch—Execute Menu Item dynamic attribute is an Operator Driven Attribute. To configure a Touch—
Execute Menu Item dynamic attribute, you need to select the menu item you want executed.

A feature of this dynamic attribute is it overrides the effect of having the “Prevent User Exit” enabled (see
Configure—=>Run Time, Runtime Setup dialog box). A menu item that is normally prevented from being executed
when Prevent User Exit is true will be allowed to execute if invoked using this dynamic attribute. This will allow
commands such as File=>0pen Project or exiting from the MMI Runtime. Graphics with dynamic attributes to
do this type of override would typically be contained in draw windows that only are shown in special cases,
perhaps controlled via a security scheme.

Menu Item Select the Runtime menu option from this list box and click OKto configure
the graphic.
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CHAPTER 8

TRENDS

OVERVIEW

Trend charts are advanced graphics that display tag values on a graph grid. You can input values to a real-time
trend using active I/0 tags in a Cyrano strategy. The X-axis represents the time span and the Y-axis is the value
range of the data points being plotted. Values appear to move from right to left as they are added to the trend
line. Up to four trend lines can be displayed on any one trend chart, but there is no limit to the number of trend
charts displayed in a draw window. The maximum time span supported by each trend is 14 days.

Several options are available to customize each trend chart. Some configurable features include the number of

major and minor divisions, the graph background, border, pen colors for the trend lines, the x and y axis ranges,
and when to stop trend scanning.

To create a trend, select the trend tool from the toolbar or Tool-> Trend menu option. Position the cursor where
you want the trend to begin, click the left mouse button, drag the mouse to size the trend, and release the left
mouse button. Modify the trend by double-clicking on the trend.

trends v
100
a0
=1
0 7
20|
E‘M 85 HH:AmA: S5 HH:AmA: S5 HH:AmA: S5 HH:h

Figure 8-1: Trend Placed in a Window
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DIALOG BOXES

The following dialog boxes are used to configure trends.

Trend Dialog Box

The Trend dialog box appears when the trend graphic tool is selected, a trend graph is placed, and the graphic
is double-clicked.

.=.| Trend Configuration

|Tit|E |Examn|e Trend |

TimeSpan |BI] | |Secunds |£I | Chart Color I:I Border Color -
Refresh Time |Grl:lup 0 {1 sec. 1 sec) |£I Penl__. I | Eaabind _| Enablod
Disable Trend |Never |£I | Enablad | Enabled
X-axis Layout Y-axis Layout
Color Color

Number of Major Divisions

[+ ]
Number of Minor Divisions IZI
[ ]

Label Interval in Major Div

Number of Major Divisions

Number of Minor Divisions

T R

HIII

Label Interval in Maj Div

Label Position : Label Position Left +

Label Format +| Hours «| Minutes | Seconds Label Range Min Val D Max Val

/ oK xﬁancel ? Help

Figure 8-2: Trend Dialog Box

Title The name used to identify this real time trend.

Time Span The time span is the period of time represented by the real time trend. The
maximum time span supported is 14 days.

Specify the time span by selecting a unit type (e.g., minutes) from the list
box and entering a value in the edit box.

Refresh Time Select the refresh time group you wish to use to scan the trend pens tags.
All trend pen’s tags will be scanned at the same rate.

Disable Trend Choose an option from the “Disable Trend” drop-down list to configure
disabling for a trend based on its window state. This option is useful to
improve efficiency when several trends are used. If every trend is always
scanning, the system throughput is slowed considerably.
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Chart Color

Border Color

Pen Configuration

The trend retains its recorded data at the time the trend was disabled.
Never The trend is never disabled. It always collects data.

When Window Closed The trend stops scanning when its window is
closed. It starts scanning again when the window is restored.

When Window Minimized The trend stops scanning when its window is
minimized. It starts scanning again when the window is restored.

When Window Closed or Minimized The trend stops scanning when its
window is closed or minimized. It starts scanning again when the window is
restored.

The chart color is the background color of the real time trend. To select a
color, click in the color button to display the Color dialog box.

Click in the color button to display the Color dialog box and choose a color to
outline the chart area of the real time trend.

A real time trend can graph up to four lines simultaneously. Each line has a
trend pen associated with it.

Each trend pen is configured with the Trend Pen dialog box. Only trend pens
that are configured and enabled have a line graphed.

To configure a trend pen, select the appropriate Pen button. The corresponding
Trend Pen Configuration dialog box appears. Use it to configure the pen
color, line width, and its maximum/minimum values. A trend pen that has
been previously configured can be enabled or disabled by selecting its
Enabled check box.
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X-axis Layout

This section configures the appearance of the chart with regard to the X-axis. You can specify the spacing and
color of the vertical lines that identify major and minor axis divisions. You can also use this to specify the format,
color, position and spacing of labels.

Number of Major Divisions

Number of Minor Divisions

Label Interval in Major Div

Label Position

Label Format

Y-axis Layout

Enter the Number of Major Divisions in the edit box and specify the color of
the vertical lines by selecting the color button. The minimum number of
major divisions is one.

Enter the Number of Minor Divisions in the edit box and specify the color of
the vertical lines by selecting the color button. The minimum number of
minor divisions is one.

Enter the spacing in the Label Interval in Major Div. edit box. The value
entered specifies how often a label appears with a Major Division vertical
line (e.g., 1 means every line, 3 means every third line).Specify the label
color by selecting the color button.

The Label Position is specified using the drop down list box. Choices are
Top, Bottom, Top & Bottom, or None.

The Label Format is specified as any combination of Hours, Minutes, and
Seconds.

This section configures the appearance of the chart with regard to the Y-axis. You can specify the spacing and
color of the horizontal lines that identify major and minor axis divisions. This can also be used to specify the
format, color, position, and spacing of labels.

Major Axis Divisions

Minor Axis Divisions
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Enter the Number of Major Divisions in the edit box and specify the color of
the horizontal lines by selecting the color button. The minimum number of
major divisions is one.

Enter the Number of Minor Divisions in the edit box, and specify the color of
the horizontal lines by selecting the color button. The minimum number of
minor divisions is one.
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Labels Enter the spacing in the Label Interval in Major Div. edit box. The value
entered specifies how often a label appears with a Major Division horizontal
line (e.g., 1 means every line, 3 means every third line). Specify the label
color by selecting the color button. The Label Position is specified using the
drop down list box. Choices are left, right, left & right, or none.

Label Interval in Major Div  Enter the spacing in the Label Interval in Major Div. edit box. The value
entered specifies how often a label appears with a Major Division vertical
line (e.g., 1 means every line, 3 means every third line). Specify the label
color by selecting the color button.

Label Position The Label Position is specified using the drop down list box. Choices are
Top, Bottom, Top & Bottom, or None.

Label Range The Label Range refers to the range of pen tag values that appear within
the boundaries of the chart. The Min Val represents the minimum value
along the chart’s y-axis, and the Max Val represents the maximum value
represented by the top of the y-axis.
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Trend Pen Dialog Box

This dialog box is displayed when a Pen# button is selected from the Trend dialog box. Use this dialog box to
configure a trend pen. It associates a tag with the pen and defines the relationship between the tag’s value and
the position of the pen on the real time trend's chart, i.e., it establishes the scaling between the tag's value and
the y-axis of the chart.

|

Trend Pen #1 Configuration

Tag

Name: |

Maximum Value I:I
Minimum Value I:I

Type: (Cyrano 200

Pen Color

Pen Width

I
L]

“DK

xﬁancel

? Help

Name

Type

Minimum Value

Maximum Value

Pen Color

Pen Width
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Figure 8-3: Trend Pen Dialog Box

Select a Cyrano tag to use as the source of the position data. As the value of
the selected tag's data changes during execution of the Cyrano Strategy,
the trend pen'’s position changes according to the position parameters entered
in this dialog box.

Cyrano 200 is currently the only type selection available.

This is the tag value that positions the trend pen at the bottom of the chart's
y-axis. If the value read for the tag at a particular scan time is less than this
minimum value, no point is plotted at the x-axis position for that scan time.

This is the tag value that will position the trend pen at the top of the chart’s
y-axis. If the value read for the tag at a particular scan time is greater than
this maximum value, no point will be plotted at the x-axis position for that
scan time.

Selecting the color button displays the Color dialog box for choosing the
color for the line that represents this pen’s data on the chart.

This edit box specifies the width of the line drawn on the chart for this pen.



CHAPTER 9

RECIPE DOWNLOAD AND UPLOAD

OVERVIEW

Recipes allow you to download and upload data to a Cyrano program. They provide a convenient method for
making broad changes to program variables without having an operator manually enter numerous values. This
is common in batch type processes where system variables have been predetermined and vary between runs
or product types. For example, a cookie baking company uses a Mistic system to control its cookie making
process. They make chocolate chip cookies in the morning and need to make peanut butter cookies in the
afternoon. The operator can simply upload the recipe to the controller with the ingredient changes. Recipes
may also be used to save critical process settings which can be used to create more recipes or restore a system
after a failure.

Recipe files are simple ASCII files which contain one or more Cyrano tags and values. Only integer table, float
table, and string table tags may be used in a recipe file. A recipe file may also contain chart control instructions.
You can run, stop, suspend, and continue one or more Cyrano charts when a recipe file is downloaded. This
may be used to start a chart which moves the values in the downloaded tables to other program variables.

Recipes files are downloaded and uploaded by either configuring a Touch—Download Recipe or Touch—
Upload Recipe Dynamic Attribute to a graphic object, or by configuring a trigger to initiate the recipe action. If
a configured graphic object is selected by the operator or the required trigger action occurs, the configured
upload or download function is performed.

This chapter begins by explaining some basic concepts about recipe files. Dialog boxes relating to recipes are
then explained and conclude the chapter.
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RECIPE FILE FORMAT

Recipe files are ASCII files and can be created using any text editor or word processor that can save files in
ASCII format. The Windows Notepad accessory can be used to create ASCII files. Each recipe file contains a list
of the Cyrano tags followed by the corresponding data values.

A typical recipe file is shown in Figure 9-1.

Recipe File "EXAMPLE.RCP"

Comment lines
begin with "

{ recipe file for 902 fabri
! file sets : belt speed
bond temp
width

yard qty

MILL1:Float Table.Fabric_Type_902
123.50
36.80 Cyrano tag

44.50
1200.00

L

Diata waluey

lend of recipe file

Blank ling

Figure 9-1: Recipe File Format

Figure 9-1 shows how a simple recipe file could be configured. The file contains one or more of the following
items:

Comment Line

Any line which begins with the “/” character is considered a comment. Comments are used for documentation
only.

Cyrano Tag

This line identifies the Cyrano tag being downloaded (or uploaded). It has the format:

<Controller Name>:<Table Type>.<Table Name>

<Controller Name> is the Mistic controller name

<Table Type> is one of the keywords “Integer Table”, “Float Table”, or “String Table” which identifies the
variable type and is separated from <Controller Name> by a “:"
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<Table Name> is the table name of the Cyrano program tag. It must be of the type specified by <Table Type>.
It is separated from <Table Type> by a “."

Data Values

Each line following the Cyrano tag contains a data value. When the file is downloaded, the first line following
the tag will be sent to index 0 of the table, the second line will be sent to index 1 of the table, and so on. The
number of values following the tag must be equal to or less than the actual size of the table. Sending more
values than a table can hold will cause errors.

Blank Line

The line after the last data value must be a blank line containing only a carriage return. This line is used to
indicate that all the data for that particular table has been specified. Blank lines must not be interspersed
within the lines containing the data for the table. The last line of the file must also be a blank line. Figure 9-2
shows where blank lines are expected in the recipe file.

Specifying an Index

When downloading large data tables, it may be convenient to download only part of the table. When a table is
downloaded, the table index starts at 0 and is incremented with each data line. The recipe file in Figure 9-2
illustrates how to specify an index.

Recipe File "EXAMPLEZ.RCP"

! yard qty
/

MILL1:Float Table.Fabric_Type_902
123.50
36.80
44.50

1200.00

! start fabric sequence
MILL1:Chart.Initialize_Sequence

! end of recipe file

Blank line

Figure 9-2: Table Indices in a Recipe File

In the above example, the first data value 123.50 would be sent to element 0 of the table. The following line
contains the index reference 23:36.80, so the data value 36.80 would be sent to element 23 of the table. The
next line, 44.50, will be sent to element 24 of the table. When line 64:1200.00 is sent, it will go to element 64
of the table. The following value, 1255.60, is sent to element 65, and so on.
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Chart Control Instructions

The example file in Figure 9-3 contains a chart control instruction. The chart control instruction is used to control
the execution state of any Cyrano chart when a recipe file is downloaded.

The instruction has the following format:

<Controller Name>:Chart.<Chart Name>
<Chart State>

yard qty
U:Float Table.Fabric_Type._

200.00

! start fabric sequence
MILL1:Chart.Initialize_Sequeng

RUN

! end of recipe file

Blank line

Figure 9-3: Blank lines in a Recipe File

<Controller Name> is the Mistic controller name.
Chart is the keyword which identifies the type of instruction and is separated from <Controller Name> by a *:"
<Chart Name> is the Cyrano chart name. It is separated from Chart by a “.”

<Chart State> is one of the following keywords: STOP, RUN, SUSPEND, or CONTINUE and must be on the line
following the <Chart Name>. The last line must be a blank line containing only a carriage return. This line is
used to indicate the end of chart control data.

Recipe Uploading

Uploading a recipe is similar to downloading as the files have exactly the same format. However, when an
upload is initiated, the MMI needs to know what tags to upload. To do this, a Format File and a Destination File
are specified. The format file is a template of the data to retrieve from thecontroller and has the same format as
a download file. The destination file is the filename to which the uploaded data will be stored.
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DIALOG BOXES

The dialog boxes used to configure recipes are discussed in this section. Depending on whether you want a
touch-based or trigger-based recipe action will determine which configuration dialog boxes are displayed.

How to Bring Up a Touch-based (Graphic) Recipe Action

If you want a recipe action to occur by having an operator choose a graphic, you'll want to configure a touch-
based recipe action. To begin to configure a touch-based recipe, use the Selector tool to select a graphic, and
then choose the Edit—>Edit Dynamic Attributes command. The Graphic Dynamic Attributes dialog box is displayed.
Select the Touch—Download Recipe or the Touch—Upload Recipe option and then the Edit button. The Dynamic
Attribute—Download Recipe dialog is displayed if the Touch—Download Recipe option was selected. The
Dynamic Attribute—Upload Recipe dialog box is displayed if the Touch—Upload Recipe option was selected.

|

Graphic Dynamic Attributes

‘ Object: Group

Controller Driven Attributes

> a1

Y: 146 Width: 68 Height: 24

Operator Driven Attributes

Line Color

Fill Color

Text Color
Yisibility/Blink
Horizontal Size (width)
Yertical Size (height)
Horizontal Position

goodoodn

Yertical Position

Claar

VDK

>

Horizontal Slider
Vertical Slider m
Touch - Send Value
Touch - Send Discrete
Touch - Send String
Touch - Windows laar

Touch - Download Recipe +

goodood

v| Focus-frame Enabled
v| Beep Enabled

xﬁancel

? Help

Figure 9-4: Dynamic Attributes Dialog Box Used to Configure a
Touch-based Recipe Action
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How to Bring Up a Trigger-based Recipe Action

If you want a recipe action to occur after an event takes place, you'll want to configure a trigger-based recipe
action. To begin to configure a trigger-based recipe, select the Configure=> Recipe menu option. The Recipe
Managers dialog box appears. Click the appropriate Add button to configure a download or upload trigger
action. The corresponding Download or Upload Recipe Manager appears.

Figure 9-5: Recipe Managers Dialog Box Used to Configure
Trigger-based Recipe Action

Download Recipe Dialog Boxes

The dialog boxes used to configure the download recipe actions differ slightly between the touch-based and
trigger-based recipes. Figure 9-6 shows the dialog box used to configure touch-based recipes, and Figure 9-7
shows the dialog box used to configure trigger-based recipes. The dialog box parameter descriptions for both
are described in this section. Those applying only to trigger-based recipes are indicated as such.

Figure 9-6: Dynamic Attribute Download Recipe Dialog Box

9-6 Mistic MMI User’s Guide



RECIPE DOWNLOAD/UPLOAD

|

Download Recipe Manager

> Prompt For Name
> From Mistic String

Name: | |
Recipe File:
Directory | | Browse... I
“+ Fixed Name _ i
File Name: Extension: |rcp

Trigger: |

Trigger... I

Notification... | | siatlication Fnabied

“ oK xcancel ? Help

Name (Trigger-based re

Directory

Fixed Name

Prompt For Name

Figure 9-7: Download Recipe Manager Dialog Box

cipe download)
Enter a name for this recipe. This name is used to refer to this trigger-
based recipe in the Recipe Managers list dialog box. The name can be up
to 40 characters long.

Use the Browse button to select the directory where the recipe files are.
This directory contains the recipe files available for downloading. At Runtime,
only files from this directory are accessed.

Check this if the recipe file is a file name you want to configure at this time.
If this option is selected, the File Name edit box appears, prompting you for
a file name. Make sure the file exists in the Directory entry, otherwise an
error is posted. The file name may not be changed at Runtime.

The Extension parameter also appears and prompts for a one to three
character long extension that's appended to the Fixed Name. The extension
must not contain a period or a DOS wild card character. The default extension
is RCP.

Check this if the recipe file name is to be prompted at Runtime when the
trigger occurs. If this option is selected, the Extension parameter also appears.
Enter a one to three character long extension which does not contain a
period or a DOS wild card. This extension is used as a filter to select which
files are displayed when prompting a user for the recipe name at Runtime,
however files with different extensions may be selected.
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From Mistic String

File Name

Mistic String

Extension

Check this option if you want to use a string tag name from the controller
strategy to specify the recipe file name. If this option is selected, the “Mistic
String” edit box appears, and prompts for the name of the Cyrano tag name
you want to use. Use the “?” button to enter the tag name from the Tag
Selection dialog box.

This parameter is displayed if the Fixed Name option was selected. The file
name is the name of the recipe located in the Directory entry.

This parameter is displayed if the From Mistic String option is checked.
Enter the name of the Cyrano tag name containing the name of the recipe
file. The tag name must be a string type.

Specify the file extension for the recipe files available to this dynamic attribute
by entering the extension in the File Extension field. The extension must be
one to three characters long and must not contain a period or DOS wild card
characters.

If Fixed Name is checked, this extension will be appended to the File Name
entry to create the name for the recipe file. If Prompt For Name is checked,
this extension will be used as a filter to select the files for display in a file
selection dialog box when the MMI Runtime executes this dynamic attribute.
However, you may override this filtering if you wish to select a file with a
different extension.

Trigger (Trigger-based recipe download)

Use the Trigger button to select the Cyrano tag name that triggers the
recipe download action. Pressing the Trigger button displays the Recipe
Trigger Configuration dialog box.

Notification (Trigger-based recipe download)

Choose this button to select a tag to write a value to when an recipe is
successfully downloaded. Pressing this button displays the Recipe
Download Completed Notification dialog box.

Notification Enabled (Trigger-based recipe download)
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This checkbox allows enabling and disabling of the Notification option
once it's configured. The Notification Enabled box remains disabled until
the natification is configured. A check mark in the box indicates the
notification is enabled.
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Upload Recipe Dialog Boxes

The dialog boxes used to configure the upload recipe actions differ slightly between the touch-based and
trigger-based recipes. Figure 9-8 shows the dialog box used to configure touch-based recipes, and Figure 9-9
shows the dialog box used to configure trigger-based recipes. The dialog box parameter descriptions for both
are described in this section. Those applying only to trigger-based recipes are indicated as such.

Figure 9-8: Dynamic Attribute Upload Recipe Dialog Box

Figure 9-9: Upload Recipe Manager Dialog Box
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The following descriptions apply to both the Format File and the Destination File.

Name (Trigger-based recipe upload)
Enter a name for this recipe. This name is used to refer to this trigger-based recipe in the Recipe Managers
list dialog box. The name can be up to 40 characters long.

Directory

Fixed Name

Prompt For Name

From Mistic String

File Name

Mistic String
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Use the Browse button to select the directory where the template file
resides. At Runtime, only files from this directory are accessed.

Check this if the template file is a file name you want to configure at this
time. If this option is selected, the File Name edit box appears, prompting
you for a file name. Make sure the file exists in the Directory entry, otherwise
an error is posted. The file name may not be changed at Runtime.

The Extension parameter also appears and prompts for a one to three
character long extension that's appended to the Fixed Name. The extension
must not contain a period or a DOS wild card character. The default extension
is .RCP.

Check this if the template file name is to be prompted at Runtime when the
trigger occurs. If this option is selected, the Extension parameter also appears.
Enter a one to three character long extension which does not contain a
period or a DOS wild card. This extension is used as a filter to select which
files are displayed when prompting a user for the recipe name at Runtime,
however files with different extensions may be selected.

Check this option if you want to use a string tag name from the controller
strategy to specify the template file name. If this option is selected, the
“Mistic String” edit box appears, prompting for the name of the Cyrano tag
name you want to use. Use the “?" button to enter the tag name from the
Tag Selection dialog box.

This parameter is displayed if the Fixed Name option was selected. The file
name is the name of the recipe located in the Directory entry.

This parameter is displayed if the From Mistic String option is checked.
Enter the name of the Cyrano tag name containing the name of the recipe
file. The tag name must be a string type.
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Extension Specify the file extension for the recipe files available to this dynamic attribute
by entering the extension in the File Extension field. The extension must be
one to three characters long and must not contain a period or DOS wild card
characters.

If Fixed Name is checked, this extension will append to the File Name entry
to create the name for the recipe file. If Prompt For Name is checked, this
extension will be used as a filter to select the files for display in a file selection
dialog box when the MMI Runtime executes this dynamic attribute. However,
you may override this filter if you wish to select a file with a different
extension.

Trigger (Trigger-based recipe upload )
Use the Trigger button to select the Cyrano tag name that triggers the recipe
upload action. Pressing the Trigger button displays the Recipe Trigger
Configuration dialog box.

Notification (Trigger-based recipe upload )
Choose this button to select a tag to write a value to when an recipe is
successfully uploaded. Pressing this button displays the Recipe Upload
Completed Notification dialog box.

Notification Enabled (Trigger-based recipe upload )
This checkbox allows enabling and disabling of the Notification option
once it's configured. The Notification Enabled box remains disabled until
the natification is configured. A check mark in the box indicates the
notification is enabled.
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Recipe Managers

The Recipe Manager dialog box appears when the Configure—=>Recipe command is selected. The dialog box
displays the Download Recipes and Upload Recipes list boxes which list the recipes that can be downloaded to
the controller or uploaded from the controller. Each list box has a set of Add, Modify, and Delete buttons
associated with it.

Pressing the Add or Modify button in the Download Recipes group displays the Download Recipe Manager
dialog box. Similarly, the Upload Recipe Manager is displayed when its Add or Modify buttons are pressed.

The Delete button removes the name of a recipe manager from the list.

Figure 9-10: Recipe Managers Dialog Box
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Recipe Download/Upload Completed Notification

The Recipe Download/Upload Completed Notification dialog box allows definition of a tag and value written to
that tag when an appropriate notification condition occurs. You must select a tag from the tag section of this
dialog box to use as the destination for the data.

Set/Offset:

Select Set if you want the value used as a replacement for the tag's current value. Select Offset if you want the
value added to the tag’s current value.

Value Out

This field defines the floating point or integer value written to the specified tag.

i) e o]

Figure 9-11: Recipe Completed Notification Dialog Box
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CHAPTER 10

HISTORICAL LOGGING

OVERVIEW

Historic logging allows you to store data from your process onto disk. Once the data is collected, it can be
removed from the system for permanent storage or for use by other applications, such as Excel, to make
reports. Data is stored in standard delimited ASCII format. Up to 1 million separate tags may be configured per
historic log. (Inthe case of tables, each element is considered a separate tag.) The data, along with the timestamp,
is buffered in the host's memory until it reaches the configured buffer size limit. Upon reaching this limit, the
buffer contents are written to this historic log file.

Some basic concepts are presented in the beginning of this chapter, followed by explanations of dialog boxes
used to configure Historic Logs.

Tag Types

The following tag base types can be logged: Integer, Integer Table, Float, Float Table, String and Discrete. With
tables you may select individual elements, groups of elements, or all elements.

Filenames

Filenames may be constructed in several ways and be created from different sources. Filenames may be created
automatically by using the rollover concept, be specified as a fixed name, or be created by using strings stored
in the Mistic controller strategy.

The rollover format does not apply to files with fixed names or which are constructed from Mistic string tagnames.

Triggers

By default, historic logging begins when scanning starts and ends when scanning stops. Optionally, the beginning
of logging may be delayed until a start trigger condition occurs, and can be stopped when a stop trigger
condition occurs or a defined number of samples have been collected. The triggers may be attached to any
controller variable.
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Rollovers

The rollover period controls how often a new data file is created. The rollover may be set for Hours, Days,
Months, or None. If the rollover is set to Hours, then a new data file will be created each hour. Configuring the
rollover to None causes all of the collected data to be placed in one file.

File Format

A historic log is a standard ASClI file. The first line of the file is a header which shows the names of each data
field. Subsequent lines are data samples with the following format:

DATE<delimiter>TIME<delimiter>TAG1<delimiter>TAG2. . .TAG1000<CrLf>

where:

DATE is the current system data in the format YYYY/MM/DD. (YYYY = year, MM= month, DD= day)
TIME is the current system time in the format HH:MM:SS. (HH= hour, MM= minute, SS= seconds)
TAG1..TAG1000 are valid Cyrano tags in the format Controller_Name:Tag

<delimiter> is any printable ASCII character.

<CrLf> is a carriage return, line feed.

Example:

Date,Time,CNTR1:TEMP208,CNTR1:PRES209,CNTR1:LEVEL218
1993/04/26,17:00:00,120.02,14.96,12.09

1993/04/26,17:00:01,120.06,14.98,12.03

1993/04/26,17:00:02,120.03,14.99,12.02

1993/04/26,17:00:03,120.04,15.01,12.05

Additional header lines may be posted to an existing log file. Every time the MMI is shut down and restarted,
anew header line is appended to the log file, followed by data samples.
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DIALOG BOXES

The following dialog box explanations present details for configuring Historic Logs.

Historic Log Dialog Box

The Historic Log dialog box is displayed when the Configure—> Historic Data Log menu option is selected from
the MM Configurator. All configured historic logs are listed by name. Use this command to add new historic
logs to the project , or modify or delete previously configured historic logs. You can add up to 1000 historic logs

per project.

|

Historic Logs

Name

| Add. |

| Rrhify I

| Dialate I

VDK

annceI ? Help

Add

Modify

Delete

Figure 10-1: Historic Log Dialog Box

Select the Add button to add new historic logs to the project. The new log is
displayed on the list when you return from the Historic Log Configuration
dialog box.

If there are no historic logs in the project, the Modify and Delete buttons
cannot be selected. If a historic log has been configured, the Modify and
Delete buttons may be selected.

Select the Modify button to change the selected historic log with the Historic
Log Configuration dialog box. The modified log is displayed on the list when
you return to the Historic Log dialog box.

Select the Delete button to remove the selected historic log from the historic
log list. After selecting the Delete button, amessage prompting you to delete
the selected historic log is displayed . If you respond “yes”, the historic log
is removed from the historic log list. Selecting “no” or <esc> aborts the delete
process.
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Historic Log Configuration Dialog Box

This dialog box is displayed when either the Add or Modify button is selected from the Historic Log dialog box.
From this dialog box, you can configure all the properties of a historic log.

Group D (1 sec, 1 sec) |—

Figure 10-2: Historic Log Configuration Dialog Box

Up to 1 million separate tags may be configured as individual log points within a single historic log. All configured
historic log points are put into a single Scan Group and scanned during runtime according to the scan rate of the
selected refresh time group. A time stamp is recorded when all tags are scanned within the scan group.

The data, along with the time stamp, is buffered in the host'’s memory until it reaches the buffer size limit
configured in the Historic Log File Configuration dialog box. Upon reaching this limit, the buffer contents are
written to this historic log file. All values within a scan group, including the time stamp, are recorded as a single
line using the delimiter specified with the Line Format button.

Filenames may be constructed in several ways and be created from different sources. Filenames may be created
automatically using the rollover concept, they may be specified as a fixed name, and they can be created using
strings stored in the Mistic controller strategy.
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Typically, file names are dependent on the rollover period specified within the Historic Log File Configuration

dialog box and follow the format:

RMYYMMHnn
RD YYMMDDHnn
RHMMDDHHHnn
HISTLOG.Hnn

Months
Days
Hours
None

where YY=year, MM =month, DD=day, HH=hour, and nn represents the two character identifier assigned to

the historic log by the configurator.

The rollover format does not apply to files with fixed names or that are constructed from Mistic string tagnames.

The number of files retained on disk for a historic log is also set within the Historic Log File Configuration dialog
box. Upon reaching this limit during runtime, the file with the oldest DOS time stamp is deleted.

Name

Refresh Time

Log File

This edit box enables the user to specify a name for the historic log being
configured. The name must be unique from all historic logs within the project
or an error message is displayed when OK is selected to exit the dialog box.

This read-only edit box contains a unique two character identifier
automatically assigned by the MMI Configurator. This identifier is used as
the last two characters of the file name extension for the historic log file
(e.g., .HOO).

Enables you to select a previously configured refresh time group to scan the
tags of the historic log points. This sample rate applies to every log point
configured within this historic log.

Allows access to the History Log File Configuration dialog box which defines
how the historic log file is to be accessed and maintained. File access
parameters include the delimiter, number of lines buffered, rollover period,
number of files to retain for this log, and whether to keep the file open.
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Historic Log Point Configuration

List

Append

Insert

Modify

Delete

Up

Down
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Displays all configured historic log points for this historic log by tag name.
The order of the points in the list is the order that the points will be logged
to the file, with the topmost entry first. New points may be added and existing
points may be modified, have their position in the list changed or deleted. To
change or rearrange historic log points in the list, select the point prior to
choosing the Modify, Up, Down, or Delete buttons. Each historic log point
corresponds to an individual tag defined in the Historic Log Point dialog box
which is accessed via the Append, Insert, or Modify buttons.

Allows access to the Historic Log Point dialog box to configure a new historic
log point to be added to the historic log. The new log point is added at the
bottom of the historic log points list upon selecting OK from the Historic Log
Point dialog box.

Allows access to the Historic Log Point dialog box to configure a new historic
log point to be added to the historic log. Upon selecting OK from the Historic
Log Point dialog box, the new log point is inserted immediately above the
point currently selected (highlighted) in the historic log points list.

Allows access to the Historic Log Point dialog box to modify the historic log
point which is selected in the historic log point list.

Removes the historic log point which is selected in the historic log point list.
After selecting the Delete button, a message is displayed prompting the
user to delete the selected historic log point. Responding “Yes” causes the
historic log point to be removed from the historic log points list. Selecting
“No" or esc aborts the delete process.

Moves the selected log point up the list by repositioning it just above the log
point that it is currently below.

Moves the selected log point down the list by repositioning it just below the
log point that it is currently above.
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Start Trigger

Enabled

Stop Trigger

Enabled

Number of Samples

Notification

Enabled Check Box

Displays the Historic Log Start Trigger Configuration dialog box allowing
definition of a tag and its associated condition which comprises the start
trigger for the Historic Log. The start trigger is edge sensitive and therefore
only activates from a non-triggered state. If a start trigger is configured and
enabled, then a stop trigger must also be configured or an error message
will result when exiting the Trigger dialog box via the OK button.

Allows start trigger enabling once the start trigger is configured. The Enabled
box remains disabled until the start trigger is configured. A check mark in
the Enabled box indicates the start trigger is enabled.

Displays the Historic Log Stop Trigger Configuration dialog box allowing
definition of a tag and its associated condition which comprise the stop
trigger for the Historic Log. The stop trigger is edge sensitive and only
activates on a transition from a false to true state.

There are two different methods of stopping historic log sampling once it
has begun. The user may either select a tag and define a condition for that
tag which causes sampling to terminate when the condition evaluates to
true (Stop Trigger button), or the user may define a discrete number of samples
to take once the start trigger occurs (Number of Samples). Radio buttons in
front of the Stop Trigger button and Number of Samples edit box determine
the type of stop trigger selected. A method to stop the sampling is required
if a start trigger is configured and enabled. If no start trigger is configured
and enabled, then a stop trigger is not needed.

Allows stop trigger enabling once the stop trigger is configured. The Enabled
box remains disabled until the stop trigger is configured. A check mark in
the Enabled box indicates the stop trigger is enabled.

Allows the alternative configuration of a stop trigger via specification of the
number of historic log samples to take once a start trigger occurs.

Displays the Natification dialog box allowing selection of a tag and a value
to be written to that tag when the condition that stops the Historic Log
sampling is encountered.

Allows notification enabling once the natification is configured. The Enabled
box remains disabled until the notification is configured. A check mark in
the Enabled box indicates the notification is enabled.

Mistic MMI User's Guide 10-7



HISTORICAL LOGGING

Historic Log File Configuration Dialog Box

The Historic Log File Configuration dialog box allows you to configure how a data file is stored to disk. Files are
stored in standard ASCII delimited format. The size, number of files, and line formats are configurable parameters.

Browse
Use Project Directory

Automatic
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Figure 10-3: File Access Dialog Box

Use this edit box to enter the directory path and filename for a data file. This
parameter is initially blank and can be directly edited or changed with the
Browse button.

Use the Browse button to quickly locate a directory path for the data file.
Choose this option to specify the file be created in the MMI project directory.

Select this option to automatically specify the filename selected in the
Directory Path group.
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Fixed

From Mistic String

Use this option to specify a file name for the data file. The filename can be
any valid, 8 character DOS file name and does not require a 3 character
extension. Note, if you do not specify an extension, one is not automatically
added. A directory path name must be specified either explicitly in this field,
or by having selected the “Use Project Directory” option. If the “Name”
option was selected, its corresponding edit box must have a file name.

A Start Trigger option must be configured and enabled for this file name
source. When the trigger starts a historic log, the new data is appended if
the file already exists, and is created if it does not.

Rollover does not apply to this type of file.

This option lets you specify a string tagname from a Cyrano control strategy
and use it to define the file name source. The tagname is specified in the
Mistic String edit box with the “?” button. The tag selected must be a string

type.

A Start Trigger option must be configured and enabled. \When the trigger
occurs, the Mistic String tag is concatenated to the Directory Path Name.
The Directory Path Name may be an empty string. If this is the case, the
tagname must contain the complete path name, including the drive designator
(such as c:). This option lets a historic log produce different file names each
time a trigger occurs. If a file already exists, the new data is appended to it.
If it does not exist, the file is created.

The Default Name if Mistic String Invalid parameter is used to specify a file
name in case the Mistic string concatenation does not create a valid file
name. The filename can be any valid, 8 character DOS file name. Do not
include a 3 character extension. If the default file name is used, the extension
isan "H" followed by the historic log's ID number (Example: .HOO if the ID
were 00).

In case the tagname entered in Mistic String is empty, then the Project
Directory is concatenated with the default file name to create the path and
file name.
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Line Format

Lines Buffered

Keep File Open

Number of Files to Retain
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If the result of the concatenation is a directory or file that can't be accessed
or created, the logging file is created using the following rules:

e |f the Mistic String is empty, then the Project Directory is
concatenated with the Default Name if Mistic String Invalid and
the extension is an “H” followed by the historic log ID number.

e |f the Mistic String is not empty and the Project Directory was not
specified as the directory path, then the “Directory Path Name” is
concatenated with the “Default Name if Mistic String Invalid”.

e |f the “Project Directory” was specified as the path, or the previous
step failed, the “Project Directory” is concatenated with the
“Default Name if Mistic String Invalid” and the extension is an
“H" followed by the historic log ID number. If the project directory
is read-only or there is not enough room left on the drive containing
the project directory, an error is posted indicating the file could
not be created.

¢ Rollover does not apply to this type of file.

The Line Format button displays the Line Format dialog and allows you to
customize the line formatting in historic and event logs.

Lines buffered configures the number of data lines (samples) which are
buffered in system memory before the data is written to disk. Valid entries
are any number between 0 and 999. A small Lines Buffered value combined
with fast sample rates may result in excessive disk access. A large “Lines
Buffered” value may result in loss of data in the event of power loss or
system failure.

When data samples are recorded to disk, the data file is opened, data is
written to disk, and the data file is closed. This allows maximum data integrity
but slows disk access since each disk access requires an open, write, and
close sequence. This option allows the MM to keep the current data file
open for writes, increasing disk performance. Should the system lose power
or fail, the current data file may be damaged or lost.

This edit box contains the number of files that will be stored on the disk
before the oldest file is deleted. If Rollover is set to Hours and the Number
of Files to Retain is set at 30, only the last 30 hours' data would be stored on
disk. Any files older than 30 hours would be deleted.
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Rollover

Rollover Settings

The Rollover edit box allows you to select a rollover period which determines
how often a new data file is created. You may select Hours, Days, Month, or
None from the drop-down list box. See Rollover Settings for more details.

The Rollover drop-down list allows the user to select how often a new data
file is created. The user may select Hours, Days, Month, or None from the
drop-down list box. For time based rollovers, the DOS time and date functions
are used in determining time-of-day and day-of-month. Be sure the system
time and date are set prior to starting the MMI.

Selecting hours causes a new data file to be created at the top of every
hour. If data logging were triggered at 8:30 am, the first data file would
contain data from 8:30 am to 9:00 am. Thereafter, data files will contain
data from 9:00 am to 10:00 am, 10:00 am to 11:00 am, etc. The data files
will, therefore, contain a maximum of one hours’ data depending on when
logging is triggered.

Selecting days causes the current data file to close and a new data file to be
created every day at midnight. If data logging were trigged at 7:00 pm on
the 5th, the first data file would contain data from 7:00 pm to 12:00 pm on
the 5th. Thereafter, data files will contain data from midnight the 5th to
midnight the 6th, midnight the 6th to midnight the 7th, etc. The data file will
therefore contain a maximum of one days’ data.

Selecting month will cause a new data file to be created on the first day of
every month at midnight. If data logging were started on the January 27th,
the first data file would contain data from the 27th of January to the 1st of
February. Thereafter, data files will contain data from the 1st of February to
the 1st of March, the 1st of March to 1st of April, etc. The data file will
therefore contain a maximum of one months’ data.

Selecting None causes all logged data to be placed in a single data file
name HISTLOG.Hnn, where nn is the two character identifier assigned to
the historic log by the configurator. Logging begins when the Start Trigger is
activated Whenever logging is triggered, data will be appended to the existing
data file. The size of the file is limited only by available disk space. Care
should be taken to not allow a data file to consume all the available disk
space.
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Line Format Dialog Box

The Line Format dialog box is displayed when the Line Format button is selected from the Line Format button
from the Historic Log File Configuration dialog box. This option allows you to customize the line formatting in
historic logs.

Figure 10-4: Line Format Dialog

Delimiter

Choose a delimiter option to separate the data in the log. Choose “Other” to enter a delimiter option that's not
listed.

Check the “Include Space After Delimiter” box to append a space after each delimiter.

Quotes Around Strings

Selecting an option from this drop-down list puts quotes around each string in the log. The types of quotes to
select from are: none, *, *, and “.

Carriage Return Every N Elements

Choose this option to insert a carriage return every N data elements on a line, where N is a number entered in
the elements text box. This option is primarily intended for historic logs with very long data lines which are read
by programs that cannot handle long data lines. The date and time information at the beginning of a data line
are not counted as data elements. The N limit is 99999 elements.
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Historic Log Point Dialog Box

This dialog box is displayed when the Append, Insert, or Modify buttons are selected from the Historic Log
Configuration dialog box. Use this dialog box to select tags whose values are recorded to the historic log file
during runtime.

=-‘ Historic Log Point Configuration

Tag

Name: |

Type: |Cyrano 200

“ oK xﬁancel ? Help

Figure 10-5: Historic Log Point Dialog Box

Select a Cyrano 200 type tag from the tag section of this dialog box to be used as the source of the data. For
detailed information about specific tags, the Tag Selection dialog box may be displayed by clicking the mouse
on the “?” to the right of the “Tag Name" field.

When creating log tables using table variables, the number of elements can be modified in the Tag Selection
dialog box. The maximum number of elements in a log table is 1 million.

Floating Point Resolution Determines the number of digits to the right of the decimal point recorded
for floating point numbers.

Tag Selection Dialog Box

The Tag dialog box is displayed when the ? button is clicked from the Historic Log Point dialog box. The dialog
box lets you select the Cyrano tag you want to work with. The dialog box is divided into 5 sections: Controller,
Item Type, ltem Name List, Selected Fields, and Refresh Time (only for controller driven attributes and triggers).
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Figure 10-6: Tag Dialog Box

Controller

Select the Mistic controller which contains the tag you wish to use. If only one controller is available, it is
automatically selected. Selection of a controller updates the ltemName list box so that it displays a list of the
selectable Cyrano data types available in that controller’s Cyrano strategy.

Item Type

Select the type of data you wish to use. The list contains only those types defined in the selected controller’s
Cyrano strategy. Selection of a specific item type updates the Item Name list box . It then displays a list of all the
tags of that selection type. The Item Type selection also determines the Selected Field options available.

Item Name

This is an alphabetized list of the available Cyrano tags of the type specified in the ItemType list. You can select
the tag of interest from this list.
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Selected Fields

The item type of the selected tag determines which of these fields, if any, need to have contents specified. If an
entry is not needed, then the option is not available.

Field

Bit

Element

Start Index & Num Elements

Refresh Time

Specifies what data associated with the tag is of interest. For example, if
the tag selected is of Item Type PID, then the available fields are Error, Enable,
A/M, Input, Output, Setpoint etc. If the tag Item Type is Digital Multifunction
Input Point, the available field is State. If the tag [tem Type is FLOAT, the
Field list box is disabled.

If the base type is Integer, a particular bit may be selected from the integer.

If the selected ItemType is one of the Table types and only a single element
of the table is desired, then this field can be used to select the index of the
single element of interest.

To select multiple elements from Item Type Table, use the Start Index to
specify the first element and Num Elements to specify how many.

Allows you to select the refresh time group to be used for scanning. All tags
with the same refresh time group are scanned at the same time. A group
with a refresh time of 0 seconds is scanned as fast as possible. Use the drop
down button to select from the list of refresh time groups. The refresh time
parameter is displayed if a controller driven attribute is being edited.
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Historic Log Start/StopTrigger Dialog Box

This dialog box is displayed when the Start Trigger or Stop Trigger button is selected from the Historic Log
Configuration dialog box. It allows you to configure either a start or stop trigger for a historic log.

|

Historic Log Start Trigger Configuration

Tag

Name: |

Type: |Cyrano 200

Setup by Current Yalue Setup by

> +

 Discrete

“ Current Yalue

“DK

xﬁancel ? Help

Figure 10-7: Historic Log Start/Stop Trigger Dialog Box

Name

Setup By

Setup By Discrete

Setup By Current Value
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Select a Cyrano type tag from the tag section of this dialog to be used as the
source of the data. Prior to tag selection, you need to choose the tag base
type as either discrete or value. Discrete types include those tags which can
have only two distinct states (on and off), while value tag types are tags that
can have several values. Use the “?" button to quickly locate and enter
Cyrano tag name from the Tag Selection dialog box.

This control group specifies the tag base type. Selecting either the Discrete
or Current Value radio buttons subsequently causes the Setup By Discrete
or Setup by Value controls to be displayed.

This control group specifies an on or off trigger state for tags which have a
discrete basetype.

This control group defines a comparison value and mathematical operation
to determine the trigger state for tags with a value basetype. The sampled
tag value is compared against this specified trigger value according to the
mathematical operation specified.

Mathematical operations include: =>,<,<=>=.

Triggers are edge sensitive and only activate on a positive transition from a
non-triggered state.
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Historic Log Stop Trigger Notification Dialog Box

This dialog box appears when the Notification button is pressed from the Historic Log Configuration dialog box.
The Notification dialog box lets you define a tag and value that's written to that tag when a Stop Trigger has
occurred. You must select a tag from the tag section of this dialog to use as the destination for the data.

yano 20— [3)

Figure 10-8: Historic Log Stop Trigger Notification Dialog Box

Set/Offset

Select Set if you want the value used as a replacement for the tag's current value. Select Offset if you want the
value added to the tag’s current value.

Value Out

This field defines the floating point or integer value written to the specified tag.
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_— CHAPTER 11

SOUND

OVERVIEW

The MMI provides a Windows sound interface. The sound interface can use standard .WAV and MIDI files to
generate a variety of sounds via a multimedia board. Operator messages and notifications can be prerecorded
and triggered by events in the process.

DIALOG BOXES

The following dialog boxes are used to configure sounds into your MMI project.

Sounds Dialog Box

This dialog box is displayed when Configure— Sounds is selected from the MMI Configurator Configure menu.
It contains a list of names of all the sound events configured for the current MMI project . Up to 1000 sounds
events per project are allowed. Sound files must reside in the MM project directory.

Figure 11-1: Sounds Dialog Box
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A sound file is associated with each sound event and contains data regarding the sound to be played. Both
WAV (digitized sound) and .MID files are supported. Several sound files are included with Microsoft Windows
and others are available from various sources such as CompuServe, specialty CD-ROMs, and public BBS's. The
Windows Media Player utility (MPLAYER.EXE) can be used for sound “browsing” purposes to play WAV and
.MID files over your PC’s installed sound hardware.

Use of the MMI sound capability requires that the PC executing the MMI Runtime have an installed and
properly configured sound card (which supports the desired sound file types) and associated driver.

Sound List

This is a list of the names of all the sound events that are configured for the current MMI project. New sound
events can be added to the list by selecting the Add button. Existing sound events can be modified or deleted
from the list by selecting the Modify or Delete buttons.

Add Button Selecting the Add button causes the Sound Configuration dialog box to be
displayed so new sound events can be added to the project.

If there are no sound events in the project, the Modify and Delete buttons
cannot be selected. If there are sound events configured, selecting one in
the sound list enables the Modify and Delete buttons

Modify Button Selecting the Modify button causes the Sound Configuration dialog box to
be displayed so the parameters associated with the selected sound event
can be changed.

Delete Button Selecting the Delete button displays a dialog box which asks the user to
confirm the selected sound is to be removed from the sound list. Selecting
OK removes the sound event from the list, while selecting Cancel or ESC
exits the delete process without affecting the sound list.
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Sound Configuration Dialog Box

This dialog box is displayed when either the Add or Modify button is selected from the Sounds dialog box.
Using this dialog box, you can configure the name, sound file, and start/stop triggers that define the sound
event. Sound files must reside in the MM project directory.

|

Sound Configuration

Name |

Sound File |

| Browse... I

Start Trigger

| Start Trigger... I

Stop Trigger

“ Play Sound

1 Time(s)

|

| Stop Trigger... I

“DK

xﬁancel ? Help

Name

Figure 11-2: Sound Configuration Dialog Box

Sound File/Browse Button

Start Trigger

Enter a name for the sound event being configured. No two sound events in
a project may have the same name.

Select the Browse button to list sound files found in the project directory.
They're displayed in the Select a Sound File dialog box. In this dialog box,
the List Files of Type field may be used to select WAV files or .MID files.
Once the desired sound file has been selected, its name is placed in the
Sound File field of the Sound Configuration dialog box.

Selecting the Start Trigger button displays the Sound Start Trigger
Configuration dialog box. This dialog box is used to configure the tag and
tag conditions that causes the sound file to begin playing. The tag name
and associated tag condition that comprise the start trigger are displayed in
the edit box.
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Stop Trigger
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There are two different methods to stop a sound file from playing — by
either using 1) a repeat count, or 2) a stop trigger.

1) Select the button next to the “Play Sound ____ Times"” text. The sound
repeats the number of times specified by the value you enter in the editable
field and then stop. This value defaults to one, but you can enter any desired
value.

2) Select the button next to the stop trigger edit box. A stop trigger event is
configured by selecting the Stop Trigger button and filling in the fields in
the Sound Stop Trigger Configuration dialog box. Exiting that dialog box, the
tag name and associated condition which comprise the stop trigger are
displayedin the edit box.
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Sound Start/Stop Trigger Dialog Box

This dialog box is displayed when the Start Trigger or Stop Trigger button is selected from the Sound Configuration

dialog box.

‘

Sound Start Trigger Configuration

Tag

Name: |

Type: |Cyrano 200

Setup by Current Value Setup by

> +

> Discrete

“ Current Yalue

xﬁancel ? Help

Name

Setup By

Setup By Discrete

Setup By Current Value

Figure 11-3: Trigger Dialog Box

Select a Cyrano type tag from the tag section of this dialog box to be used
as the source of the data. Prior to tag selection, you need to choose the tag
base type as either discrete or value. Discrete types include those tags which
can have only two distinct states (on and off), while value tag types are tags
that can have several values. Use the “?” button to quickly locate and enter
Cyrano tag name from the Tag Selection dialog box.

This control group specifies the tag base type. Selecting either the Discrete
or Current Value radio buttons subsequently causes the Setup By Discrete
or Setup by Value controls to be displayed.

This control group specifies an on or off trigger state for tags which have a
discrete basetype.

This control group defines a comparison value and mathematical operation
to determine the trigger state for tags with a value basetype. The sampled
tag value is compared against this specified trigger value according to the
mathematical operation specified.

Mathematical operations include: =><,<=>=

Triggers are edge sensitive and only activate on a positive transition from a
non-triggered state.
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Tag Selection Dialog Box

The Tag dialog box is displayed when the ? button is clicked from the Sound Start/Stop Trigger Configuration
dialog box. The dialog box lets you select the Cyrano tag you want to work with. The dialog box is divided into
5 sections: Controller, ltem Type, ltem Name List, Selected Fields, and Refresh Time (only for controller driven
attributes and triggers).

Figure 11-4: Tag Dialog Box

Controller

Select the Mistic controller which contains the tag you wish to use. If only one controller is available, it is
automatically selected. Selection of a controller updates the ltemName list box so that it displays a list of the
selectable Cyrano data types available in that controller’s Cyrano strategy.

Item Type

Select the type of data you wish to use. The list contains only those types defined in the selected controller’s
Cyrano strategy. Selection of a specific item type updates the [tem Name list box . It then displays a list of all the
tags of that selection type. The Item Type selection also determines the Selected Field options available.

Item Name

This is an alphabetized list of the available Cyrano tags of the type specified in the ItemType list. You can select
the tag of interest from this list.
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Selected Fields

The base type of the selected item determines which of these fields, if any, need to have contents specified. If
an entry is not needed, then the cursor for the dialog box is prevented from entering that dialog box control.

Field

Bit

Element

Start Index & Num Elements

Refresh Time

Specifies what data associated with the tag is of interest. For example, if
the tag selected is of Item Type PID, then the available fields are Error, Enable,
A/M, Input, Output, Setpoint etc. If the tag Item Type is Digital Multifunction
Input Point, the available field is State. If the tag [tem Type is FLOAT, the
Field list box is disabled.

If the base type is Integer, a particular bit may be selected from the integer.

If the selected ItemType is one of the Table types and only a single element
of the table is desired, then this field can be used to select the index of the
single element of interest.

To select multiple elements from Item Type Table, use the Start Index to
specify the first element and Num Elements to specify how many.

Allows you to select the refresh time group to be used for scanning. All tags
with the same refresh time group are scanned at the same time. A group
with a refresh time of 0 seconds is scanned as fast as possible. Use the drop
down button to select from the list of refresh time groups. The refresh time
parameter is displayed if a controller driven attribute is being edited.
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g | CHAPTER 12

DRAW WINDOW STATE

OVERVIEW

The draw window state configures the appearance of your application by controlling which windows are displayed
at what times. Windows may be triggered by events in the controller, such as alarms, and job completion.
Changes in a draw window's visual state can act as alarms to force immediate operator attention when a
trigger occurs.

The dialog boxes presented in this chapter may be used to configure window managers and a window’s visual
state. A window manager is a draw window combined with a trigger allowing dynamic control of the draw
window visual state.

DIALOG BOXES

Use the following dialog boxes to configure the windows of your project.

Window Managers Dialog Box

This dialog box is displayed when Configure— Window State is selected from the MMI Configurator Configure
menu. It contains a list of the names of all the window managers that have been configured for the current MMI
project. Up to 1000 window managers per project are allowed.

=-| Window Managers

Name Add._

Bgpedify

Drelate

“ oK xﬁancel ? Help

Figure 12-1: Window Managers Dialog Box
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Name

This is a list of the names of all the window managers configured for the current MM project. New window
managers can be added to the list by selecting the Add button. If there are window manager events configured,
selecting one in the window manager list enables the Modify and Delete buttons. If there are no window
manager events in the project, the Modify and Delete buttons cannot be selected.

Add Button Select the Add button to display the Window Manager Configuration dialog
box and add new window managers to the project.

Modify Button Selecting the Modify button causes the Window Manager Configuration
dialog box to be displayed so the parameters associated with the selected
window manager can be changed.

Delete Button Selecting the Delete button displays a dialog box asking the user to confirm
the selected window manager is to be removed from the window manager
list. Selecting OK removes the window manager from the list while selecting
Cancel oresc exits the delete process without affecting the window manager
list.
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Window Manager Configuration Dialog Box

This dialog box is displayed when either the Add or Modify button is selected from the Window Manager List
dialog box. The Window Manager Configuration dialog box is used to create or modify a window manager
within the project. A window manager is a draw window combined with a trigger allowing dynamic control of
the draw window visual state. Changes in a draw window’s visual state can act as alarms to force immediate
operator attention when a trigger occurs.

=-‘ Window Manager Configuration

Title |Exﬁmp|e Window Manager

Window Management Configuration

| Pop Window...

Trigger

| | ‘ Trigger... I

“ Ok annceI ? Help

Figure 12-2: Window Manager Configuration Dialog Box

Title This edit box enables you to specify a name for the window manager being
configured. The name must be unique from all window managers within the
project or an error message is displayed if OK is selected to exit the dialog
box.

Pop Window Selecting this button displays the Pop Window dialog box. You can enter
information about the draw window(s) that are affected by the Trigger.

Trigger Selecting the Trigger button displays the Trigger dialog box. Define a tag
and its associated condition that comprises the trigger for the window
manager. The trigger is edge sensitive and only activates from a non-triggered
state. The tag and its associated condition are displayed in the edit box.

Mistic MMI User's Guide 12-3



DRAW WINDOW STATE

Pop Window Dialog Box

The Pop Window dialog box is displayed when the Pop Window button is pressed from the Window Manager
Configuration dialog box. Use is to configure visual states (open, iconified, closed) for a project’s draw windows
after an event has occurred. The following description of this dialog box refers to a generic event. The particular
event being configured is determined by the menu selection or dialog box selection that caused this dialog box

to appear.
=-| Pop Window
Windows Action | Affected Windows
FLUSH Open  CLIP New Action
MAIN R
PUMP 1 £
PUMP 2 __Open_|
SET POINTS Agrrsszeed -
Default
> Close
> Iconify
|Remuve Selected || Remove All I | Deselect All I
All Others:
If Open: If Closed: If Iconified:
# No Change % No Change # No Change
> Iconity ~ Open ~ Open
> Close > Iconify > Close
/ oK xﬁancel ? Help

To specify anew visual state, first use the Windows list box to select the draw windows that are affected by the
event. Click the Insert or Append button to remove them from the Windows list box and add them to the
Affected Windows list. The desired action can be specified for each. Finally, actions can be specified for all
draw windows that have not been added to the Affected Windows list. The following sections describe how to

perform these actions.

Windows

The Windows list is a multiple selection list box used to select the draw windows to be affected by the event.
Selections from this list box can be added to the Affected Windows list box using the Insert or Append buttons.
The new visual state of the selected draw windows is initially specified by the Default radio button group. The
new state can be changed after the entry is in the Affected Windows list. See that section for details. Each time
entries are added to the Affected Windows list, they are removed from the Windows list and are left in the

Figure 12-3: Pop Window Dialog Box

selected state in the Affected Windows list and any that were previously selected are deselected.
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The order of the draw windows in the Affected Windows list is important when any of the draw windows to be
opened overlap other draw windows to be opened. If such an overlap exists, those that are nearer the top of the
list will obscure those lower in the list. Proper draw window ordering can be obtained using the Insert and
Append buttons.

Append This button adds the selected draw windows at the bottom of the Affected
Windows list.
Insert The Insert button places the selected Windows names before the selected

window name in the Affected list. Only one entry may be selected in the
Affected Windows list for this button to be enabled.

Affected Windows List

The Affected Windows list is a multiple selection list box. Each entry has two parts: the name of the draw
window and the action to be performed when the event takes place. Entries are added to the list by the
methods described in the Window List section.

There are several buttons that perform operations on entries selected in the list.
Open, Close, and Iconify These buttons define the window state for the entries selected.

Remove Selected This button removes the selected entries from the list and returns them to
the Windows list.

Remove All This button removes all entries from the list and returns them to the Windows
list.
Deselect All This button deselects all entries in the list. The entries remain in the list but

they are set to the deselected state.

All Others

You may want to configure new visual states for all draw windows not included in the Affected Windows list
when the event occurs. The If Open, If Closed, If Iconified groups have radio buttons for this purpose. The radio
buttons provide a No Change option, and the other two possible window states for a particular group. The radio
button selected in each group determines the new visual state for all the draw windows currently in that
group’s state when the event occurs. For example, if the Close radio button is selected in the If Open grouping,
then all open draw windows not listed in the Affected Windows list are closed when the event occurs. The No
Change radio button means that there should be no change for draw windows referred to by that grouping. This
button is the default for each group.
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Window Manager Start Trigger Configuration Dialog Box

This dialog box is displayed when the Trigger button is selected from the Window Manager Configuration

dialog box.

|

Window Manager Start Trigger Configuration

Tag

Name: |0PTO DEMO BOX:SUPLY_VALVYE_LED. State

Type: |Cyrano 200

Setup by Discrete

“ On
> Off

Setup by
“ Discrete

> Current Value

“DK

xﬁancel ? Help

Figure 12-4: Window Manager Start Trigger Configuration

Name

Setup By

Setup By Discrete

Setup By Current Value
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Select a Cyrano type tag from the tag section of this dialog to be used as the
source of the data. Prior to tag selection, you need to choose the tag base
type as either discrete or value. Discrete types include those tags which can
have only two distinct states (on and off), while value tag types are tags that
can have several values. Use the “?” button to quickly locate and enter
Cyrano tag name from the Tag Selection dialog box.

This control group specifies the tag base type. Selecting either the Discrete
or Current Value radio buttons subsequently causes the Setup By Discrete
or Setup by Value controls to be displayed.

This control group specifies an on or off trigger state for tags which have a
discrete basetype.

This control group defines a comparison value and mathematical operation
to determine the trigger state for tags with a value basetype. The sampled
tag value is compared against this specified trigger value according to the
mathematical operation specified.

Mathematical operations include: =><,<=>=

Triggers are edge sensitive and only activate on a positive transition from a
non-triggered state.
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Tag Selection Dialog Box

The Tag dialog box is displayed when the ? button is clicked from the Window Manager Start Trigger Configuration
dialog box. The dialog box lets you select the Cyrano tag you want to work with. The dialog box is divided into
5 sections: Controller, Item Type, Item Name List, Selected Fields, and Refresh Time (only for controller driven
attributes and triggers).

= Tag Selection

Controller Item Type

alarm test Analog Input Point +
Analog Multifunction 170 Unit

Analog Output Point

Controller

Counter
Digital Multifunction 1/0 Unit
Digital Multifunction Input Point +
Item Hame Selected Fields
INTERRUPT .
POWERUP Field | B

Element I:l Bit (0-31] |:|
Start Index I:l Mum Elements |:|

‘Heflesh Time |Emup 01 sec, 250 ms) |EI

¢ 0K xl:ancel ? Heln

Figure 12-5: Tag Dialog Box

Controller

Select the Mistic controller which contains the tag you wish to use. If only one controller is available, it is
automatically selected. Selection of a controller updates the [temName list box so that it displays a list of the
selectable Cyrano data types available in that controller’s Cyrano strategy.

Item Type

Select the type of data you wish to use. The list contains only those types defined in the selected controller's
Cyrano strategy. Selection of a specific item type updates the ltem Name list box . It then displays a list of all the
tags of that selection type. The Item Type selection also determines the Selected Field options available.

Item Name

This is an alphabetized list of the available Cyrano tags of the type specified in the ItemType list. You can select
the tag of interest from this list.
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Selected Fields

The base type of the selected item determines which of these fields, if any, need to have contents specified. If
an entry is not needed, then the cursor for the dialog box is prevented from entering that dialog box control.

Field

Bit

Element

Start Index & Num Elements

Refresh Time
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Specifies what data associated with the tag is of interest. For example, if
the tag selected is of Item Type PID, then the available fields are Error, Enable,
A/M, Input, Output, Setpoint etc. If the tag Item Type is Digital Multifunction
Input Point, the available field is State. If the tag [tem Type is FLOAT, the
Field list box is disabled.

If the base type is Integer, a particular bit may be selected from the integer.

If the selected ItemType is one of the Table types and only a single element
of the table is desired, then this field can be used to select the index of the
single element of interest.

To select multiple elements from Item Type Table, use the Start Index to
specify the first element and Num Elements to specify how many.

Allows you to select the refresh time group to be used for scanning. All tags
with the same refresh time group are scanned at the same time. A group
with a refresh time of 0 seconds is scanned as fast as possible. Use the drop
down button to select from the list of refresh time groups. The refresh time
parameter is displayed if a controller driven attribute is being edited.



CHAPTER 13

LAUNCHING APPLICATIONS

OVERVIEW

The MM is capable of starting other applications. This is known as “launching an application”. Applications
can be launched in two ways. The first uses the Launch Application Output Dynamic Attribute. The second
method is to configure an Application Manager. The MMI maintains a list of Application Managers.

A trigger or graphic may be configured to launch an application. Every time the trigger or graphic is toggled, a
new session of the application is created, unless the application only allows one session, or you've selected
the option to limit it to one session for that particular graphic or trigger. For example, suppose a graphic launches
the Windows Calculator program. If the Calculator program is not closed when a user is done with it, they might
just click on the graphic again. This could lead to many sessions of the calculator program running all at once.
The “single instance” option for the Dynamic Attribute Launch Application eliminates this problem.

The “single instance” option forces the Runtime to check if this trigger or graphic has already launched an
application. If this trigger or graphic’s already launched an application, that application becomes the active
session. If the trigger or graphic does not have a launched application, the Runtime launches it and tracks it
until it's closed.

You can also choose the initial appearance of a launched application. Applications may be launched normally,
or with its main window maximized or minimized.
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DIALOG BOXES

Use the following dialog boxes to configure the launching of applications from the Mistic MMI.

Application Managers Dialog Box

This dialog box is displayed when the Configure—> Applications menu option is selected from the MM
Configurator. It contains a list of the names of all the application managers that have been configured for the
current MMI project. Up to 1000 application managers are allowed per project.

=) Application Managers

Name ‘ Add._ I

‘ brpelify I

‘ Pelate I

V 0K xCancel ? Help

Figure 13-1: Application Managers Dialog Box

Application Managers List

Thisis alist of the names of all the application managers configured for the current MM project. New application
managers can be added to the list by selecting the Add button. Existing application managers can be modified
or deleted from the list by selecting the Modify or Delete buttons.

Add Selecting the Add button displays the Application Manager Configuration
dialog box. New application managers can be added to the project with this
dialog box.

Modify Button Selecting the Modify button displays the Application Manager Configuration

dialog box. Parameters associated with the selected application manager
can be changed with this dialog box.

Delete Button Selecting the Delete button displays a dialog asking the user to confirm if
the selected application manager should be removed from the application
manager list. Choose OK to remove the application manager from the list.
Choose Cancel or ESC to exit the delete process without affecting the
application manager list.
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Application Manager Dialog Box

This dialog box is displayed when either the Add or Modify button is selected from the Application Manager
List dialog box. Use it to create or modify an application manager for the project. With this dialog box, you can
configure the name, command line parameters, working directory, and start trigger that define the application
manager.

=-| Application Manager
Name |Examp|e Application Managerl |
Working Directory | | Browse... I
Command Line | | Browse... I
Append Mistic String | | ? I x I
Launch Options Show Options
4 Multiple Instances L .
# Normal > Minimized » Maximized
 Single Instance
Trigger
| Trigger... I

_ | Hotfionton Faablad

/ oK xﬁancel ? Help

Figure 13-2: Application Manager Dialog Box

Name Enter a name for the application manager being configured. No two
application managers may have the same name in a project.

Working Directory/Browse Button
Use this option to select the working directory to use when the specified
application is launched. The working directory is an optional parameter. If a
working directory is not specified, the current MMI Runtime directory is
used. Clicking the Browse button displays a dialog titled Working Directory
Selection. When you exit this dialog box, the selected path is displayed in
the edit box.

Command Line/Browse Button
Use this option to choose a program file to execute when the trigger condition
occurs. Clicking the Browse button displays the Application Manager
Executable File Selection dialog box. When you exit this dialog box, the
selected path is displayed in the edit box. The Command Line can be modified
at any time.
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Append Mistic String/Browse/Clear Button

Trigger

Notification Button

This optional feature allows a string from a Mistic controller tag to be
appended to the Command Line string. The string is appended to the
command line string before the application is launched. A possible use for
this option is to save command line options for an application in the controller.
Only tag names may be entered. Literal strings are not accepted. If the
appended string is a parameter, a space must be included in the Command
Line string to separate it from the main command line.

Selecting the “?" button displays the Tag Selection dialog box to choose a
string variable from the controller strategy. Pressing the “X" button clears
the tag name entered.

Choose the Trigger button to define a tag and its trigger condition. The
Application Manager Trigger Selection dialog box is displayed. The trigger
is edge sensitive and only activates from a non-triggered state. The tag and
its associated condition are displayed in the edit box.

Choose this button to display the Launch Application Trigger Notification
dialog box. This option lets you select a tag and write a value to it when an
application is successfully launched.

Notification Enabled Check Box

13-4 Mistic MMI User’s Guide

This checkbox allows enabling and disabling of the “Notification” option
once it's configured. The “Notification Enabled” box remains disabled
until the notification is configured. A check mark in the box indicates the
notification is enabled.
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Launch Options

Show Options

Applications can be launched so that a new session is created each time, or
so that only one session is running at a time for a single graphic.

Multiple Instances This option launches a new session of an application
each time the operator selects the graphic. Some applications only allow
one session of an application to run, while others allow multiple sessions.

Single Instance This option forces the Runtime to check if this graphic
has already launched an active session of this application. If the application
is running, it becomes the active application. If the application is not running,
the Runtime launches it, and keeps track of when it is closed.

The single instance option does not limit the number of active sessions of
an application that is launched by other graphics and triggers. The single
instance option only applies to each graphic or trigger and makes sure each
only has one session launched from it. Therefore, it is possible to have multiple
active sessions of an application, even when this option is used.

The show options control the initial appearance of the application when it is launched.

Normal
Minimized

Maximize

This option displays the application window in a normal view.
The application is displayed as an icon when it is launched.

The application is displayed as an enlarged window when it is launched.
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Application Manager Trigger Selection Dialog Box

This dialog box is displayed when the Trigger button is selected from the Application Manager Configuration
dialog box. Use it to configure either a start or stop trigger for dynamic objects such as window managers,
historic logs, application managers, or sounds.

|

Application Manager Trigger Selection

Tag

Name: |

Type: |Cyrano 200

Setup by Current Value Setup by

 Discrete
> +

“ Current Value

“DK

xﬁancel ? Help

Figure 13-3: Application Manager Trigger Selection Dialog Box

Name

Setup By

Setup By Discrete

Setup By Current Value
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Select a Cyrano type tag from the tag section of this dialog box to be used
as the source of the data. Prior to tag selection, you need to choose the tag
base type as either discrete or value. Discrete types include those tags which
can have only two distinct states (on and off), while value tag types are tags
that can have several values. Use the “?” button to quickly locate and enter
Cyrano tag name from the Tag Selection dialog box.

This control group specifies the tag base type. Selecting either the Discrete
or Current Value radio buttons subsequently causes the Setup By Discrete
or Setup by Value controls to be displayed.

This control group specifies an on or off trigger state for tags which have a
discrete basetype.

This control group defines a comparison value and mathematical operation
to determine the trigger state for tags with a value basetype. The sampled
tag value is compared against this specified trigger value according to the
mathematical operation specified.

Mathematical operations include: =>,<,<=>=.

Triggers are edge sensitive and only activate on a positive transition from a
non-triggered state.
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Tag Selection Dialog Box

The Tag dialog box is displayed when the ? button is clicked from the Application Manager or the Application
Manager Trigger Selection dialog box. The dialog box lets you select the Cyrano tag you want to work with. The
dialog box is divided into 5 sections: Controller, Item Type, ltem Name List, Selected Fields, and Refresh Time
(only for controller driven attributes and triggers).

~=-‘ Tag Selection

Controller lem Type

OPTO DEMO BOX Analog Input Point

Analog Multifunction 170 Unit
Analog Output Point f—
Chart

[+

Controller

Digital Multifunction |/O Unit
Digital Multifunction Output Point
Float +

em Name Selected Fields

Field | [:]
Element I:I Bit (0-31) I:I
Start Index l:l Num Elements I:I

/-

Figure 13-4: Tag Dialog Box

Controller

Select the Mistic controller which contains the tag you wish to use. If only one controller is available, it is
automatically selected. Selection of a controller updates the [temName list box so that it displays a list of the
selectable Cyrano data types available in that controller’s Cyrano strategy.

Item Type

Select the type of data you wish to use. The list contains only those types defined in the selected controller’s
Cyrano strategy. Selection of a specific item type updates the ltem Name list box . It then displays a list of all the
tags of that selection type. The Item Type selection also determines the Selected Field options available.

Item Name

This is an alphabetized list of the available Cyrano tags of the type specified in the ItemType list. You can select
the tag of interest from this list.
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Selected Fields

The base type of the selected item determines which of these fields, if any, need to have contents specified. If
an entry is not needed, then the cursor for the dialog box is prevented from entering that dialog box control.

Field

Bit

Element

Start Index & Num Elements

Refresh Time
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Specifies what data associated with the tag is of interest. For example, if
the tag selected is of Item Type PID, then the available fields are Error, Enable,
A/M, Input, Output, Setpoint etc. If the tag Item Type is Digital Multifunction
Input Point, the available field is State. If the tag [tem Type is FLOAT, the
Field list box is disabled.

If the base type is Integer, a particular bit may be selected from the integer.

If the selected ItemType is one of the Table types and only a single element
of the table is desired, then this field can be used to select the index of the
single element of interest.

To select multiple elements from Item Type Table, use the Start Index to
specify the first element and Num Elements to specify how many.the first
element and Num Elements is used to specify how many.

Allows you to select the refresh time group to be used for scanning. All tags
with the same refresh time group are scanned at the same time. A group
with a refresh time of 0 seconds is scanned as fast as possible. Use the drop
down button to select from the list of refresh time groups. The refresh time
parameter is displayed if a controller driven attribute is being edited.
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Launch Application Trigger Notification Dialog Box

This dialog box appears when the Notification button is pressed from the Application Manager dialog box. The
Notification dialog box lets you define a tag and value that’s written to that tag when a Stop Trigger has
occurred. You must select a tag from the tag section of this dialog box to use as the destination for the data.

Figure 13-5: Launch Application Trigger Notification Dialog Box

Set/Offset

Select Set if you want the value used as a replacement for the tag's current value. Select Offset if you want the
value added to the tag’s current value.

Value Out

This field defines the floating point or integer value written to the specified tag.
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g | CHAPTER 14

RUNTIME SETUP

OVERVIEW

This Runtime Setup chapter addresses the configuration of the initial appearance of the MM Runtime when it
begins execution. You can specify which Draw Windows you want open or closed, if you want the menu
displayed, and whether you want to prevent the user from exiting the program. Customize the appearance of
the main window and choose options to modify the on-screen keyboards for the Send String and Send Value
dialog boxes. Also customize the Event Log. The Event Log displays messages about the MMI status and its
transactions.

This chapter begins with a discussion on preventing user exit. You will find this useful when you're working
with the Runtime Setup dialog box. The chapter then goes into the details of the dialog boxes used to configure
the Runtime settings.

PREVENTING USER EXIT

In some situations, it may be desirable to configure the runtime environment so the user is prevented from
exiting the MMI Runtime program and switching to other Windows programs.

Preventing Exit

The Configure—>Run Time command in the MMl Configurator is used to prevent user exit from the MMI Runtime.
Once the MMI Runtime begins executing a project configured this way, the user is prevented from switching to
a different project or from exiting the program.

Preventing Switching

It is possible to configure Windows in a way that prevents the user from switching to an application other than
the MMI Runtime. This is accomplished by making the MMI Runtime program the shell program for Windows.

The file SYSTEM.INI contains a line which begins “SHELL=". This line identifies the program that Windows will
use as its shell when it begins execution. Usually the Program Manager is used as the shell and the line in
SYSTEM.INI reads “SHELL=PROGMAN.EXE". If this entry is changed so that Windows thinks the MMI Runtime
is the shell, Windows will start MMI Runtime when the user starts Windows from the DOS prompt. For example,
if the MMI Runtime program, MMIRT.EXE, is located in the directory C:AMMI then change the entry to
“SHELL=CA\MMNMMIRTEXE".
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Exiting Windows

If the MMI Runtime is running a project which prevents user exit and Windows is running the MM Runtime as
its shell, the only way to exit Windows is by using the cTrL-AT-DEL key combination. The MM software includes
a Utility Diskette which contains a Windows executable file NOCAD.EXE (for NOControlAltDelete) and a Windows
virtual device driver NOCAD.386 which can be used to disable and enable the cTrL-AT-DEL key functionality. The

diskette contains a file NOCAD.TXT which provides the necessary details.

DIALOG BOXES

The following dialog boxes are used to configure the Runtime appearance at startup.

Runtime Setup Dialog Box

Use this dialog box to configure various conditions at the time MM Runtime begins execution.
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Runtime Setup

Runtime Draw Window Initial State:

Define Default...

Security Options: Ewvent Log Options

> Lise Mast Racent

_| Prevent User Exit _| Prevent Disabling

_| Hide Menu Bar Permanently +| Start Enabled

Main Window Style Options:

_| Always Maximized v| System Menu
¥| Minimize Button v| Maximize Button

_| Use Custom Caption v| Title Bar

Custom Caption: |Sample Custom String

Keyboard Setup

_| Use On-Screen Keyboard for Touch Screens

| incheds fneent ABOH in Soses-Kavboard

V oK xCancel ? Help

Figure 14-1: Runtime Setup Dialog Box
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Runtime Draw Window Initial State

The initial state refers to the position, visual state, and visibility of the project’s draw windows at the time they
are initially displayed, after the project is loaded. Visibility refers to whether a draw window is obscured by

another draw window.
Use Default
Use Most Recent

Define Default

Prevent User Exit

Hide Menu Bar Permanently

Check this option to specify the visual state and visibility of the windows.
The Use Most Recent feature is not implemented in version 3.0.

If Use Default is checked, you must select Define Default to display the
Pop Window dialog box. Use it to define the desired visual states and visibility.

Security Options

Check this to prevent the user from changing the project currently open in
the MMI Runtime or from exiting the MMI Runtime.

If you want to prevent a user from switching to another Windows application,
refer to the Preventing User Exit in an upcoming section.

Check this to prevent display of the menu bar in the MM Runtime. This
feature provides a way to prevent the MMI Runtime user from accessing
the MMI Runtime menus. Theesc key does not activate the menu bar. Access
to selected menu items and graphics such as text and buttons can be
configured with Touch—Execute Menu ltem output dynamic attribute
graphics.

When the menu bar is not visible due to this feature, pressing the F1 function
key does not invoke the MMI Runtime online help system. To offer access to
the online help system, configure a graphic with a Touch—FExecute Menu
[tem and specify the Help menu item.
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Event Log Options

Prevent Disabling Choose this option to prevent a user from disabling the Event Log during
Runtime.
Start Enabled Choose this option to enable the Event Log at startup.

Main Window Style Options:

Use these options to customize the MMI Runtime application window.

Always Maximized Check this box to always maximize the Runtime window.

Minimize Button Check this box to include a minimize button in the Runtime window.

Use Custom Caption Check this box to use the caption specified in the Custom Caption text box.

Custom Caption Used to enter a customized caption. This caption is used if the Use Custom
Caption check box was selected. Up to 80 characters may be entered.

System Menu Check this box to include the standard Windows System Menu.

Maximize Button Check this box to include a maximize button in the MMI Runtime window.

Title Bar Check this box to include a title bar in the Runtime window.
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Keyboard Setup

Use these options to change the typical keyboard setup.

Use On—Screen Keyboard for Touch Screens

Check this option to enable the use of an on-screen keyboard with the Send
String and Send Value Dynamic Attributes. Use this option when the MMI
Runtime is running on a computer without a physical keyboard and a
touchscreen. Selecting this option affects all Send String and Send Value
Dynamic Attributes in a project.

Include ‘Insert ASCII’ in Screen-Keyboard

Pop Window Dialog Box

Select this option to include the ‘Insert ASCII parameter in the On-Screen
Send String dialog box. The ‘Insert ASCII' feature allows a user to enter any
character value between 0-255. This option is only available for the Send
String Dynamic Attribute. The Use On—-Screen Keyboard for Touch Screens
option must be checked in order for this option to be available.

The Pop Window dialog box is displayed when the Define Default button is pressed from the Runtime Setup
dialog box. Use is to configure visual states (open, iconified, closed) for a project’s draw windows after an
event has occurred. The following description of this dialog box refers to a generic event. The particular event
being configured is determined by the menu selection or dialog box selection that caused this dialog box to

appear.
=-| Pop Window
Windows Action  |Affected Windows
FLUSH Open_ CLIP New Action
M
PUMP 1 A
PUMP 2 |_open |
SET POINTS Agipangd >
Default
+ Open
> Close
> lconity
|Remnve Selected || Remove All I | Deselect All I
All Others:
If Open: If Closed: If Iconified:
# No Change % No Change “+ No Change
> lconify > Open > Open
> Close > lconify > Close

VDK

Figure 14-2: Pop Window Dialog Box
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To specify anew visual state, first use the Windows list box to select the draw windows that are affected by the
event. Click the Insert or Append button to remove them from the Windows list box and add them to the
Affected Windows list. The desired action can be specified for each. Finally, actions can be specified for all
draw windows that have not been added to the Affected Windows list. The following sections describe how to
perform these actions.

Windows

The Windows list is a multiple selection list box used to select the draw windows to be affected by the event.
Selections from this list box can be added to the Affected Windows list box using the Insert or Append buttons.
The new visual state of the selected draw windows is initially specified by the Default radio button group. The
new state can be changed after the entry is in the Affected Windows list. See that section for details. Each time
entries are added to the Affected Windows list, they are removed from the Windows list and are left in the
selected state in the Affected Windows list and any that were previously selected are deselected.

The order of the draw windows in the Affected Windows list is important when any of the draw windows to be
opened overlap other draw windows to be opened. If such an overlap exists, those that are nearer the top of the
list will obscure those lower in the list. Proper draw window ordering can be obtained using the Insert and
Append buttons.

Append This button adds the selected draw windows at the bottom of the Affected
Windows list.
Insert The Insert button places the selected Windows names before the selected

window name in the Affected list. Only one entry may be selected in the
Affected Windows list for this button to be enabled.
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Affected Windows List

The Affected Windows list is a multiple selection list box. Each entry has two parts: the name of the draw
window and the action to be performed when the event takes place. Entries are added to the list by the
methods described in the Window List section.

There are several buttons that perform operations on entries selected in the list.
Open, Close, and Iconify These buttons define the window state for the entries selected.

Remove Selected This button removes the selected entries from the list and returns them to
the Windows list.

Remove All This button removes all entries from the list and returns them to the Windows
list.
Deselect All This button deselects all entries in the list. The entries remain in the list but

they are set to the deselected state.

All Others

You may want to configure new visual states for all draw windows not included in the Affected Windows list
when the event occurs. The If Open, If Closed, If Iconified groups have radio buttons for this purpose. The radio
buttons provide a No Change option, and the other two possible window states for a particular group. The radio
button selected in each group determines the new visual state for all the draw windows currently in that
group’s state when the event accurs. For example, if the Close radio button is selected in the If Open grouping,
then all open draw windows not listed in the Affected Windows list are closed when the event occurs. The No
Change radio button means that there should be no change for draw windows referred to by that grouping. This
button is the default for each group.
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Event Log Configuration Dialog Box

This dialog box is displayed when Configure=>Event Log is selected from the MMI Configurator menu. It allows
you to specify the attributes of the event log file and to enable or disable the writing of the file. Only one Event
Log can be configured for the project.

Event Log Configuration

Log File Setup:

File Setup.... v| Enabled
e L

vEIK

xﬂancel ? Help

Figure 14-3: Event Log Configuration Dialog Box

File Setup

Enabled Check Box
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Selecting the File Setup button displays the Event Log Configuration dialog
box. Use this dialog box to specify file parameters such as rollover period,
the amount of data to buffer in memory, and the filename and directory
location of the Event Log.

As events are received, a time stamp is recorded and the two are buffered
in the host's memory until they reach the buffer size limit configured in the
Event Log File Configuration dialog box. Once the limit is reached, the buffer
contents are written to the event log file.

If the rollover is None, the filename is EVENTLOG.MSG.

File names are dependent on the rollover period specified in the Event Log
File Configuration dialog box and follow the format:

where YY = year, mm = month, dd = day, and hh = hour.

If the rollover period is None, then the filename is EVENTLOG.MSG. File
name extensions are .MSG. The number of files retained on disk for the
message log is also set in the Event Log File Configuration dialog box. Once
this limit is reached during Runtime, the file with the oldest DOS time stamp
is deleted.

If the Enabled check box is checked, then an event log file will be written to
disk.
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Event Log File Configuration Dialog Box

The Event Log File Configuration dialog box allows you to configure the format in which data files are stored to
disk. Files are stored in standard ASCII delimited format. The size, number of files, and line formats are user
configurable. This dialog box is used in conjunction with other dialogs that need to configure file formats.

Figure 14-4: Event Log File Configuration Dialog Box

Name Use this edit box to enter the directory path and filename for a data file. This
parameter is initially blank and can be directly edited or changed with the
Browse button.

Browse A path for the data file may be specified by using the Browse button.

Use Project Directory Choosing this option specifies the file be put into the MMI project directory.

Automatic Select this option to automatically specify the filename selected in the
Directory Path group.
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Fixed

From Mistic String:
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Use this option to specify a file name for the data file. The filename can be
any valid, 8 character DOS file name and does not require a 3 character
extension. A directory path name must be specified either explicitly in this
field, or by having selected the Use Project Directory option. If the Name
option was selected, its corresponding edit box must have a file name.

A Start Trigger option must be configured and enabled for this file name
source. When the trigger starts a historic log, the new data is appended if
the file already exists, and is created if it does not.

Rollover does not apply to this type of file.

This option lets you specify a string tagname from a Cyrano control strategy
and use it to define the file name source. The tagname is specified in the
MisticString edit box with the “?” button. The tag selected must be a string

type.

A Start Trigger option must be configured and enabled. \When the trigger
occurs, the MisticString tag is concatenated to the Directory Path Name.
The Directory Path Name may be an empty string. If this is the case, the
tagname must contain the complete path name, including the drive designator
(such as c:). This option lets a historic log produce different file names each
time a trigger occurs. If a file already exists, the new data is appended to it.
If it does not exist, the file is created.

The Default Name is used to specify a file name in case the Mistic string
concatenation does not create a valid file name. The filename can be any
valid, 8 character DOS file name. Do not include a 3 character extension. If
the default file name is used, the extension is an “H" followed by the historic
log's ID number (Example: .HOO if the ID were 00).

In case the tagname entered in MisticString is empty, then the Project
Directory is concatenated with the default file name to create the path and
file name.



RUNTIME SETUP

Line Format

If the result of the concatenation is a directory or file that can't be accessed
or created, the logging file is created using the following rules:

e |f the MisticString is empty, then the Project Directory is
concatenated with the “Default Name if Mistic String Invalid“and the
extension is an “H” followed by the historic log ID number.

e |fthe MisticString is not empty and the Project Directory was not specified
as the directory path, then the Directory Path Name is concatenated with
the “Default Name if Mistic String Invalid”.

e |f the Project Directory was specified as the path, or the previous step
failed, the Project Directory is concatenated with the “Default Name if
Mistic String Invalid” and the extension is an “H" followed by the historic
log ID number. If the project directory is read-only or there is not enough
room left on the drive containing the project directory, an error is posted
indicating the file could not be created.

e Rollover does not apply to this type of file.

The Line Format button displays the Line Format dialog box and allows you to customize the line formatting in

historic and event logs.

Lines Buffered

Keep File Open

Number of Files to Retain

Lines buffered configures the number of data lines (samples) which are
buffered in system memory before the data is written to disk. Valid entries
are any number between 0and 999. A small “Lines Buffered” value combined
with fast sample rates may result in excessive disk access. A large “Lines
Buffered” value may result in loss of data in the event of power loss or
system failure.

When data samples are recorded to disk, the data file is opened, data is
written to disk, and the data file is closed. This allows maximum data integrity
but slows disk access since each disk access requires an open, write, and
close sequence. This option allows the MMI to keep the current data file
open for writes, increasing disk performance. Should the system loose power
or fail, however, the current data file may be damaged or lost.

This edit box contains the number of files that will be stored on the disk
before the oldest file is deleted. If Rollover is set to Hours and the Number
of Files to Retain is set at 30, only the last 30 hours' data would be stored on
disk. Any files older than 30 hours would be deleted.
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Rollover

Rollover Settings
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The Rollover edit box allows you to select a rollover period which determines
how often a new data file is created. You may select Hours, Days, Month, or
None from the drop-down list box. See Rollover Settings for more details.

The Rollover drop-down list allows the user to select how often a new data
file is created. The user may select Hours, Days, Month, or None from the
drop-down list box. For time based rollovers, the DOS time and date functions
are used in determining time-of-day and day-of-month. Be sure the system
time and date are set prior to starting the MMI.

Selecting hours will cause a new data file to be created at the top of every
hour. If data logging were trigged at 8:30am, the first data file would contain
data from 8:30am to 9:00am. Thereafter, data files will contain data from
9:00am to 10:00am, 10:00am to 11:00am, etc. The data files will therefore
contain a maximum of one hours’ data depending on when logging is
triggered.

Selecting days will cause the current data file to close and a new data file to
be created every day at midnight. If data logging were trigged at 7:00pm on
the 5th, the first data file would contain data from 7:00pm to 12:00pm on
the 5th. Thereafter, data files will contain data from midnight the 5th to
midnight the 6th, midnight the 6th to midnight the 7th, etc. The data file will
therefore contain a maximum of one days’ data.

Selecting month will cause a new data file to be created on the first day of
every month at midnight. If data logging were started on the January 27th,
the first data file would contain data from the 27th of January to the 1st of
February. Thereafter, data files will contain data from the 1st of February to
the 1st of March, the 1st of March to 1st of April, etc. The data file will
therefore contain a maximum of one months’ data.

Selecting None causes all logged data to be placed in a single data file.
Logging begins when the Start Trigger is activated Whenever logging is
triggered, data will be appended to the existing data file. The size of the file
is limited only by available disk space. Care should be taken to not allow a
data file to consume all the available disk space.
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Line Format Dialog Box

The Line Format dialog box is displayed when the Line Format button is selected from the Configure—>Event
Log and Configure=>Historic Log commands. This option allows you to customize the line formatting in event
and historic logs.

Figure 14-5: Line Format Dialog Box

Delimiter

Choose a delimiter option to separate the data in the log. Choose “Other” to enter a delimiter option that's not
listed.

Check the “Include Space After Delimiter” box to append a space after each delimiter.

Quotes Around Strings

Selecting an option from this drop-down list puts quotes around each string in the log. The types of quotes to
select from are: none, *, *, and “.

Carriage Return Every N Elements

Choose this option to insert a carriage return every N data elements on a line, where N is a number entered in
the elements text box. This option is primarily intended for historic logs with very long data lines which are read
by programs that cannot handle long data lines. The date and time information at the beginning of a data line
are not counted as data elements. The N limit is 99999 elements.
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g | CHAPTER 15

RUNTIME MENUS

Runtime Menus provide access to the runtime commands. These commands allow you to open and close
projects, view the event log, and view the controller configurations.

= Mistic MMI Runtime
File  View Window Help (41556K)

Figure 15-1: MMI Runtime Menu

FILE MENU

File
Open Project...

Project Path

Change Printer...
Printer Setup...
Print

Exit MMI Buntime

Figure 15-2: File Menu

Open Project (File Menu)

Use this command to load an existing project created by the MMI Configurator. The Open Project dialog box lets
you select the directory containing the project you want to open. Scanning and animation begin immediately
once the project is loaded.

Project Path (File Menu)

This command displays the full project pathname in a Message Box. The project pathname is also displayed in
the Program’s Title Bar, however if the full project pathname is too long to fit in the Title Bar, then only the
project name is shown.

Change Printer (File Menu)

This command selects from one of the configured Windows print devices. The print device must have previously
installed Windows printers.
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Printer Setup (File Menu)

Displays a dialog box which allows configuration of default printer settings. This dialog box is specific to each
type of printer. See the Windows User Manual for more information on printer settings.

Print (File Menu)

Takes a snapshot of the MMI Runtime screen and sends it to the currently selected printer.

With the Mistic MMI, you can print graphics from the Configurator main window, draw windows, and the
Runtime windows, with the File=>Print command. The window of interest must be displayed in order to print it.
What you see on your screen is what is sent to the printer.

You can select printer devices with the File—>Change Printer command. Printing is sent to available printer
devices which have been previously installed through the Windows Control Panel. For information on installing
printers, refer to the Windows system documentation on the topic.

Exit MMI Runtime (File Menu)

Stops the scanner, closes all Runtime windows, and exits the MMI Runtime.
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VIEW MENU

View
Hide MenuBar

Mistic Controller(s)...
MW Driver...
Event Log

Figure 15-3: View Menu

Hide Menu Bar (View Menu)

This command causes the top menu bar to disappear allowing a larger screen area. To make the menu bar
reappear, press Esc.

Mistic Controller(s) (View Menu)

Selecting this command displays the Controller List dialog box. This dialog box lists all of the Mistic controllers
that are configured for the project. Selecting a controller and pressing the Inspect button displays the Controller
Status dialog box. This dialog box displays each controller's status and allows you to disconnect the MMI from
acontroller. Refer to Chapter 16, Runtime Controller Attachment, Controller Status dialog box, for more information
about Runtime controller status.

MWDriver (View Menu)

Choosing this command displays the “MWDRIVER.DLL Information” message box. The MWDRIVER.DLL version
and the path from where it was loaded is displayed.

Event Log (View Menu)

The Event Log command displays the Runtime system event log. This log contains system errors and messages
received during Runtime. The list box contains the most recent system event messages generated by the MMI.
Each message consists of a date and time stamp, and message text. The message text describes events such
as communications errors, and 1/0 errors. Scroll bars may be used to view prior messages. If the text of the
message is too wide to completely fit in the list box area, you can double-click the message and it will be
displayed in its entirety in a window message box.

Auto restore on new message

This field appears in the Event Log. The enable and disable options may be used to configure how the Event Log
Viewer appears during Runtime. If ‘Auto restore on new message’ is enabled, then the Event Log Viewer dialog
box automatically becomes the foreground window when a new event message is received. Selecting Cancel
hides the Event Log Viewer dialog box until it reappears as described above.
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WINDOW MENU

Window

Open...
Close...

Figure 15-4: Window Menu

Open (Window Menu)

Use this command to open any Runtime window which is currently closed. An Open Window dialog box will
display a lists of closed windows.

Close (Window Menu)

Use this command to close any currently open or iconified Runtime window. A Close Window will display a list
of currently open windows.

Open Window List (Window Menu)

Currently opened or iconified windows are listed in the Window Menu. Up to nine window names are displayed
and if more than nine windows are opened, a menu item named More Windows is appended.

Select a draw window name to cause that draw window to be displayed in front of all other opened draw
windows. If more than nine windows are opened, selecting More Windows will display a list box with all the
names of all opened windows. Select from the list box the window you want brought to the front. A window
must be opened or iconified for it to be listed.

15-4 Mistic MMI User’s Guide



RUNTIME MENUS

HELP MENU

Help

Contents

Search for Help On...
How to Use Help

About MMI Runtime ...

Figure 15-5: Help Menu

Contents (Help Menu)
Starts Help and displays the topics in MMI Runtime Help.

Search for Help On (Help Menu)

Opens the Search dialog box for MMI Runtime Help. Using the Search dialog box, you can look up Help information
by using keywords.

How to Use Help (Help Menu)

Describes how to use Help.

About MMI Runtime (Help Menu)

Choosing this command displays information about the MIMI Runtime. Information displayed includes the Runtime
version and date, and minimum versions required for Cyrano, Mistic controller kernels, and the MWDRIVER.DLL.
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CHAPTER 16

RUNTIME CONTROLLER ATTACHMENT

OVERVIEW

During the MMI Runtime, parameters for configured controllers may be inspected.

CONTROLLER LIST DIALOG BOX

This dialog box is displayed when the Configure—>Mistic Controllers menu item is selected from the MMI
Runtime menu. It contains a list of all the Mistic controller names configured for the current MMI project.

Controller List

Controller Name

OFTO DEMO BOX

Inspect... I

V 0K ? Help

Figure 16-1: Controller Dialog Box

Controller Name This is a list of all the controllers names that are configured for the current

MM project. Controller parameters can be queried by selecting the Inspect
button after first selecting the specific controller in this list box.
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Inspect Selecting the Inspect button displays the Controller Status dialog box so
you can obtain information about the selected controller. Information includes
EPROM version, available memory, program state, and .GML file information.
You may also use the Controller Status dialog box to manually attach or
detach a controller. Detaching a controller from the MMI stops the data
from being scanned for that controller. The Inspect button can only be used
after a controller name has been selected in the Controller Name list.

CONTROLLER STATUS DIALOG BOX

This dialog box is displayed when the Inspect button is selected from the Controller List dialog box. Using this
dialog box, you can obtain information about the controller as well as manually attach or detach a controller.

Figure 16-2: Controller Status Dialog Box

Controller

Name Displays the name of the selected controller from the MM application’s
controller list.

Address Displays the selected controller’s address.
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Type

PC Port
Type

Retries

Time Out (sec)

Re-enable (sec)

Mode

Controller State
EPROM version

Available Memory

Shows the model of the Mistic 200 controller. Possible types are the G4LC32,
GALC32ISA, GALC32SX, and M4RTU.

Displays the computer host port connection to the controller. Possible
connection types are ARCnet, AC37/AC42, ISA Direct, and WIN COM. The
ARCnet port types have a hex value address in the I/0 Adr: and the RAM
Address: fields. Alternately, AC37/AC42, ISA Direct, and WIN COM port
connections display the I/0 Adr and Baud fields.

AC37/AC42 connections show the hex value 1/0 Address while ISA Direct
and WIN COM ports display a COMn (n=values 1 through 4) port connection
in the 1/0 Adr; field.

ISA Direct fields display a N/A in the BAUD field.

This displays the number of times the computer attempts to establish
communications with the controller.

This field displays the amount of time (in seconds) the computer waits before
reattempting to establish communications with the currently selected
controller.

This is the period of time that the program waits after a communication
attempt has failed before it attempts to re-establish communication to the
controller. Every failed communication attempt automatically disables the
associated controller. The program uses this Re-enable time to enable the
controller for another attempt at communication.

This field displays the currently selected manner of communication between
the controller and host computer for AC37/AC42, ISA DIRECT, and WIN
COM PC port types. Valid modes include ASCII or Binary. If the PC port type
is ARCnet, the mode is set to N/A. A detailed description of Binary and
ASClImodes is found in Chapter 5, Controller Configuration, under Controller
Communications.

Displays the current EPROM version in the Mistic controller.

Displays the amount of available RAM memory in the Mistic controller in
bytes.
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Program State

GML File Name

GML File Time

GML File Date

Communication

Attach

Detach

Status

Error
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Displays the current program state, either RUN or STOP.

Displays the eight character file name for the GML file name associated
with the Cyrano strategy which is resident in the Mistic controller.

Displays the DOS creation time for the GML file associated with the Cyrano
strategy which is resident in the Mistic controller.

Displays the DOS creation date for the GML file associated with the Cyrano
strategy which is resident in the Mistic controller.

This button allows you to manually attach the Mistic controller to resume
scanning. You can query the controller with this button to determine if
communication can be established. If communication with the controller is
not established and you have not manually detached it, the Status field
indicates “Detached on Error”. If communication with the controller is not
established and the Controller was manually detached by the user, the Status
field indicates “Detached by User”. Finally, if communication is successful,
the Status field indicates “Attached.”

This button allows you to manually detach the controller and suspend all
scanning associated with that controller. Upon selecting this button, the
Status field indicates “Detached by User”.

This field indicates the current communication status between the host PC
and the controller. Upon entry to this dialog box, a query is made to obtain
the controller’s status. If the controller has been detached by the user, this
status indicates “Detached by User”. If the controller has not been manually
detached, and the query is unsuccessful, the status indicates “Detached on
Error”. If the controller is not manually detached and the query is successful,
the status indicates “Attached”. From this point, the status reflects the current
controller state desired as the user selects either the Attach or Detach
buttons.

This field appears when an error is detected. A comprehensive list of Runtime
errors is found in Appendix A, Messages and Errors.



APPENDIX A

ERRORS AND MESSAGES

OVERVIEW

During Configuration and Runtime, the Mistic MMI may alert you to an error condition. Errors are caused by
incorrect equipment setup, out of date files, or equipment failure.

Errors can be grouped into three major categories: Configurator Errors, Runtime Errors, and Windows Errors.
Configuration errors occur during the construction and attachment of graphics while in the Configurator. Runtime
errors occur while running a project. Windows errors are issued by the Windows environment.

Configurator errors occur when building a project. Errors are most common when entering data into a dialog’s
edit box. If an improper value is entered, the Mistic MMI will inform you of the error. Simply reenter the value.

Along with the errors generated by the Mistic MMI, Windows itself will display errors. The most common
Windows errors occur when too many applications are running at the same time. The Windows documentation
contains a description of these errors.

Runtime errors occur during Runtime and can be further categorized as Controller, File Access, Historic Log,
Launch Application, Port, Recipe, Scanner, Server, or System errors. Most errors can be traced to improper
configuration of the Mistic controller or the /0 unit hardware.
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CONTROLLER ERRORS (RUNTIME)

The Mistic controller reports the following runtime errors. The source of the error may be the Mistic controller
or one or more 1/0 units.

Buffer Overrun

This error occurs if the data returned from the 1/0 units is too long (>255 characters) or too short (data length is
0). Check for possible noise interference, proper termination, or other factors which may affect communication
lines to the controlller.

Communications Watchdog

The communication link watchdog timer has timed out. The Mistic controller is unable to communicate with
one or more 1/0 units. This might be caused by improper wiring or termination. See “I/O Checksum Error”
below.

Controller Bus Error

This error is usually caused by a problem in the Mistic kernel or library. It could also be caused by a failure in the
Mistic 200 processor hardware. The failure may be due to a bad memory or port device. When this error occurs,
the chart in the controller that caused the error is stopped. If this error occurs, make sure that all cards in the
Mistic controller are properly seated.

Controller Compile Error

The MMI was unable to compile a custom Forth word on the Mistic controller during scanning. Custom Forth
words are used by the MMI to accelerate scanning by aggregating queries of several tags into one word.

Controller Definition Incomplete

An incomplete user defined command was downloaded to the controller. This can occur if MISTIC.LIB was
downloaded with an incorrect FORTH word definition.

Controller Dictionary Full (Switched to Slow Scan)

The controller has insufficient memory to compile a new Forth word generated by the MMI. The MMI creates
custom Forth words to accelerate scanning. Each custom word contains queries for several tags found in the
same scan group. The increase in scanning efficiency is achieved by making a single query to the controller to
obtain values for all the tags compiled into the custom Forth word. This reduces the overhead required if each
tag is queried individually. If this error occurs, the MMI must revert to querying each tag individually which is
called “Slow Scan.”

Controller Empty Stack

The Mistic controller generates this error during a download or while running. A command is requesting more
items from the stack than are available. Example: An ENDIF (Forth “THEN") without a corresponding IF
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Controller EPROM Out of Date

The controller EPROM version on the Mistic controller does not meet the minimum version requirements for
this version of the MMI. The minimum required EPROM version is identified as the Mistic Version in the About
dialog.

Controller Error

The Mistic controller receives a message it does not understand. This may be caused by wiring or noise problems
between the host computer and the Mistic controller.

Controller Execute Error

The Mistic controller encounters a program instruction which it cannot execute. During runtime, this error may
indicate a corrupt program file.

Controller GML Date Stamp Invalid

The date stamp for the current Cyrano strategy was not currently obtained from the Mistic controller. Check
connections with the Mistic controller.

Controller GML Date/Time Incompatible

The date and time stamp recorded on the controller for the current Cyrano strategy does not match the date and
time of the GML file which was used to configure the MMI project. MMI Runtime operation will continue. Any
tags which may have changed can cause scanning errors. The MMI Configurator should be run to update the
internal GML time stamp recorded in the MMI project and verify connections to any tags which may have
changed.

Controller GML File Name Incompatible

This error commonly occurs when a new or modified strategy is downloaded to a controller and the Mistic MMI
runtime is started. If the MMI was configured with a strategy file that does not match the one in the controller,
this error will be reported. Enter the configurator and select New Strategy from the Configure, Mistic Controller
Menu.

Controller GML Time Stamp Invalid

The time stamp for the current Cyrano strategy was not correctly obtained from the Mistic controller. Check
connections with the Mistic controller.

Controller Out Of Memory (Switched to Slow Scan)

The program and data in the Mistic controller has exceeded the available controller memory. This error usually
occurs during program download. During runtime, this error occurs when the MMI is compiling custom Forth
words for compressed scanning. These words may be compiled any time a MM Runtime window is initially
opened.
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Controller Stack Full

The stack on the Mistic controller cannot grow any further. This error may be caused by an error in a library
(Cyrano’s MISTIC.LIB file), the include file (Cyrano’s MISTIC.INC file), or words downloaded by the MM

Controller Strategy Invalid

The Mistic MMI did not find a Cyrano strategy at the controller during the verification process. Make sure a
Cyrano strategy was downloaded to the controller before trying to run the MMI.

Data Field Error

The 1/0 unit did not receive enough characters. This indicates a problem between the Mistic controller and the
/0 unit. This can be caused by different baud rate settings on the controller or /0 unit. Check the communications

jumpers.

Data Range Error

This error occurs when an invalid command has been constructed within the MMI on the host machine. The
erroneous command is not passed on to the Mistic controller.

Invalid Channel

This error occurs when a command attempting to use an unconfigured channel is sent to the controller.

Invalid Command

The Mistic controller received an invalid command from the host.

Invalid Delay

This error occurs with digital 1/0 units when you try to start a square wave, generate N pulses, or a TPO, with
a delay time less than 10ms on more than eight output positions.

Invalid Event

This error occurs when you try to enable an event entry or define a reaction before the event has been defined.

Invalid Limits

An 1/0 unit receives data which contains an illegal value. The Mistic controller has sent a command to an |/0
unit which contains out of range data. Check your controller program to see if calculated values are within
module configured ranges.
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Invalid Mistic Kernel, may need to be downloaded

The controller's kernel has been corrupted. Download the Mistic kernel using the FLASH200 utility.

Invalid Module Type

This error occurs when a command is sent that requires a different channel configuration than the one presently
in use. For example, you issue a command to turn on an output on a channel that is configured as an input.

1/0 Buffer Overrun

One of the Mistic I/0 units received a command from the controller which was greater than 256 characters.

1/0 Checksum Error

This error indicates a problem with the communication link. Checksum error often occurs when the Local Bus or
Remote Bus networks are not wired, terminated, or biased properly.

Power Up

After a power failure on an /0 unit, a Power-UP Clear Command is expected before any other command. The
Mistic Controller will automatically send this command. However, the MIMI will report the occurrence.

Table Index Error

The index for the specified table is out of range. Check the MM project to make sure you are not accessing an
invalid range of table elements.

Undefined Command

This error indicates a Mistic 1/0 unit received a command from the Mistic controller which it did not understand.
This may indicate a new command was added that is not supported by an older I/0 unit. An update to the I/0
unit's EPROM may be required.

Word Abort While Port Unlocked

This error is generated by the controller after the UNLOCK command was issued.
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FILE ACCESS ERRORS (RUNTIME)

The following File Access Errors are generated by the MMI if an error occured while the MM is working with
files or while working with Historic Logs.

Bad Mistic String, using default file name.

The Mistic tagname used as a source for a file name could not be used. The default file name will be used
instead. The default file name was set up in the Configurator.

Can't make directory

A directory could not be created. Check if the directory is being created in a read-only directory. Change the
protection to allow you to write to it.

Directory now created.

Status message indicating the directory was created.

Drive is full. Writing has been suspended.

Afile was being written to a drive but not enough free space was available to complete the transaction. Free up
some space on the drive to continue.

Drive is no longer full. Writing has been resumed.

The destination drive has enough space available to complete the file writing transaction.

Initial Writing of file: Filename

Status message indicating Filename is going to be created.

Invalid Directory Bad Directory Name. Using default.

The specified directory could not be used. The default directory will be used instead. The default directory was
set up in the Configurator.
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HISTORIC LOG ERRORS (RUNTIME)

The following runtime error and File Access runtime errors may result from a historic log error.

Scan Error: [ Scanner Error ] while accessing: Tagname

A scanner error occurred while trying to access Tagname. Check the Scanner errors list for a complete description.

LAUNCH APPLICATION ERRORS (RUNTIME)

The following errors may occur if an error occurred while working with the Launch Applications feature of the
MMI.

File Not Found:

The executable file specified for a launch application setup could not be found. Verify the directory where the
file actually resides.

Path Not Found:

The drive/directory path specified for the executable in a launch application setup does not exist. Verify the
actual path of the executable file.

Scan error - [ Scanner Error ] while accessing: Tagname

A scanner error occurred while trying to access Tagname. Check the Scanner Errors section for more details
about the error.

WinExec Error #:

A Windows executable error occurred. Check Microsoft help sources for clarification about the error #.

Working Directory Invalid:

The working directory specified for a launch application setup is incorrect. Verify the drive and path are correct.

Mistic MMI User’s Guide ~ A-7



ERRORS AND MESSAGES

PORT ERRORS (RUNTIME)

The following errors are generated by the MMI if a port related error occurred.

ARCnet has no other nodes

There are no other ARCnet nodes on the network.

ARCnet Transmitter Not Available

The MWDRIVER.DLL could not receive notification from the ARCnet adapter that it is ready to transmit data.
Ensure the ARCnet adapter is installed properly and connected to the network.

Checksum error

The computed CRC checksum does not match that in the received message. Check hardware connections to
the Mistic controller.

Controller Currently Busy

Another host machine has the Mistic controller's host port locked. The host port is locked when any host
machine is downloading new Forth words for either a MMI or Cyrano application. A MMI session downloads
new Forth words during startup or when a window is opened for the first time in that session. During this
period, all communication is suspended between other hosts running MMI sessions and the Mistic controller.
Upon completion of Forth word download, the port is unlocked and communication resumes with all MMI
sessions connected to the Mistic controller. Verification of the communications is provided by the “Attaching to
Scanner” message.

Driver Port Invalid

This error occurs when a device, such as an AC37 or AC42, has been configured but does exist at runtime.
Check your device configuration.

Driver Protocol Invalid

This is an internal MMI error. Call Opto 22 Technical Support.

Error constructing port - out of memory

The first call to this port failed because the host computer was out of memory.

Invalid Address-

The driver sent a command which included a Mistic controller address outside the limits of 0 and 255.
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Invalid baud rate

The baud rate is not correct.

Invalid MwDriver handle

This is an internal MMI error. Call Opto 22 Technical Support.

Not Enough Data -

The MWDRIVER.DLL did not receive the required number of bytes from the controller which were expected.
Check connections with the Mistic controller.

Port Init Error

At runtime, the MMI software was unable to initialize the |/O driver. This is probably caused by a memory
allocation problem. Exit Windows and restart Runtime.

Port Locked

The communication port configured to talk to one or more Mistic controllers is being used by another application.
Check the Windows Program Manager to see what other applications are running. Programs which use the
computer serial ports, such as modem programs, may be running and using the port.

Response Time-out

A response was not received from the Mistic controller in the Time-out period specified for the port. Check the
Time-out settings for the port. If adequate, check hardware connections with the Mistic controller.

Send Error

This error is usually caused by not having a Clear-to-Send (CTS) signal on the RS-232 port. No message will be
sent. Check hardware connections with the Mistic controller.

Undefined Error #

An internal Mistic MMI error occurred. The error that occurred is not recognized by the MMI. Contact Opto 22
Technical Support.
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RECIPE UPLOAD/DOWNLOAD ERRORS (RUNTIME)

The following errors are displayed if a recipe upload or download error occurred.

An unknown error occurred on the indicated line. (Recipe Upload)

An unknown error occurred during the upload. Call Opto 22 Technical Support.

A scanner error while accessing tag: tagname (tag name not found)

A scanner error was encountered while scanning tagname. Check the Scanner Errors for more details about the
error.

Could not find the selected directory for the recipe format file. Please check to
ensure the path is correct. (Recipe Upload)

The path configured for the format file of the uploaded recipe was invalid. Make sure the drive/directory path
is correct.

Could not find the selected recipe format file. Please check to ensure the
filename is correct.

The file name configured for the format file of the uploaded recipe was not found. Make sure you configured
the correct tag name.

Could not find the selected directory for the recipe destination file. Please check
to ensure the path is correct. (Recipe Upload)

The path configured for the destination file of the uploaded recipe was invalid. Make sure the drive/directory
path is correct.

Could not make directory for Destination File: (Recipe Upload)

The path configured in the destination path could not be created. Check the drive specified in the path. Also
check the read/write protection of the directory.

Invalid type specified. Valid types are: “Integer Table, Float Table, String Table
and Chart”

An invalid type was specified in the recipe. Only tags of types integer table, float table, string table, and chart
are allowed in a recipe.

Mistic String for Destination File was empty: (Recipe Upload)

A Cyrano tag name was configured to contain the name of the destination file but its contents were empty.
Make sure you configure the correct tag name.

A-10 Mistic MM User's Guide



ERRORS AND MESSAGES

Mistic String for Format File was empty:

A Cyrano tag name was configured to contain the name of the format file but its contents were empty. Make
sure you configured the correct tag name.

Scan error - Scanner Error while accessing: Tagname

A scanner error occurred while trying to access Tagname. Check the Scanner Errors section for more details
about the error.

The recipe file does not exist! (Recipe Upload)
The recipe upload file does not exist. Verify the spelling of the file.

The specified controller does not exist in this project.

The controller specified in the recipe’s Cyrano tag is not recognized by this project. Verify the controller name for
the tag name requested. Check the controller’s spelling.

The tag info is formatted incorrectly. Should be: Controller:Tag Type.Tag Name"

The syntax for the Cyrano tag is incorrect. Make sure it follows the this pattern: Controller Name:Tag Type.Tag
Name, where Controller Name is the name of the Mistic controller; Tag Type is “Integer Table”, “ Float Table”,
“String Table”, or “Chart”; and Tag Name is the name of a Cyrano tag or chart name of the type specified in Tag

Type.

The tag value is formatted incorrectly. Should be: Index (optional) : Value"”

Check the syntax of the tag value(s) specified for the indices. Make sure a colon separates the index from the
actual value, and also verify the index is within the table’s range.

The specified chart state is invalid. Valid states are Run, Stop, Suspend, or
Continue.

Make sure the chart state sent in a chart control instruction was “RUN", “STOP”, “SUSPEND", or “CONTINUE".

Uploaded/Downloaded to File: Filename

Status message indicating Filename was uploaded/downloaded.
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SCANNER ERRORS (RUNTIME)

The following runtime errors are displayed if a scanning error occurred.

Alternate Debugger Port (Switched to Slow Scan)

During the process of compiling Forth words for a compressed scan, the MMI receives a notice from the Mistic
controller that it is using the alternate debugger port and therefore cannot compile words on that port. The
MM I reverts to a Slow Scan mode in which all tags are scanned individually.

Attaching to Scanner

This message appears when trying to re-establish communications with the Mistic controller.

Controller ID Not Found

The Mistic controller id used for the scan item cannot be found in the list which is maintained internally to the
MMI.

Detaching from Scanner on Error

This message appears when the number of retries has been exceeded by the host when trying to re-establish
communications with the Mistic controller.

Detaching from Scanner by User

This message appears during runtime when the user has manually disconnected the host from the Mistic
controller in the Controller Manager dialog box.

Float value illegal. Value Ignored

An error occurred when converting data from a controller into a float variable used in the MMI. The value is not
used to update graphics during this scan period.

Incorrect Packet Size (Switched to Slow Scan)

The response packet from the Mistic controller does not contain the correct amount of data during a compressed
scan. This may be due to a failure in the custom Forth word compiled for the MMI to assist in scanning. This
custom Forth word is no longer used and the system reverts to scanning all tags separately. This mode is called
Slow Scan.

Internal Sequence Error (Switched to Slow Scan)

An internal MMI error occurred when updating graphics with values obtained from a custom Forth word used
during scanning. This custom Forth word is no longer used and the system reverts to scanning all tags separately.
This mode is called Slow Scan.
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Receive Error

The expected number of characters were not received from the Mistic controller.

Scanner Overrun Error

The internal MM scanner is unable to scan all of the 1/0 data requests at the rate configured by the user. This
can occur if too many points have been configured at too fast a scan rate. Slow down the scan group times. This
can also occur if the controller takes too long to provide the data at the configured rate.

Task Start Failed
A task on the Mistic controller has failed to start as directed by the MIMI.

Unexpected controller response (out-of-sync)

Sequence ids are placed in each command to the Mistic controller from the host. This id is compared to the one
found in the response from the Mistic controller to ensure that messages do not go out of synchronization. If
this problem persists, run the MW Sniffer utility to record communications between the Mistic controller and
the host and report the problem to Opto 22 Technical Support.

SERVER MESSAGES/ERRORS (RUNTIME)

The following runtime error messages are displayed if a MDS server error occurred.

Alternate server DOWN
The primary or backup server is down. If the primary MDS node was running, the backup node is down; if the
backup node was running, the primary MDS node is down.

Alternate server UP

A status message indicating the backup/primary server is connected to MDS. If the primary MDS node was
running, the backup node is up; if the backup node was running, the primary MDS node is up.

Both servers DOWN

The primary and backup servers are down. Verify the MDS port configuration in MDS matches the actual
physical configuration of the Mistic equipment. Also verify the LAN network is correct.

Both servers UP [switched to primary]
The primary and backup servers are connected to MDS. The primary MDS node is connected to the MIMI.

Connecting to server (pinging server)
The MMl is attempting to connect to MDS.

Mistic MMI User’s Guide A-13



ERRORS AND MESSAGES

Controller name not found on server or network error

The MMI attempted to verify a controller is registered with MDS but the controller was not found. Make sure
it was registered with MDS in the MDS Administrator. Verify the controller name is spelled correctly.

Controller not defined

The MMI attempted to verify a controller is registered with MDS but the controller was not found. Make sure
it was registered with MDS in the MDS Administrator. Verify the controller name is spelled correctly.

Could not connect to server. MDS version too old for server
The MMI could not connect to MDS because the version of the MDS program is too old for MIMI.

Could not connect to server. MMI version too old for server

The MMI could not connect to MDS because the version of the MMI program is too old for MDS.

Current server DOWN [no alternate]

The primary/backup MDS server is down and an alternate server was not configured. Make sure MDS is
running.

Current server UP

Status message indicating the primary/backup MDS server is up and running.

Disconnecting from server

Indicates the MM is disconnecting from MDS. Possible causes are that a network communication error occurred,
or the MM is simply terminating its connection to MDS.

Error connecting to server (ping FAILED)

The MMI could not communicate and connect to MDS.

Internal Error - server improperly configured

Call OPTO 22 Technical Support. The data collected after this error occurs is unreliable.

Network communication FAILED

The MM tried to communicate to MDS and MDS could not receive the message. Verify MDS is running and the
LAN connections are working properly.

Network error while configuring server (group add FAILED)

The MM was in the process of configuring MDS with a group when and a failure occurred. Verify MDS is
running and the LAN connections are working properly.
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Network error while configuring server (item add FAILED)

The MMI was in the process of configuring the server with a tagname when a network error occurred. Verify
MDS is running and the LAN connections are working properly.

Network error while configuring server (project disable FAILED)

The MMl was in the process of disabling a project from the server when a network error occurred. Verify MDS
is running and the LAN connections are working properly.

Network error while configuring server (project enable FAILED)

The MMl was in the process of enabling a project to the server when a network error occurred. Verify MDS is
running and the LAN connections are working properly.

Network error while connecting to server (add FAILED)

The MMl could not connect to MDS because of a network error. Verify MDS is running and the LAN connections
are working properly.

Network initialization FAILED

Connection to the network failed. Verify NetBIOS protocol was configured for the network. Also verify Windows
for Workgroups 3.11 (or above) is loaded.

Server data overrun

The MMI could not keep up with the data MDS is providing. This could happen if the MMI PC is busy with CPU
intensive window operations and tasks. Increase the scan rates for these data items or alleviate the demands
on the PC.

Server temporarily locked by another client (project lock FAILED)

The server is locked by a MMI project while the MMI project is built and established to MDS. This keeps
another MMI project from building and taxing the MDS resources. The MMI will try again later.

Switched to alternate server

Status message indicates the MMI switched to the backup server if it had been using the main server, or it
switched to the main server if it had been using the backup server.

Verification of server configuration FAILED

The MMl is verifying MDS is scanning the correct number of items and the verification failed. Try your project
again. If the error repeats itself, call Opto 22 Product Support. Any data returned may be invalid.
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SYSTEM ERRORS (RUNTIME)

The following error is displayed if a system error occurred.

System: Floating point error N caught by signal handler

The data returned from the controller was detected to have a floating point error. This could have occurred
during data manipulations at the controller. Verify the data has been handled or cast properly according to its

type.
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If you have any questions about this product, contact Opto 22 Product Support Monday through Friday,

APPENDIX B

8a.m. to 5 p.m. Pacific Time.

Phone: 800-TEK-OPTO (835-6786)

951-695-3080

Fax: 951-695-3017
E-mail: support@opto22.com
Opto 22 Web site: WwWw.0ptoZ2.com

When calling for technical support, be prepared to provide the following information about your system to the
Product Support engineer:

Software and version being used
Controller firmware version
PC configuration

A complete description of your hardware and operating systems, including:
— jumper configuration

—accessories installed (such as expansion daughter cards)

— type of power supply

—types of /0 units installed

—third-party devices installed (e.g., barcode readers)

Specific error messages seen
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GLOSSARY

advanced graphic

The Mistic MMI's advanced graphic object is a trend. It is a predefined collection of graphic symbols.
Advanced graphics have their own dialog boxes to control specific attributes.

application manager

An Application Manager is a dynamic object used to launch another application based upon changes in
process variables. Each application manager has a command line, working directory, and an associated
trigger. The program file specified in the command line is launched everytime the trigger condition occurs.

bitmap

A Bitmap is an electronic image of a picture that can be viewed on a computer display. Bitmaps have types
of manochrome or color. Color bitmaps are available with a 16 or 256 color palette. The type and palette size
are important as they determine the amount of memory needed to store the image. Bitmap files have a file
extension of .BMP. Bitmap files can be created using any Windows paint program. In the MMI, bitmaps are
typically used for any complex graphics or logos.

color button

A Color Button appears as a colored rectangle in dialog boxes. Its color indicates the color currently selected
to the associated item in the dialog box. To change the color select the color button. This displays the Color
Dialog.

NOTE: for best results use solid colors only.

connection

The term connection is used to indicate a relationship between an object and a tag that effects a dynamic
attribute possessed by the object. The MMI configurator makes the connecting of these pieces of
information easy by using the visually oriented Windows interface.
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Controller Driven Dynamic Attributes

Controller driven dynamic attributes are connections made to a dynamic object which changes the
appearance of the object based on the value or state of a variable. For example, changes in tag values
within a controller may cause graphics on the MMI to change size, color, or shape.

Cyrano strategy

A Cyrano Strategy defines the control strategy resident in a Mistic controller. The GML file associated with
this strategy is used by the MMI Configurator to obtain information about the controller as well as tag
names for the I/0 points and variables. Multiple versions of the same Cyrano strategy may reside on more
than one controller in a system.

deadband

Deadband is a range of input values for a dynamic attribute that have no impact on the associated dynamic
object. The MMI implements a deadband by using the deadband value entered for each dynamic attribute.
A deadband value of zero allows all input values to impact the dynamic attribute. If the scanned input value
is greater than the deadband value plus the last input value that successfully impacted the dynamic
attribute, then the scanned input value is allowed to impact the dynamic attribute. Similarly, if the scanned
input value is less than the last input value that successfully impacted the dynamic attribute minus the
deadband value, then the scanned input value is allowed to impact the dynamic attribute.

delimiter

A Delimiter is a unique character used to separate items written to the same line within a file.

draw window

A Draw Window is any window that allows addition of graphics. A draw window has static attributes of
position, size and color, and a dynamic attribute of a Draw Window Visual State.

draw window visual state

Draw windows have visual states of open, closed, or iconified. An open window scans and updates objects
associated with it. A closed window scans only its trends if it was configured to do so, and does no
updating. An iconified window scans all its objects but does no updating.

dynamic attribute

Dynamic Attributes are those attributes of a dynamic object which change during runtime. Examples of
dynamic attributes include color, size, position, visibility, etc. Dynamic attribute behavior is controlled from
sampled tag values as designated during configuration.

dynamic link

A Dynamic Link is the relationship established during configuration between a tag and a dynamic object as a
graphic, historic log, or trend.
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dynamic objects

Any configurable object that has dynamic attributes associated with it is a dynamic object. Examples of
dynamic objects include graphics, historic logs, window managers, and trends. During runtime dynamic
objects are updated with values from the scanned controllers, user interaction, or system events.

event

Events are incidents or occurrences of significance to the MMI operator and are not always an indication of
abnormal conditions. Event examples include disk full, communication problems, etc.

event log

A project’s Event Log is a list of event messages for all events that have occurred while a project is being
executed by the MMI Runtime. The list can be viewed using the Event Log Viewer by selecting View Event
Log from the View menu of the Runtime. Optionally, at configuration time, the Event Log can be configured to
write the event messages to a file in addition to adding them to its list. Only one event log exists per project.
freshness

Freshness is a method of improving system performance. When an 1/0 point is accessed by the MM, a time
value associated with the I/0 point is tested. If the tested time value is within the specified freshness, the
controller will use its Internal Value and save the communications overhead needed to get the value from
the 1/0 brick. This system works because every |/0 access the controller makes when executing the Cyrano
control Strategy updates the Internal Value and makes its time value current. The freshness value in the
MMI is configured as part of a Refresh Time Group.

graphics

Graphics are dynamic objects such as lines, boxes, circles, etc., used to build a visual representation of a
system of process. An operator interface is a combination of graphics which visually simulate a real-world
process. Graphics are classified as either primary or advanced.

grid

A grid is a visual array of points arranged in the draw window to facilitate the drawing and alignment of
graphics. Grids may be turned on or off.

grid point

One of the visual alignment points represented by a single dot. A grid is composed of numerous grid points.

G4LC32

The G4LC32 Mistic controller. Referred to generically as a controller.
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G4LC32ISA

The G4LC32ISA Mistic controller. Referred to generically as a controller.

G4LC32SX

The G4LC32SX Mistic controller. Referred to generically as a controller.

historic log

A Historic Log is a dynamic object configured to write a selected set of data out to a file. Data is sampled at
predetermined intervals and written out to files in the user selected directory. Each Historic Log can have an
associated Start Trigger and Stop Trigger to initiate and terminate sampling.

Operator Driven Dynamic Attributes

Operator driven dynamic attributes are connections made to a dynamic object which changes the value or
state of a variable based on an operator action. Operator actions, such as a mouse click, cause variables in a
controller to change.

overrun

(scanner overrun error) The internal MM scanner is unable to scan all of the I/0 data requests at the rate
configured by the user. This can occur if too many points have been configured at too fast a scan rate. Slow
down the scan group times. This can also occur if the controller takes too long to provide the data at the
configured rate.

primary graphic

Primary graphics are graphics such as lines, rectangles, circles, polygons, etc. which are used to form
complex visual images. The Configurator’s Tool Bar contains all supported primary graphics.

project

Projects are collections of one or more draw windows containing dynamic objects which represent a control
system or process.

real time trend

Areal time trend is a graphical representation of a tag's value as it changes over time. This graphical
representation is displayed as a simulation of a strip chart recording. Up to four lines can be displayed
simultaneously.

recipe

Arecipe is used to download and upload data to a Cyrano program. Recipes allow an operator to make
broad changes to program variables for the purpose of tailoring the Cyrano strategy to specific runs or
product types. Data is stored in ASCII files which are edited with any text editor word processor which can
save the data in ASCII format. These files are uploaded or downloaded by configuring a Touch-Download
Recipe or Touch-Upload Recipe Dynamic Attribute for a graphic object.
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refresh time group

A Refresh Time Group defines a preconfigured refresh rate and freshness applicable to one or more scanned
tags. Up to seven separate refresh times groups can be configured within an MMI project.

rollover period

The period of time a log or file receives data before that data is written to a new log or file. Rollover periods
may be months, days, or hours. File naming conventions are adjusted accordingly.

scan group

A Scan Group is a collection of tags that are scanned at particular scan rate. The scan rate defines how
often controller variables are scanned to refresh MIMI tags. Every MMI tag belongs to a scan group. There
are seven scan groups with configurable refresh times ranging from milliseconds to months. Communication
loads can be optimized by changing the refresh times of a scan group.

snap on

Snap On is a characteristic causing points of a graphic to be placed only on grid points. Snap On is used to
facilitate the drawing and alignment of graphics. Snap On is sometimes referred to as magnetism.

snap off

Snap Off disables the placement of a graphic to the nearest gridpoint when it is moved in the draw window.

static objects

Static Objects are graphics which do not have a dynamic connection. Changes in a controller do not effect a
static object. Static objects are used to make a process graphic more familiar to the operator.

tag

ATag is the symbolic name used to identify a piece of data such as an 1/0 unit, alarm, variable, or system
condition.

tool bar

ATool Bar is a set of graphic drawing tools arranged in a vertical row used to create process graphics. The
Tool Bar may be moved anywhere in the drawing area to facilitate drawing.

trend

ATrend is a rectangular shaped dynamic object which graphs the change in a variable or set of variables
over time. Trends show variables in the vertical axis and time in the horizontal axis.
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trend pen

Atrend pen is a dynamic object used by trends. The value of its tag provides the data for the line graphs in
the trends.

trigger

ATrigger is configured with a tag and a condition to which that tag is compared. The condition is comprised
of a value and a mathematical relationship. The specified tag is sampled and compared against this
specified condition. Triggers are edge sensitive and only activate with a positive transition from a non
triggered state. Triggers are often used to start and stop sampling of other tags associated with dynamic
attributes of a dynamic object.

window manager

A Window Manager is a dynamic object used to activate, deactivate, or inconify one or more windows
based on changes in process variables or operator actions. Each window manager has an associated trigger
and list of draw windowss and their visual state transitions.
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Symbols

.BMP, 7-5
.GML, 16-2
timestamp, 1-2

.GML file, 1-2
NI file, 1-3
.MMl file, 1-3
.RCP, 9-10

.WON, 1-3

WAV, 11-2

A

About MMI Configurator, 3-38
About MMI Runtime, 15-5
AC37, 4-3
AC37/AC42 Port Dialog Box, 4-12
AC38, 4-3
AC42, 4-3
Align, Edit Menu, 3-7

Bottom, 3-9

Center, 3-7

Left, 3-7

Middle, 3-9

Right, 3-8

Top, 3-8
animation

when it starts, 15-1
appearance

launched application, of, 13-5

Application Manager Dialog Box, 13-3
Application Manager Trigger Selection

Dialog Box, 13-6

Application Managers Dialog Box, 13-2

applications
launching, 13-1

Applications (Configure menu), 3-37

ARCnet
cable specifications, 4-2
communications, 4-1
port specifications, 4-2
ARCnet Port dialog box, 4-10
ASCII
screen keyboard, 14-4
assigning
color to graphic, 7-10
refresh time to graphic, 7-9, 10-16, 11-7,
12-8, 13-9
attributes
draw windows, 1-3
setting, 7-3
attributes, text, 3-23
Available Memory, 16-4

B

Background (Text menu), 3-32
backups

mistic MMI, 2-5
baud rate

AC37, 4-3
binary mode, 4-4
bitmap

default file extension, 3-3
Bitmap (Tool menu), 3-21
bitmaps, 7-5
blank lines

recipe file, 9-3
blink

making a graphic, 7-17
blink rates, 7-18
Bottom Align, 3-9
Bring to Front, Edit Menu, 3-6
bulletin board service, B-1
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C connections, 1-4
_ to tags, 2-3
caption Contents (Help menu), 3-38
main window, 14-4 Contents, Help (Runtime), 15-5

carrriage return
between strings, 10-13, 14-13
Center Align, 3-7
Change Printer, File Menu, 3-3
changing
background color of text, 3-32
color of text, 3-32
font size, 3-31
line color, 3-23
type face of text, 3-33
chart control
recipes, 9-1

controller

configuration, 2-4, 4-1
controller communication, 4-1
controller driven attributes, 1-4, 7-5
Controller Properties Dialog Box, 4-9
controllers

configure, 4-1

inspecting at Runtime, 16-1
Controllers dialog box, 4-8
copy

different directory name, to, 3-2
' ] dynamic attributes, 3-13
Choose Bitmap, File Menu, 3-3 Copy (Window menu), 3-35

circle with slash, 7-7 Copy Dynamic Attributes, Edit menu, 3-13
Close (Window menu), 3-35 Copy, Edit Menu, 3-6

Close Project, File menu, 3-2

. copy project
close window

different computer, drive, 3-2

during Runtim;. 15-4 Copy to File, Edit menu, 3-13
Close Windows Dialog Box, 6-3 Curve (Tool menu), 3-20
color. _ customer support, B-1
assigning, 7-10 Cut, Edit Menu, 3-5
trends, 8-4 Cyrano, 1-2
Color (Text menu), 3-32 GML file, 1-2
communication downloading to controller, 2-4
ARCnet, 4-1 exiting environment, 2-4
binary mode, 4-4 kernel, 1-2
controller, 4-1 . running on controller, 2-4
modem ASCII serial mode, 4-5 selecting, 2-3
parameters, binary, 4-4
RS-232, 4-3 D
RS-485, 4-3 Del Wind
RS-485 max. distance, 4-3 elete (Win ow men'u), 3-35
. Delete Dynamic Attributes, 3-14
configure

Delete, Edit menu, 3-6
detach
controller at Runtime, 16-4
dialog box (mistic MMI)
“Controllers”, 2-7
"Open Project”, 2-6
dialog boxess

controllers, 4-1
Configure menu
Applications, 3-37
Event Log, 3-37
Historic Data Log, 3-36
Refresh Times, 3-36

Run Time, 3-37 :
Sounds. 3-37 download recipe, 9-6
Window State, 3-37 upload recipe, 9-9
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disable
trend, 8-3
download recipe dialogs, 9-6
draw window, 2-3, 6-1
defined, 1-3
state, 12-1
draw windows
attributes, 1-3
Duplicate, Edit menu, 3-6
Dynamic Attribute Color dialog, 7-10
Dynamic Attribute Download Recipe Dialog,
7-31
Dynamic Attribute Launch Application
Dialog, 7-33
Dynamic Attribute Position dialog, 7-12
Dynamic Attribute Rotate Dialog, 7-20
Dynamic Attribute Send Discrete Dialog,
7-23
Dynamic Attribute Send String Dialog, 7-25
Dynamic Attribute Send Value Dialog, 7-21
Dynamic Attribute Text Input Dialog, 7-14
Dynamic Attribute Upload Recipe Dialog,
7-27
Dynamic Attribute Visible/Blink Dialog, 7-17
Dynamic Attribute Width/Height Dialog,
7-15
dynamic attributes, 7-5
Dynamic Attributes dialog, 7-6
dynamic objects, 1-3

E

Edit Dynamic Attributes, Edit menu, 3-13
Edit Menu, 3-5
Align, 3-7
Bring to Front, 3-6
Copy, 3-6
Copy Dynamic Attributes, 3-13
Copy to File, 3-13
Cut, 3-5
Delete, 3-6
Delete Dynamic Attributes, 3-14
Duplicate, 3-6
Edit Dynamic Attributes, 3-13
Edit Object, 3-14
Flip/Rotate, 3-10
Group, 3-12
Paste, 3-6

Paste Dynamic Attributes, 3-13

Paste From File, 3-13

Select All, 3-6

Send to Back, 3-7

Ungroup, 3-12
Edit Object, 3-14
Ellipse (Tool menu), 3-18
enable

event log at startup, 14-3
EPROM, 16-2, 16-3
Event Log

displayed, 15-3
event log

prevent disabling, 14-3

start enabled, 14-3
Event Log (Configure menu), 3-37
Event Log Configuration Dialog, 14-8
event log file

name, 14-9
Event Log File Configuration Dialog, 14-9
Event Log Viewer Dialog, 15-4
example programs, 2-4
exit

MMI Runtime, 15-3
Exit MMI Configurator, 3-4
extension

.RCP, 9-10

event log file, 3-37

F

file
.GML, 1-2
AN 1-3
MMI, 1-3
.WON, 1-3
recipe, 9-2
file format
historic logs, 10-2, 10-4
File Menu, 3-1
Change Printer, 3-3
Choose Bitmap, 3-3
Close Project, 3-2
Exit MMI Configurator, 3-4
New Project, 3-1
Open Project, 3-2
Print, 3-3
Printer Setup, 3-3
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Project Path, 3-3
Save As Bitmap, 3-3
Save Project, 3-2
Save Project As, 3-2
File Menu (Runtime)
Change Printer, 15-1
Exit MMI Runtime, 15-3
Open Project, 15-1
Print, 15-2
Printer Setup, 15-2
Project Path, 15-1
filenames
historic logs, 10-1
fill
pattern, 3-27
percent, 3-27
Fill Color, 3-25
Fill Pattern, 3-26
Flip Horizontal, 3-10
Flip Vertical, 3-10
Flip/Rotate, Edit menu, 3-10
focus-frame, 7-7
Font (Text menu), 3-30
format
historic log files, 10-2
freshness, 5-2

G

graphic
launch applications, 13-1
order, 7-4
graphics, 7-1
de-selecting, 7-3
moving, 7-3
resize, 7-3
selecting, 7-1
Grids, 3-29
Group, Edit Menu, 3-12
grouping objects, 7-4

H

handles
sizing, 7-1, 7-3
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Help menu
About MMI Configurator, 3-38
Contents, 3-38
Search for Help On, 3-38
Help menu (Configurator), 3-38
How to Use Help, 3-38
Help menu (Runtime), 15-5
About MMI Runtime, 15-5
Contents, 15-5
How to Use Help, 15-5
Search for Help On, 15-5
Hide Menu Bar, 3-28
Hide/Show Grid, 3-29
Hide/Show ToolBar, 3-28
Hide\Show Coordinates, 3-28
hiding menu bar, 14-3
Historic Data Log (Configure Menu), 3-37
historic log
max. tags, 10-4
Historic Log Configuration Dialog, 10-4
Historic Log Dialog, 10-3
Historic Log File Configuration Dialog Box,
10-8
Historic Log Point Dialog Box, 10-13
Historic Log Start/StopTrigger Dialog Box,
10-16
Historic Log Stop Trigger Notification Dialog
Box, 10-17
historic logging, 10-1
rollovers, 10-2
triggers, 10-1
historic logs
maximum per project, 10-3
How to Use Help, 3-38
How to Use Help (Runtime), 15-5

index

tables in recipes, 9-3
inspecting

controllers at Runtime, 16-1
installation, 2-2
invisible

fill, 3-26
invisible lines, 3-25
ISA Direct dialog box, 4-14
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K

kernel, 1-2
keyboard setup
main Runtime window, 14-5

L

Launch Application Trigger Notification
Dialog Box, 13-9
launching
multiple instances of an application,
7-34
single instance of application, 7-34
launching application
dynamic attributes, 7-33
launching applications, 13-1
Left Align, 3-7
Line (Tool menu), 3-16
Line Color, 3-23
Line Format Dialog Box, 10-12, 14-13
line, invisible, 3-25
Line Style, 3-24
Line Width, 3-24
logging
tag types, 10-1

M

main window, 2-3
managers, recipe, 9-12
maximize button
main Runtime window, 14-4
MDS, 1-1, 4-7
MDS Port Dialog Box, 4-19
Middle Align, 3-9
mistic controllers
listed during Runtime, 15-3
mistic MMI
backups explained, 2-5
controllers, configure, 2-7
Event Log Viewer, 2-8
exiting, 2-7
openning project, 2-6
starting, 2-5
MMI Configurator, 1-2
starting the, 2-3
MMI Runtime, 1-2

Modem ASCII Serial Mode, 4-5
monitoring, 1-2
moving

graphic, 7-3
MPLAYER.EXE, 11-2
mwdriverdll, 15-3

N

New (Window menu), 3-35
New Project, File menu, 3-1

0

objects, 1-3
dynamic, 1-3
static, 1-3
Opaque (Style menu), 3-27
Opaque (Text menu), 3-33
Open (Window menu), 3-35
Open Project, File Menu, 3-2
open window
during Runtime, 15-4
list during Runtime, 15-4
Open Windows (Window menu), 3-36
Open Windows Dialog Box, 6-3
operator driven attributes, 1-4, 7-5, 7-7
Opto 22 Product Support, B-1
order
draw windows, 7-28

P

Paste Dynamic Attributes, Edit menu, 3-13
Paste, Edit Menu, 3-6
Paste From File, Edit Menu, 3-13
pathname
project, 15-1
pattern fill, 3-27
PC port
controllers at Runtime, 16-3
pen
trends, 8-6
percent fill, 3-27
Polygon (Tool menu), 3-19
Polyline (Tool menu), 3-19
Pop Window Dialog, 7-26
Runtime setup, 14-5
window state, 12-4
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position refresh time
of graphic, 7-12 assigned to a graphic, 7-9, 10-16, 11-7,
prevent 12-8, 13-9
event log disable, 14-3 trend pens, 8-3
MMI Runtime exit, 14-1 Refresh Time Group, 5-2
program switching, 14-1 Refresh Times (Configure menu), 3-37
user exit, 14-1, 14-3 Refresh Times dialog box, 5-3
windows exit, 14-2 requirements, 2-1
print, 15-2 resize
Printer Setup (File Menu, Configurator), graphic, 7-3
3-3 RF modems, 4-5
Printer Setup File Menu (Runtime), 15-2 Right Align, 3-8
problems rollover
WIN COM ports, 4-4 historic logs, 10-5
product support, B-1 rollover settings, 10-11
Program State, 16-4 rotate, 7-20
programs, example, 2-4 a graphic, 7-20
project Rotate Clockwise, 3-11
defined, 1-3 Rotate CounterClockwise, 3-12
project path rotation
displaying, 1-3 objects not allowed, 3-11
Project Path, File Menu, 3-3 rotation anchor point, 7-21
Properties (Window menu), 3-36 Round Rectangle, 3-17
RS-232, 4-3
Q RS-485, 4-3
quotes Run Time (Configure menu), 3-38
around strings, 10-13, 14-13 runtime
main window startup, 14-4
R Runtime menus, 15-1

Runtime Setup, 14-1

recipe Runtime Setup Dialog Box, 14-2

file contents, 9-2
Recipe Completed Notification Dialog Box, S
9-13
recipe download
trigger-based, 7-32
recipe managers, 9-12

Save As Bitmap, File Menu, 3-3
Save Project As, File Menu, 3-2
Save Project, File Menu, 3-2

Recipe Managers Dialog Box, 9-13 scan groups

recipe upload, 9-4 types, 5-2
trigger-based, 7-30 scanner overrun errors

recipes, 9-1 tip to avoid, 5-2

Recipes (Configure menu), 3-38 seanning, 5-1

Rectangle (Tool menu), 3-17 historic logs, 10-4

Redraw, 3-29 Search for Help On, 3-38

Select (Tool Menu), 3-15
selecting graphics, 7-1
Select All, Edit Menu, 3-6

reference point
assigning to graphic, 7-13
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send
discrete value to Cyrano tag, 7-23
string to Cyrano tag, 7-25
value to Cyrano tag, 7-21

Send to Back, Edit Menu, 3-7

Size (Text menu), 3-31

Solid and invisible fill, 3-26

Sound Start/Stop Trigger Dialog Box, 11-5

Sounds (Configure menu), 3-37
Sounds Dialog Box, 11-1
square, drawing a, 3-17
static objects, 1-3
stop sound, 11-4
Style menu, 3-23

Fill Color, 3-25

Fill Pattern, 3-26

Line Color, 3-23

Line Style, 3-24

Line Width, 3-24

Opaque, 3-27

Transparent, 3-27
system menu

main Runtime window, 14-4
system requirements, 2-1
SYSTEML.INI, 14-1

T

Tag dialog box, 7-8, 10-14
tag types
historic logs, 10-1
tags, 1-4
max. per historic log, 10-4
technical support, B-1
Text (Tool menu), 3-21
text attributes, 3-23
Text menu, 3-30
Background, 3-32
Color, 3-32
Font, 3-30
opaque, 3-33
Size, 3-31
Text Type Face, 3-33
Transparent, 3-34
Text Type Face, 3-33

timestamp
of .GML file, 1-2
title bar
main window at startup, 14-4
Tool Menu, 3-15
Tool menu
Bitmap, 3-21
Curve, 3-20
Ellipse, 3-18
Line, 3-16
Polygon, 3-19
Polyline, 3-19
Rectangle, 3-17
Round Rectangle, 3-17
Select, 3-15
Text, 3-21
Trend, 3-22
toolbar, 2-3
Top Align, 3-8
touch-based recipe, 9-5
touch-screens
data entry, 7-22, 7-26
keyboard setup at Runtime, 14-4
Transparent (Style Menu), 3-27
Transparent (Text menu), 3-34
Trend (Tool menu), 3-22
Trend Pen Dialog Box, 8-6
trends, 8-1
closed windows, 1-3
x-axis, 8-5
y-axis, 8-6
trigger
based recipe download, 7-32
based recipe upload, 7-30
historic logging, 10-1
historic logs, 10-7
launch applications, 13-1
stop trigger, 10-7
to initiate recipe action, 9-1
trigger-based recipe, 9-5
trouble
WIN COM ports, 4-4
Turn Snap On/Off, 3-29
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U Window Manager Configuration Dialog Box,
_ 12-3
Ungroup, Edit Menu, 3-12 Window Manager Start Trigger Configuration,
unselected windows action, 7-28 12-6
upload window managers
recipes, 9-9 _ max. per project, 12-1
tngg.er—based recipe, 7-30 Window Managers Dialog Box, 12-1
uploading Window Menu, 15-4
recipe, 7-29 Window menu, 3-34
V Close, 3-35
Copy, 3-35
View menu, 3-28 Delete, 3-35
Grids, 3-29 New, 3-35
Hide Menu Bar, 3-28 Open, 3-35
Hide/Show Grid, 3-29 Open Window, 3-36
Hide/Show ToolBar, 3-28 Properties, 3-35
Hide\Show Coordinates, 3-28 Window menu (Runtime)
Redraw, 3-29 Close, 15-4
Turn Snap On/Off, 3-29 Open, 15-4
View menu (Runtime), 15-3 Open Window list, 15-4
Event Log, 15-3 Window Properties Dialog Box, 6-1
Hide Menu Bar, 15-3 Window State (Configure menu), 3-37
mistic controllers, 15-3 Windows, 5-1
MWDriver, 15-3 Windows for Worgroups 3.11, 4-4
visibility Windows NT, 4-7
graphic, of a, 7-17 Windows serial drivers
problems, 4-4
W
, X
WIN COM Port Dialog Box, 4-16
window x-axis, trend, 8-5
draw, 2-3 Y

order during Runtime, 7-28
visual state during Runtime, 7-26
window,
main, 2-3
window, draw
state, 12-1

y-axis, trend, 8-6
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